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Compressor basics

What is Compressor?

Compressor is an application for converting audio and video files into professional media formats
for disc, device, or web delivery. The process of converting from one file format to another is
called transcoding. You can use Compressor on its own or with Final Cut Pro X and Motion to
transcode audio and video files directly from those applications.
In Compressor, you can:
••

Convert source media to high-definition (HD) or standard-definition (SD) formats (including
H.264) for Apple devices such as Apple TV, iPhone, iPad, iPod, or iTunes; for streaming or
podcasting on the web; for DVD, CD-ROM, or Blu-ray Disc; or for handoff to post-production.
Source media or
Final Cut Pro project

H.264
MP3
AC-3

MP3
MPEG-1
MPEG-4
QuickTime

AC-3
AIFF
H.264
MPEG-1
MPEG-2

AIFF
MP3
QuickTime

H.264
AC-3

DVD video

CD-ROM

Blu-ray Disc

To web

Apple TV
iPhone
iPad
iPod
iTunes

QuickTime
movie
(for broadband
and lowband)

••

Use batch processing to create multiple output files from single-source media files.

••

Create standalone applications called Droplets for drag-and-drop transcoding operations on
your desktop. Simply drag a media file onto a Droplet to launch a customized transcoding
session, without opening Compressor.

••

Use Apple-supplied encoding settings or create your own settings to build a library of
specialized settings that can be reused.

••

Apply video filters to add fade-in/fade-out effects, timecode overlays, gamma correction, noise
removal, letterbox framing, watermarks, color adjustments, and more.
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••

Apply audio filters to control dynamic range, peak levels, equalization, and audio fade-in/
fade-out effects.

••

Use the Preview window to view the results of your filter settings in real time.

••

Create and save output destinations, including your desktop, local disks, remote disks, and FTP
locations. You can even use destination presets to specify filenaming conventions.

••

Control video file image quality during MPEG-2 DVD transcoding by applying single- or dualpass variable bit rate (VBR) to your output files.

••

Customize your frame dimensions using geometry controls. You can resize your image to common
aspect ratios, including 4:3, 16:9, and 2.35:1, or reduce file size by cropping unwanted image areas.

••

Publish your media files to a QuickTime Streaming Server or other locations for DVD authoring.

••

Customize post-transcoding operations by applying AppleScript automation to your output files.

••

Export sequences directly from Final Cut Pro X or Motion into Compressor for transcoding,
leveraging the powerful video-processing technology of those applications.

••

Encode media files in the background so that you can perform other tasks at the same time.

••

Automatically send an email notification to any location to notify you or your colleagues when
a transcoding job is complete.

••

Use distributed processing to divide the transcoding work among multiple computers, thereby
increasing your processing power. The distributed processing feature is limited to computers
that have Compressor installed.

••

Enable and disable distributed processing services and monitor batches using
command-line options.

Compressor workflow overview

Compressor offers several ways to convert (transcode) media files into any of numerous
professional file formats. For basic transcoding jobs to common output formats (Blu-ray Disc,
DVD, Apple TV, YouTube, and so on), choose a preconfigured template to have Compressor
automatically apply all required settings. For more advanced transcoding jobs, apply an output
setting from a list of more than 30 file formats.
Whether basic or advanced, all transcoding workflows in Compressor follow the same
essential steps:
••

Import your source media into Compressor.

••

Apply and modify your preferred output settings.

••

Specify a save destination (the location where the output files are saved).

••

Submit your file or batch of files for transcoding.

Chapter 1    Compressor basics
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Each transcoding session in Compressor is known as a batch. A transcoding batch can contain
multiple source media files, referred to as jobs. Each job can be transcoded into multiple formats.
The following diagram represents a batch containing two jobs:
Batch
Job 1
Setting

Source
media file
1

Setting

Job 2
Setting

Source
media file
2

Setting

Target 1

Target 2

Target 1

Target 2

Destination

Output media file
(Job 1, Target 1)

Destination

Output media file
(Job 1, Target 2)

Destination

Output media file
(Job 2, Target 1)

Destination

Output media file
(Job 2, Target 2)

In the diagram above, each job is converted to two output files. The settings and save
destinations of these files are known as the targets. One output media file is created for each
target assigned to a source media file. The total number of output files created by transcoding
this batch will be four: Job 1 will create two output media files, as will Job 2.

Compressor window overview

The main Compressor workspace has five windows, each of which represents a part of the
transcoding workflow:
Batch window

Settings and
Destinations tabs

Chapter 1    Compressor basics

Preview window

Inspector
window

History
window
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••

Batch window: Import source media files and add transcoding settings and save destinations
in this window.

••

Settings and Destinations window: Choose settings and output destinations from the two tabs
in this window. The Settings tab contains more than 30 Apple-provided settings for common
media formats (for Apple devices, Blu-ray and DVD discs, web streaming, video-sharing
services such as YouTube, and so on). You can add your own custom settings to this list. The
Destinations tab contains common save locations (Desktop, User’s Movies Folder, and so on).
You can add your own custom save destinations to this list.

••

Inspector window: Adjust common transcoding controls and view a summary table listing the
details of each setting. You can also use the Inspector window to gather information about
source clips.

••

Preview window: Preview the results of your transcoding settings in this window. A split-screen
feature lets you compare the original media to the modified version, before you output. Here
you can see the effects of applied filters and frame resizing, and you can make adjustments to
these attributes while previewing the results in real time. You can also use the Preview window
to add and view various kinds of markers.

••

History window: See a complete log of all batches submitted from your computer, including
progress bars of batches still being transcoded. You can pause or resubmit any batches listed
in the log.

You can display the Compressor workspace in either of two basic default layouts. The standard
layout displays all the Compressor windows, with the Settings and Destinations tabs sharing a
window; this layout is optimized for those times when you’re transcoding a single-source media
file. The batch layout places the emphasis on the Batch window and is optimized for those times
when you’re transcoding multiple source media files. As you work, you can switch between these
layouts. You can also create a custom layout and save it for future use.

Manage Compressor windows

The five windows of the Compressor workspace can be moved and resized independently of one
another, allowing you to customize your work environment.
View a specific window
mm Choose Window > window name.
Bring all Compressor windows to the front
Do one of the following:
mm Choose Window > Bring All to Front.
mm Click the Compressor application icon in the Dock.
Choose a layout
mm Choose Window > Layouts, and choose a layout from the list that appears.
The Compressor interface changes to match the new layout.
Save a layout
1 Arrange the Compressor windows.
2 Choose Window > Save Layout.
3 In the dialog that appears, enter a name for the layout and click Save.
The layout is saved and appears in the layouts list when you choose Window > Layouts.

Chapter 1    Compressor basics
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Manage layouts
1 Choose Window > Manage Layouts.
A dialog for managing layouts appears.

2 Do any of the following:
••

To rename a layout: Double-click it and type the new name.

••

To remove a layout: Select it and click the Delete (–) button.

••

To save the current interface configuration as a new layout: Click the Add (+) button and enter a
name for the layout.

••

To choose a layout and apply it to the current Compressor interface: Choose the layout and click
the Apply button.

3 When you’ve finished managing your layouts, click Done.
The dialog closes and the Compressor interface changes to match the chosen layout setting.
Note:  The layouts list is actually divided into two sections—the ones supplied by Apple and the
ones that you create. You cannot rename or delete the Apple-supplied layouts. The ones that you
create are listed in alphabetical order. Use care when naming your layouts so that you can easily
locate them in the list.

Compressor terms

This section covers common terms that you’ll encounter as you use Compressor.
••

Codec: Short for COmpression/DECompression. A mathematical model for reducing the data of
a source media file.

••

File format: The output format used to transcode your source media file.

••

Transcoding: The process of converting files from their original format to output files ready for
distribution in another format. Closely related terms include compression, which specifically
refers to data reduction, and encoding, a term that is essentially synonymous with transcoding,
but doesn’t emphasize the conversion aspect.

••

Source media file: The original media file to be converted to a new file format.

••

QuickTime: The cross-platform multimedia technology that allows OS X and Windows
applications to capture and play back video, audio, and still-image files. QuickTime files can
contain many different kinds of media and codecs. Codecs give instructions to QuickTime on
how to play back the media.

Chapter 1    Compressor basics
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••

Setting: A group of attributes applied to a source media file during the transcoding process.
Each setting contains the following attributes (which you can modify in the Inspector window):
••

Output (file) format: The encoder you choose to convert your source media file. Choose one
of the following output formats based on the intended playback method: AIFF, Dolby Digital
Professional, DV Stream, H.264 for Apple Devices (which contains settings for use with
iPhone, iPad, iPod, and Apple TV), Image Sequence (which supports TIFF and TARGA images),
MPEG-1, MPEG-2, MPEG-4, QuickTime Movie, or QuickTime Export Components.

••

Filters: Special effects that adjust different characteristics of your video (such as color,
brightness, and sharpness) to maximize your video quality as the file is converted.

••

Geometry: Controls to crop the image and adjust its frame size.

••

Actions: Controls to create actions that are automatically applied to output files after
transcoding. Use this feature to send email notifications and execute tasks using Automator.

••

Destination: The location where your transcoded media file is saved. You can either use the
default destination (the same folder the source media file is in) or choose a custom destination
that you created. The destination also controls how the transcoded media file is named.

••

Target: The area of the Compressor workspace (in the Batch window) where you designate the
setting, destination, and output filename. Think of it as the blueprint for creating an output
media file.

••

Job: The source media file and the target (setting and destination) you apply to it, ready to
be transcoded.

••

Batch: One or more jobs that are processed at one time. All jobs contained within the batch
are submitted collectively when you begin the transcoding process.

••

Output media files: The transcoded media file (or files) created after the batch is submitted and
processed. You can create as many output media files as there are different settings applied to
the various source media files in the batch.

Chapter 1    Compressor basics
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Compressor workflows

2

Quick and easy batch template workflow

If you want to transcode your source media files immediately and don’t need to create your own
settings, you can use the batch template settings that are preconfigured in Compressor. The
following workflow shows you a quick and easy way to use Compressor with batch templates.
Stage 1: Choose a template
In the Batch Template Chooser, you’ll select a template to transcode your media. For more
information, see Batch window on page 29.
Note:  The default set of templates is shown below. If you’ve created other templates, they will
also appear in the Batch Template Chooser.

Stage 2: Import source media files
Although there are many ways to import source media into Compressor, the easiest method is to
drag a source file from the Finder or the desktop to the placeholder job in the Batch window. For
more information, see Importing overview on page 17.
Stage 3: Submit your batch for processing
After you’ve chosen a template and provided a file to transcode, you can submit the batch that
contains your job. By default, the batch templates use Source (the same folder that the source
media files originated from) as the destination for the encoded files. For information about
choosing other destinations, see Destinations overview on page 137.
You can view the progress of your transcode in the History window in Compressor. It contains a
progress bar and tells you if a submission was successfully transcoded.
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Manual batch processing workflow

If none of the preconfigured batch settings work for your transcode but you want to use the settings
and destinations that come with Compressor, you can manually build and process your batch. The
following workflow shows you an easy way to manually build and process a batch in Compressor,
summarizing each stage in the process and providing links to the instructions you’ll need.
Stage 1: Manually import source media files
You’ll need to manually import each source media file into Compressor, either by dragging files
into the batch or by clicking the Add File button. After you import files, you’ll see that new jobs
are created for each source file you added to the batch.

Each source
file creates
a job in the
batch.

Target area (empty
in this case) of a job

For more information, see Importing overview on page 17.
Stage 2: Assign settings and destinations
You’ll need to assign at least one setting and destination to each source media file job before
you can submit the batch for processing. You can also add multiple settings to the same job
to transcode multiple versions of the media file. Each setting-destination pair is known in
Compressor as a target.
For instructions on how to assign settings and destinations, see Assign settings to source
media on page 32 and Destinations overview on page 137.
Stage 3: Submit your batch for processing
When each media file has at least one setting and destination associated with it, you can submit
your batch for processing. For more information, see Submit a batch on page 147.

You can view the progress of your transcode in Share Monitor. This is a good way to monitor
when your batch has finished transcoding and if any problems occurred during the transcoding
process. For more information about Share Monitor, see Share Monitor Help.

Chapter 2    Compressor workflows
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Alternatively, you can view the progress of your transcode in the History window in
Compressor. It contains a progress bar and, like Share Monitor, it can tell you if a submission was
successfully transcoded.

Custom transcoding workflow

You can create your own settings and destinations, and customize other attributes such as
filters, cropping, frame resizing, and actions settings to create your own custom transcoding
process. The workflow below summarizes each stage in the process and provides links to the
instructions you’ll need.
Stage 1: Import source media files
You can import source media files into a batch, either by dragging the files from the Finder to the
Compressor Batch window or by clicking the Add File button. You can import source media files
from any folder that you have access to. For more information, see Importing overview on page 17.
Stage 2: Create and assign one or more settings
Compressor has many output formats you can use to create a setting. For more information
about the various output formats available in Compressor, see Custom settings and output
formats overview on page 64. For instructions for creating your own customized settings, see
Settings overview on page 31.
You can also add filters, geometry settings, and post-transcoding actions to your settings. For
more information, see Filters overview on page 153, About deinterlacing on page 172, Geometry
overview on page 176, and Post-transcoding actions overview on page 184.
You can streamline your workflow by putting your settings into groups. For more information,
see Create and modify settings on page 35.
After creating a setting, you can preview it to check your work. For more information, see
Previewing overview on page 52.
Note:  Frame Controls settings cannot be previewed in the Preview window. To preview Frame
Controls settings, you can do a test transcode using a small section of your source media file. For
more information, see Transcode a portion of a clip on page 57.
Stage 3: Create one or more destinations
By default, your transcoded file is saved in the same folder that the source media file originated
from. If you want to store your transcoded files in a different location, you can create a new
destination. For more information, see Destinations overview on page 137.
Stage 4: Submit your batch for transcoding
After you’ve created and previewed all the jobs you want in the batch, you submit the batch. For
more information, see Jobs, targets, and batches overview on page 137.
You can view the progress of your transcode in Share Monitor. This is a good way to monitor
when your batch has finished transcoding and if any problems occurred during the transcoding
process. For more information about Share Monitor, see Share Monitor Help.
Alternatively, you can view the progress of your transcode in the History window in
Compressor. It contains a progress bar and, like Share Monitor, it can tell you if a submission was
successfully transcoded.

Chapter 2    Compressor workflows

16

Import source media

3

Importing overview

The first step in the traditional Compressor transcoding process is to import at least one source
media file into the Batch window, thus creating a batch.
If you’re using the batch template workflow, the first step is to choose a batch template. For more
information, see Quick and easy batch template workflow on page 14.
Here are some tips for importing source media:
••

About highly compressed source files: It’s strongly recommended that you do not use highly
compressed files, such as MPEG files, as your source files, because they can cause artifacts in
the encoded video.

••

When importing QuickTime reference movies: If you submit a reference movie for distributed
processing, the Apple Qmaster distributed processing system automatically copies the
appropriate media files to the processing cluster. For the best performance, you can avoid
this file transfer step by making sure that the media files specified in the reference movie are
available to each node of the Apple Qmaster cluster. For more information, see How the Apple
Qmaster system distributes batches on page 221.

••

When importing MPEG-2 files: When you import an MPEG-2 file, Compressor must parse the
file before you can play it in the Preview window. Parsing the file involves determining its
frame structure and other necessary information about the file. Because the frame structure
can change throughout the file, Compressor must scan the entire file, which can take several
minutes for longer files.
This doesn’t happen with MPEG-2 elementary files encoded using Compressor that had the
“Add DVD Studio Pro metadata” checkbox selected. For more information, see MPEG-2 Encoder
pane on page 89.

••

When importing Dolby Digital Professional source media: You can use Dolby Digital Professional
AC-3 audio files as source media files for your jobs. There are two common reasons to do this:
••

To test a file you just encoded: Because you cannot preview the Dolby Digital Professional output
settings, importing an encoded file into a job allows you to play it and verify the settings.

••

To convert a Dolby Digital audio file to another format: Because not all media players include
Dolby Digital decoders, you may find that you need to transcode the file to another format.
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Compressor includes a Dolby Digital decoder that it uses to play or transcode Dolby Digital
audio files. This means you can verify the Dolby Digital Professional output settings of a
previously encoded file on your system without using an external Dolby Digital decoder. To
hear surround sound you must have an external surround sound device connected to your
computer’s USB or FireWire output. The audio is mixed down to two channels if you play the
audio using your system’s stereo speakers.
Important:  Because the audio output is already decoded and not in the Dolby Digital format,
the optical output cannot be used when playing Dolby Digital files from Compressor.
Tip:  If Compressor doesn’t allow you to add a Dolby Digital file to a job, add the extension .ac3
to the filename.
••

About automatic values and nonstandard QuickTime: Compressor uses a variety of tactics
to determine the proper values for any settings that are set to Automatic. In most cases,
QuickTime files contain metadata specifying the various attributes of the file, such as frame
rate and frame size. In some cases, this metadata is not present, forcing Compressor to try to
determine this information, or it’s incorrect, causing Compressor to generate incorrect values
for the Automatic settings. Additionally, some QuickTime files use nonstandard settings that
require Compressor to choose an automatic value that may not be suitable. For these reasons,
it’s a good idea to verify that the Inspector values are set to Automatic. For more information,
see About the Automatic settings on page 40.

Create a batch

Batches—groups of one or more jobs—are the heart of your Compressor workflow, and the
Batch window is where you work with the batches. The Batch window provides a central location
for organizing your transcoding tasks and quickly assigning settings.
When you first open Compressor, the Batch window appears, and as you open more baches,
each appears as a tab at the top of the window. Batches can be saved, closed, and opened again.
For more information, see Batch window on page 29.
Create a batch using default settings
mm Choose File > New Batch.
A new, untitled batch is added to the Batch window.
The new batch’s tab

Each tab is for
a different batch.

The Batch window has a Submit button, located in the lower-right corner, that you can use to
begin transcoding the currently selected batch. The lower-left corner shows the status of the
current batch (how many jobs it contains and whether it has been submitted).

Chapter 3    Import source media
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Create a new batch using a batch template
1 Choose File > New Batch from Template.
The Batch Template Chooser appears, containing preconfigured templates and any templates
you’ve created.

For information about the templates in the Batch Template Chooser, see Batch window on page 29.
2 Select a batch template and click Choose.
A new, untitled batch is added to the Batch window.
The new batch’s tab

Each tab is for
a different batch.

The Batch window has a Submit button, located in the lower-right corner, that you can use to
begin transcoding the currently selected batch. The lower-left corner shows the status of the
current batch (how many jobs it contains and whether it has been submitted).
Create a custom batch template
You can save any batch as a custom batch template. Custom batch templates appear as options
in the Batch Template Chooser, alongside the default Apple batch templates. Custom batch
templates can save you time, particularly with workflows that you repeat often.
1 In the Batch window, create a new batch.
Tip:  Alternatively, open a saved batch with the characteristics that you want in the batch template.
2 Adjust the batch settings as appropriate. For more information, see Assign settings to source
media on page 32 and Destinations overview on page 137.
3 Choose File > Save as Template.
4 In the dialog that appears, enter a name and description, and click OK.
The custom batch template is saved and appears in the Batch Template Chooser.
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Add source media files
Add standard source media files to batches
Before you add any transcoding settings to a batch, you need to import the source media files
into the batch. Importing the source media files into the batch automatically creates a job.
Following are the details for adding standard (not surround sound or image sequence) source
media files to a batch.
Add source media files to a batch
1 Open Compressor.
The Batch window opens with an empty batch tab named Untitled.
Untitled batch tab

Empty batch area
with a placeholder job

Note:  If the Batch Template Chooser opens automatically, click Cancel to close it. To prevent
the Batch Template Chooser from opening when you open Compressor, select the “Don’t show
this dialog again” checkbox, or, in Set Compressor preferences, select For New Batches: Use
Blank Template.
2 Do one of the following:
••

Choose Job > New Job With File (or press Command-I), navigate to the folder that contains
your source media, select one or more source media files, and click Open.

••

Click the Add File button (in the Batch window toolbar, if visible), navigate to the folder that
contains your source media, select one or more source media files, and click Open.

••

Control-click a job and choose Source > File from the shortcut menu.
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••

Control-click an empty area of the batch and choose New Job With File from the shortcut
menu. You can then navigate to the folder that contains your source media, select one or more
source media files, and click Open.

••

Open your source media file folder and drag one or more source media files into the batch.

Note:  You can combine the above steps by selecting all the source media files you want to
transcode before opening Compressor and then dragging them to the Compressor application icon.
This opens Compressor and adds the media files to the default untitled batch at the same time.
3 To save the batch, choose File > Save As (or press Command-Shift-S).
4 In the dialog that appears, enter a name for the batch and choose the location where you want
to save it.
5 Click Save.
The tab in the Batch window changes to match the name of the file.
Note:  If your Finder preferences are set to show file extensions, the extension .compressor
appears in the tab along with the name.
You’re not required to name and save your batches, and for quick jobs you might decide not to.
However, naming and saving a batch makes it easy to go back and resubmit it later if you find
that the output files were not as expected or if your needs change. It also makes it easier to
figure out what’s in the History window and in Share Monitor if you submit multiple batches in a
short period of time.
The batch now contains your selected media files, each in its own job. Source media files with video
content also include a thumbnail image and a scroller that you can use to scroll through the video.
The targets for this job
will appear in this area.

Each source
media file
creates a job.

Drag the slider to scroll
through video files.
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Change the source media file assigned to a job
1 In the Batch window, select the job whose source media file you want to change.
2 Do one of the following:
••

Choose Job > Source > File, navigate to the folder that contains your source media, select one
or more source media files, and click Open.

••

Control-click the job and choose Source > File from the shortcut menu. You can then navigate
to your source media, select one or more source media files, and click Open.

••

Drag a new source media file to the job.

Any targets you had already configured remain and are now applied to the new source media file.
Remove a source media file from a job
mm Control-click the job and choose Clear Source from the shortcut menu.
Remove jobs from a batch
Do one of the following:
mm To remove a single job: Select the job and press Delete.
mm To remove all jobs: Control-click in an empty part of the batch and choose Remove All Jobs from
the shortcut menu.
You can now add targets to your jobs.

Add surround sound source media files to batches
There are two methods you can use to add audio files to a batch to create a surround sound job:
an automatic method that relies on filenaming to map the audio files to the proper channels and
a manual method that allows you to manually assign the audio files to the channels.
Each method results in a job to which you can add a setting that supports surround sound audio
outputs, such as Dolby Digital Professional, AIFF, and several audio codecs in the QuickTime
Movie output format.
Important:  Some of the output formats have multiple configurations for the surround sound
audio channels. Be sure you know which configuration your intended playback device requires.
For example, the AIFF output format provides four different configurations for 5.1 (six-channel)
audio outputs, with the difference being the order of the channels.
Assign files to surround channels with channel identifier codes
1 In the Finder, append the channel identifier code of the target surround channel to the filename
of each source audio file using these codes:
••

-L: Left front channel

••

-R: Right front channel

••

-C: Center front channel

••

-Ls: Left surround channel

••

-Rs: Right surround channel

••

-S: Center surround channel

••

-LFE: Low-frequency effects channel (Subwoofer, LFE)
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For example, to assign an AIFF file to the left surround channel, rename the file filename-Ls.aiff (where
filename is the name of your file). The channel identifier codes must include the hyphen, as shown.
Note:  OS X may add a file extension like .aiff. This will not interfere with this channel
assignment method.
This procedure works only when you drag files into the Batch window. If you drag the files onto
the Compressor application icon, they’ll appear as separate source files, each in its own job.
Note:  If you’re creating Dolby Digital Professional (AC-3) surround sound streams, you won’t use
all the channels listed in the table at once. For a diagram of the Dolby audio coding modes, see
Dolby Digital Professional Encoder pane on page 78.
2 Drag the renamed source audio files to the Batch window.
If the files in the group are named correctly (see step 1) and the group has fewer than seven files,
Compressor collapses the entire group of files into what appears as a single surround source
media file in the Batch window
Manually assign source audio files to channels of a surround sound stream
1 To import the source audio files, do one of the following:
••

Choose Job > New Job With Surround Sound Group (or press Command-Control-I).

••

Click the Add Surround Sound button in the Batch window.

••

Control-click in the batch and choose New Job With Surround Sound Group from the
shortcut menu.

The channel assignment interface opens.
2 To assign a source audio file to a channel, do one of the following:
••

Drag the source audio file from the Finder to the icon for a specific channel (for example, L).

••

Click the icon for a specific channel (for example, L) and use the Open dialog to locate the
source audio file intended for that channel.

The file is now assigned to the L (left front) channel.

3 Repeat step 2 for each of the source audio files that you intend to include in the surround stream.
Note:  If you’re creating Dolby Digital Professional (AC-3) surround sound streams, you won’t use
all the channels listed in the table at once. For a diagram of the Dolby audio coding modes, see
Dolby Digital Professional Encoder pane on page 78.
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4 To include a video file, click the Add Video button and select a video file.
5 When you’ve finished adding source audio and video files to the channel assignment
interface, click OK.
The group of surround files appears as a single surround source media file job in the Batch window.
Change a surround sound file assignment
After you create a surround sound job, the Batch window shows the surround sound icon in the
source media file thumbnail (unless a video file was added to the job), and the Inspector window
shows the channels and their assigned files.

Click a channel’s icon to
change the file assigned
to that channel.

You can change any of the file assignments in the Inspector window.
1 Click the speaker icon of the channel you want to change.
2 In the dialog that appears, locate the file to assign to that channel and click Open.
3 To add a video file, click Add Video and select a video file.
You can replace a video file that is already assigned by deleting it and clicking Add Video to
choose a different video file.
For information about creating Dolby Digital Professional output files, see Dolby Digital
overview on page 72.
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Add image sequences to batches
You can import a sequence of still images into Compressor as a single image sequence job and
then apply an output frame rate and an audio file to the job. From that point, you treat the job
as you do any other Compressor source media file, adding settings, destinations, filters, and
post-transcoding actions to create an output media file with the video and audio formats and
characteristics you want.
Add a still image sequence job to a batch
1 Do one of the following:
••

Click the Add Image Sequence button and navigate to the folder containing the image
sequence files you want to import.

••

Choose Job > New Job With Image Sequence (or press Command-Option-I) and navigate to
the folder containing the image sequence files you want to import.

2 Click Open.
The new job appears in the Batch window.

3 Select the job in the Batch window.
The Inspector window displays the A/V Attributes tab containing information and controls for
the new image sequence job.
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4 Do any of the following:
••

Confirm the selected image sequence files.
To view the complete list of files, click the Info (i) button.

••

Confirm the video format information in the Video section.

••

Adjust the field dominance for the source files by choosing an option from the Native Field
Dominance pop-up menu.

••

Adjust the frame rate for the source files by choosing a standard frame rate from the Frame
Rate pop-up menu.

••

If you want to add an audio file to the image sequence job, click Choose Audio and select an
audio file.
Note:  Compressor supports the following audio file types for image sequences: AIFF, MP3,
MPEG-4 audio-only (.m4a), and QuickTime movie (.mov).

You can also use Compressor to output an image sequence. For more information, see Create
image sequence files on page 134.

Add metadata to source media files
You can annotate a source media file with information that is important for your workflow.
Additionally, some types of source media need to be identified before a job can be processed.
Note:  The Add Annotation feature is supported by the H.264 for Apple Devices, MP3, and
QuickTime Movie output formats.
Add an annotation to a source media file
1 Click the job to show the source media file’s attributes in the Inspector window.
2 Click the Additional Information tab.
3 Choose the type of annotation from the Add Annotation pop-up menu.

4 Double-click the corresponding Value field and enter the annotation text.

5 To save the annotation, press Return or click in the next field.
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Associate a closed caption file with a job’s source media file
1 Click the job to show the source media file’s attributes in the Inspector window.
2 Click the Additional Information tab.
3 Click Choose, locate the closed caption file (must be a Scenarist closed caption format file, usually
with the file extension .scc), and click Open.
Note:  Closed caption data is supported by the H.264 for Apple Devices, MPEG-2, and QuickTime
Movie output formats.
Depending on the output format of the job’s target, Compressor applies the closed caption file
to the output media files.
••

For QuickTime outputs: Compressor adds the closed caption file as a closed caption track to
the QuickTime output file. You can view the closed captions using QuickTime Player (version
7.2 or later).

••

For MPEG-2 elementary stream outputs: Compressor embeds the closed caption data in an
elementary MPEG-2 video stream so that it can be used for DVD authoring.

••

For MPEG-2 program and transport stream outputs: Compressor embeds the closed caption data
in program and transport MPEG-2 streams using the EIA-708 ATSC protocol.

Important:  The timecode values in the closed caption file must directly relate to the timecode of
the source media file. You can open a closed caption file in TextEdit to see the timecode values it
contains (the actual text is encoded and cannot be read this way).

Inspector window
When you select a batch’s job, the Inspector window shows you information about the job’s
source media file.
The Inspector window contains three tabs: A/V Attributes, Additional Information, and Job Action.
A/V Attributes tab
The A/V Attributes tab contains general information about the source media file and is divided
into three sections.
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••

File information: This section shows the filename, location, and type of file.

••

Video information: This section, when applicable, shows all video-related information about the
file. This includes its frame size, frame rate, and timecode information.

••

Audio information: This section, when applicable, shows all audio-related information about the
file. This includes its sample size and sample rate.

Additional Information tab
The Additional Information tab allows you to see and modify a variety of metadata items that
might have been added in other applications such as Final Cut Pro or QuickTime. You can also
add metadata to the output media file, or associate a closed caption file with the output file.

••

Closed Caption file field: Displays the name of the closed caption file currently associated with
the source media file.

••

Choose (closed caption) button: Use this button to open a dialog and navigate to the closed
caption file you want to associate with the source media file.

••

Clear button: Use this button to remove the associated closed caption file.

••

Annotations table: Displays the current annotation types and the corresponding
annotation text.

••

Add Annotation pop‐up menu: Choose the type of annotation you want to add to the source
media file.

••

Remove (annotation) button: Use this button to remove the selected annotation.

Job Action tab
The Job Action tab allows you to apply and adjust post-transcoding actions for entire jobs. For
information about using the Job Action tab, see Post-transcoding actions overview on page 184.
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Batch window

The Batch window provides a central location for organizing your transcoding tasks and quickly
assigning settings. When you first open Compressor, the Batch window appears with an empty,
untitled batch. Think of batches as documents that can be saved, closed, and opened again. You
use the toolbar at the top of the Batch window to open all other Compressor windows.
Batch tabs

Show/hide toolbar button
Toolbar

Job area

Batch status

Batch submission button

To simplify common workflows, Compressor includes a Batch Template Chooser that can appear
anytime you create a new batch. The For New Batches setting in Compressor preferences
controls whether the Batch Template Chooser appears. For details, see Set Compressor
preferences on page 211.
The Batch Template Chooser contains a variety of options you can choose from to configure a
new batch.

Choosing a template adds one or more settings to the batch, as well as a job action to be
executed when the batch output is finished.
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Compressor includes the following batch templates:
••

Create Audio Podcast: Use this template to create an AAC audio file suitable for podcasting and
add it to the iTunes library.

••

Create Blu-ray disc: Use this template to create BD H.264 video and Dolby Digital Professional
(.ac3) audio files and automatically burn them to a Blu-ray disc or an AVCHD disc (AVCHD discs
can be played in Blu-ray Disc players that are compatible with the AVCHD format).

••

Create DVD: Use this template to create a standard-definition DVD using MPEG-2 (.m2v) video
and Dolby Digital Professional (.ac3) audio and automatically burn it to a disc.

••

HTTP Live Streaming: Use this template to create a set of files you can use to stream a movie to
iPhone, iPad, iPod touch, and Mac, using an ordinary server.

••

Publish to Apple TV: Use this template to create a video file suitable for viewing on Apple TV
and add it to the iTunes library.

••

Publish to YouTube: Use this template to create a video file suitable for viewing on YouTube and
upload it to a YouTube account.

Note:  Choose a template based on the intended use of the output media file you’re creating.
If there is no obvious template for your intended workflow, you can create your own batch or
transcoding workflow.

Chapter 3    Import source media

30

Assign settings and preview media

4

Settings overview

A setting is a combination of transcoding attributes, such as output format, filter, and geometry
settings, that you apply to the source media file as a part of the transcoding process. You need
to assign at least one setting to a source media file before you can transcode it. Once you have
a source media file in the current batch in the Batch window, you can either select a preexisting
setting or create a customized one using the Settings tab.
The Settings tab allows you to manage your settings. In conjunction with the Inspector window,
the Settings tab also provides details of all the settings and includes easy access to common
transcoding controls.
The Settings tab contains a list of the existing settings and the necessary buttons to add, remove,
or duplicate a setting and create groups and Droplets.
Create a New Setting
Group button
Duplicate Selected
Setting button

Create a New Setting
pop-up menu
Delete Selected
Setting button
Save Selection
as Droplet button
Click the disclosure
triangles to show
or hide a setting
group’s contents.

An example setting

Settings list

The Inspector window contains the panes that let you create and modify all the settings related
to your output media file, such as filters, geometry, and output format. The Inspector window is
also where you name your settings, as well as add descriptions to make it easier to remember
later what you customized. For more information, see Inspector panes on page 42.
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Assign settings
Assign settings to source media
You can use a variety of methods to assign settings to a job. Some methods, such as dragging
the setting from the Settings tab, are better suited to working with one job. Other methods, such
as using the shortcut menu, are better for assigning the same settings to a group of jobs. You can
even assign settings by dragging settings or Droplets from the Finder.
Note:  The following steps assume you have already added source media files to a batch, creating
the jobs to which you are adding the settings. For information about importing source media
files, see Importing overview on page 17.
Assign a setting to a job by dragging
1 In the Settings tab, select one or more settings or groups of settings.
Tip:  You can Option-click a setting group’s disclosure triangle to expand that group (and all
subgroups) and show all the settings it contains.
2 Drag the settings to the job in the Batch window.
A job with a source media
file in the Batch window

Select one or more
(two in this case) settings
to apply to the job.
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A new target is created for each setting that you added to the batch’s job.

New targets
are added for
each setting
you drag to
the job.

Note:  You can only apply the settings to a single job when you assign them by dragging.
Assign a setting to a job using the Target menu
1 Select one or more jobs in the Batch window’s current batch.
2 Choose Target > New Target With Setting.
The settings selection dialog appears over the Batch window.
Select the jobs in
the Batch window.

Select the settings
to apply to the
selected jobs.

Click Add to assign
the settings to the
selected jobs.

3 Choose one or more settings or groups of settings to assign to the jobs, and click Add.
The settings are assigned to each selected job.
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Assign a setting to a job using the shortcut menu
1 Select one or more jobs in the Batch window’s current batch.
2 Control-click one of the selected jobs and choose New Target With Setting from the
shortcut menu.
The shortcut menu lists the settings based on their groups. You cannot directly choose a group
to be assigned, but each group contains an “All” item that selects all the group’s settings.
Note:  You cannot select multiple individual settings with this method.
3 Choose a setting, or choose All to choose all settings in a group.
The settings are applied to all selected jobs.
Assign a setting from the Finder
Do one of the following:
mm Drag one or more settings from the Finder to an empty space in the Batch window.
A new job appears with one or more target rows populated with the settings.
mm Drag one or more settings from the Finder to an empty space on a job tile in the Batch window.
One or more new target rows appear on the job, populated with the settings.

Replace an assigned setting with a different setting
After you’ve assigned a setting to a job, you might find a more suitable setting and decide to
change the target’s setting to the new one. You can use several methods to change a target’s
setting. All of these methods leave the destination and output filename settings as they are.
Replace a setting already assigned to a target with a different setting
Do one of the following:
mm Select the target and choose Target > Change Setting.
This opens the setting selection dialog, where you can choose a new setting and click Add to
assign it to the selected target.
mm Control-click the target and choose Change Setting from the shortcut menu.
This opens the setting selection dialog, where you can choose a new setting and click Add to
assign it to the selected target.
mm Select the new setting in the Settings tab and drag it to the target.
Note:  With all the above methods, if you select multiple settings, only the top one is assigned
to the target.
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Modify an assigned setting
You can edit or change any component of a setting that has already been assigned to a source
media file in the Batch window (identified as Selected Target in the Inspector window).
Modify a setting already assigned to a source media file in the Batch window
1 Select the target in the batch with the setting that you want to change.
The setting appears in the Inspector window with Selected Target in the Name field. This
is a temporary copy of the setting and not the setting itself, so you can make temporary
modifications to the setting for just that one batch submission.

Select a target in the Batch
window to see its settings
in the Inspector window.

The setting’s name appears
as Selected Target.

Click the Save As button
to save this as a new setting
with any changes you make.

2 Make the changes to the setting.
When you modify the setting, the Save As button at the bottom of the Inspector window
becomes active.
3 To save the modified setting with a new name, click Save As.
The saved copy appears in the Settings tab as Setting Name-Copy and immediately becomes the
selected setting in the Settings tab.
Note:  You don’t have to save the modified setting, but it’s a good idea to save it in case you need
to use it again later.

Create custom settings
Create and modify settings
If the settings that come with Compressor aren’t sufficient for your transcoding needs or if you
simply want additional settings, you can create your own. You can also create a group of settings
so that you can quickly assign multiple settings to a source media file.
The easiest way to create a custom setting is to duplicate an existing setting and then adjust the
copy to suit your needs.
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Create a custom setting
1 In the Settings tab, choose an output format from the Create a New Setting (+) pop-up menu.
Choose an output format
for the new setting.

A new setting called Untitled appears in the Custom folder of the Settings tab, appended with
the selected output file format (for example, Untitled H.264 for Apple Devices).

New Untitled setting

The Inspector window also changes to show this setting’s parameters.
Note:  You can always change the output file format for that setting in the Encoder pane of the
Inspector, but be sure to change the setting name to reflect its output file format.
2 At the top of the Inspector, change the name and description to make it easy to remember why
you created this custom setting.
3 Click the Encoder button in the Inspector, and change the output format and video and audio
codecs and their associated attributes.
Different options are provided in the Encoder pane for each file format.
You can also change options in any of the other panes in the Inspector. For more information,
see Inspector panes on page 42.
4 To Save the setting, click Save.
Search for a setting
The Settings tab in the Settings and Destinations window includes a search field that you can
use to quickly locate the setting you need. For example, you can type “iPhone” to see a list of
settings that mention iPhone.
mm In the Settings tab, click the search field and enter the text to search for.
Both the names and descriptions of the settings are searched to determine if any contain the
text you entered. To clear the text entry and return to a normal settings display, click the search
field reset button (with an X).
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Duplicate a setting
If there is a setting that contains some attributes that you want to use in another setting, you can
duplicate the existing setting and make the necessary modifications to the duplicate rather than
creating a new setting from scratch. Duplicating a stock Apple setting and then adjusting the
duplicate to suit your needs is the most convenient way to create a custom setting.
1 In the Settings tab, select the setting that you want to duplicate.
2 Click the Duplicate Selected Setting button.
Click this button to duplicate
the selected setting.

Select the setting
to be duplicated.

A new setting appears in the Custom folder with the word Untitled appended before the
original name.
3 Select the new setting in the Custom folder.
4 At the top of the Inspector, name the duplicate setting and provide a description.
5 Click the Encoder button in the Inspector, and change the output format and video and audio
codecs and their associated attributes.
Different options are provided in the Encoder pane for each file format.
You can also change options in any of the other panes in the Inspector. For more information,
see Inspector panes on page 42.
6 If you’ve modified the setting in any way, you can do one of the following to save the changes:
••

Click the Save button at the bottom of the Inspector window.

••

Select any other setting.

A dialog asks if you want to save the changed attributes.

7 Click OK to save the changes, or click Revert to cancel the changes and return to the Inspector.
For information about assigning settings, see Assign settings to source media on page 32.
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Create a group of settings
1 Click the Group button in the Settings tab.
A folder called Untitled appears in the Settings tab with “0 Settings” in the Summary area. You
cannot modify this field. It displays the number of settings the group contains.
Enter a name
for the new group.

Click the Group button.

A new, untitled group
with 0 settings is created.

2 In the Inspector, enter a name for the group in the Name field.
3 In the Settings tab, drag the settings you want to group into the group folder.
You can also create hierarchies of groups (groups within groups). Just drag a group folder into
another group folder.

This custom group
contains three other
custom groups, each
with its own settings.

The Summary area displays the number of settings your group contains. Once you have at least
one setting inside the group folder, you can click the disclosure triangle next to the group folder
to show or hide the setting group details. You can also see full details of the settings in any
group by selecting the group and then looking at the Summary pane in the Inspector window.
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Add the same setting to more than one group
1 Select the setting in the Settings tab.
2 To create a copy, click the Duplicate Selected Setting button.
3 Drag the duplicated setting to another group folder.
You can choose to rename the setting—for example, removing the word “copy” from it.
Delete a setting
1 In the Settings tab, select the setting that you want to delete.
2 Click the Delete Selected Settings (–) button, or press the Delete key on your keyboard.
WARNING:  There is no warning when you delete a setting, and you cannot undo the deletion
to restore the setting.

Share settings
Newly created settings are stored as XML files in the home folder at /Users/username/Library/
Application Support/Compressor/Settings/, with the file extension .setting. You can distribute
and share any of your custom settings by placing them in the same location within the home
folder of whatever computer you distributed the settings to. You can also transfer these files the
same way that you would distribute any other file, by emailing them as an attachment or placing
them on a server.
Note:  Settings created using Compressor 4 or later are not compatible with earlier versions
of Compressor.
Copy a setting directly from Compressor
mm Drag one or more settings from the Settings tab to the Finder (to the desktop, for example).
Apply or add a setting to Compressor from the Finder
Do one of the following:
mm Drag one or more settings from the Finder to the Custom folder in the Settings tab.
mm Drag one or more settings from the Finder to an empty space in the Batch window.
A new job appears with one or more target rows populated with the settings.
mm Drag one or more settings from the Finder to an empty space on a job tile in the Batch window.
One or more new target rows appear on the job, populated with the settings.
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About the Automatic settings
Several items in the settings panes have an optional automatic mode. When the automatic mode
is on, Compressor determines the optimal value for the setting.

The Automatic button
is dark when active,
and its item is dimmed.
The Automatic button
is dimmed when inactive,
and its item is selectable.

In general, when the automatic mode is on, its item is dimmed and cannot be changed.
••

If the setting has not been assigned to a source media file: The item says “Automatic.” An
exception is in the Frame Controls pane of the Inspector window, whose state is undetermined
until you have applied the setting to a source media file.

••

If the setting has been assigned to a source media file: The item remains dimmed but shows the
value that will be used.

You can click the Automatic button to turn the automatic mode on (the button darkens) or off
(the button lightens). When the automatic mode is off, you can choose values for an item as usual.
Tip:  It’s a good idea to verify the values for those Inspector settings that are set to Automatic.
Compressor can usually correctly determine the appropriate values; however, there may be
instances where there is not enough information in the source media file to determine the correct
value. For example, some QuickTime clips might not have proper metadata or the metadata might
be incorrect. Additionally, if the source media file uses nonstandard settings (such as the video
frame size or frame rate), Compressor chooses the nearest standard value to use.
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Example: Create custom groups and settings for DVD
For this example, suppose you’re working on an HD project that will eventually end up on both an
HD and an SD DVD. Before that happens, though, you also need to supply SD DVDs of the dailies.
An easy way to handle this is to create two groups of settings:
••

Settings for the dailies: These settings would include an AIFF audio encoder (because you want
it done fast and disc space will not likely be an issue) and an MPEG-2 encoder with an SD
frame size using the fastest settings (because quality isn’t the highest priority). This could also
be an HD encoder if you have an easy way to play an HD DVD.

••

Settings for the final disc: These settings would include an AC-3 audio encoder, an H.264 HD
for DVD video encoder, and an MPEG-2 encoder using the Frame Controls to ensure a highquality SD output video.

You would most likely create a third settings group that would be named after this project and
would contain the above two groups.
Create the groups for dailies and final outputs
1 In the Settings tab, click the Create a New Setting Group button three times to create three new,
untitled groups.
2 Select the first of the new groups and, using the Inspector window, name it after the project.
3 Select the second of the new groups and name it Dailies.
4 Select the third of the new groups and name it Final Discs.
5 In the Settings tab, drag the Dailies and Final Discs groups up until a black box surrounds the
group named after the project, and then release them.
Note:  You can select multiple groups or settings by holding down Shift while selecting them.
6 Locate the Apple settings that come closest to matching what you need each setting to do in
these new groups.
7 Make a copy of each setting by clicking the Duplicate Selected Setting button.
8 Select each copied setting, rename it, and then drag it to the proper folder.

This custom group
contains the other
custom groups, each
with its own settings.
This custom group
contains the settings
used to create the dailies.

This custom group
contains the settings
used to create the
final disc.

You can then select each setting and make any necessary changes to it.
When you’ve imported the source media files and created their jobs, you can just assign the
appropriate group (Dailies or Final Disc) and all the proper settings are applied to the targets.
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Inspector panes
When you select a setting in the Settings tab or a target in a batch’s job, the Inspector shows one
of six panes.
Summary pane
The Summary pane contains the Summary table, which describes all the settings (video and audio
settings, geometry, and filter settings) associated with the setting selected in the Settings tab.
Information in the Summary table is updated automatically whenever any setting is modified.

The Summary table includes the following details:
••

Name: The name of the setting selected in the Settings tab.

••

Description: A description of the setting selected in the Settings tab.

••

File Extension: The extension assigned to the transcoded media file. This identifies which format
your source media file is being converted to.

••

Estimated file size: When a source media file is assigned to the setting, the estimated total file
size is displayed here. When a source media file is not assigned to the setting, this field shows
an estimated size per hour of source length for the source media.
Note:  The estimated total file size is not available for all output formats.

••

Audio Encoder: Details of the audio output file format and other transcoding settings, such as
sample rate, channels, bits per sample, and codec type.

••

Video Encoder: Details of the video output file format and other transcoding settings such as
frame width and height, crop amount (in pixels), frame rate, aspect ratio, codec type, pixel
depth, spatial quality, minimum spatial quality, key frame interval, temporal quality, minimum
temporal quality, and data rate (in bits per second).

••

Filter: Details of all, some, or none (depending on how many filters you selected in the Filters
pane) of the available Compressor filters.
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Encoder pane
You use the Encoder pane to select and configure the output file format and other settings. The
file format options and attributes are different for each format.

••

File Format: Use this pop-up menu to choose an output file format.

••

Extension: The following file extensions automatically appear in this field based on the format
you choose from the File Format pop‐up menu, and if video and audio tracks are enabled.
Don’t alter this field without good reason, because your file may not be recognized if you do.

••

••

aiff: Represents AIFF.

••

ac3: Represents Dolby Digital Professional.

••

caf: Represents Apple CAF files.

••

dv: Represents Digital Video (DV) format video.

••

mpg: Represents MPEG‐1 multiplexed (video and audio) stream.

••

m1v: Represents MPEG-1 video elementary stream.

••

m1a: Represents MPEG‐1 audio elementary stream.

••

m2v: Represents MPEG-2 video elementary stream.

••

m2t: Represents MPEG‐2 transport stream.

••

mpeg: Represents MPEG-2 program stream.

••

m4v: Represents H.264 for Apple Devices.

••

mp4: Represents MPEG-4.

••

mov: Represents QuickTime.

••

tga: Represents TARGA.

••

tiff: Represents TIFF.

Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It’s relevant only if
you’re using Compressor with distributed processing and with two-pass or multi-pass encoding.
For more information, see Job segmenting and two-pass or multi-pass encoding on page 249.
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Frame Controls pane
This pane of the Inspector offers automatic and customized settings for advanced image analysis,
including frame resizing, clip retiming, and deinterlacing.

Frame resizing would be necessary when transcoding between a high-definition (HD) format
such as 1080i and a standard-definition (SD) format such as DV-NTSC. An example of frame
retiming would be when transcoding between video formats with different frame rates such as
NTSC (29.97 frames per second) and PAL (25 frames per second).
Filters pane
You use the Filters pane to add filters to your setting. You can use filters to perform tasks such as
gamma correction and noise removal.

Select the checkbox next to any of the filters you want to include in a particular setting. Use each
filter’s sliders or arrow controls to adjust your filter settings as necessary.
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Filters are applied to the source media file according to their order in the filters list. You can
reorder filters by dragging them up or down in this list.
Geometry pane
You use the options in the Geometry pane to crop and resize the media file being compressed
and set its aspect ratio.

The Geometry pane has three sections:
••

Source Inset (Cropping): Use any of the four fields to enter the number of pixels by which you
want to reduce the source media file size, or choose a setting from the “Crop to” pop‐up menu
to have Compressor enter crop values based on the source media file video content.

••

Dimensions (encoded pixels): Use the Frame Size pop‐up menu or these fields to create an
appropriate output frame size and aspect ratio for your output media file. Use the Pixel Aspect
pop‐up menu to set width and height values to conform to a designated pixel aspect ratio.

••

Output Image Inset (Padding): Use the Padding pop‐up menu to calculate the output height or
width values. With Custom selected, you can enter values in the fields.

For more information about the Geometry pane, see Geometry overview on page 176.
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Actions pane
You use the Actions pane to turn on email notifications about completed transcodes and assign
a default destination to the selected setting.

••

Email Notification to: Select the checkbox to turn on email notifications, and enter the address
where you want the email to go.

••

Default Destination: Choose a destination from the pop‐up menu that you want this setting to
use as its default.

For more information, see Add setting actions on page 184.

Use markers and poster frames
Markers and poster frames overview
Compressor can import and create several different kinds of markers. In addition, Compressor can
import entire lists of chapter markers. Compressor also supports setting a poster frame for a clip.
Compressor can import and create the following types of markers:
••

Chapter markers: Chapter markers allow easy access to index points throughout a DVD,
QuickTime movie, or video podcast. QuickTime Player can interpret any text track containing
time stamps as a chapter track. Chapter markers can also have artwork and a URL assigned to
them that appear when a podcast is played.
These markers appear as purple in the Preview window timeline and are the type created
when you manually add markers using Compressor.

••

Podcast markers: Like chapter markers, podcast markers can have artwork and a URL assigned
to them. However, podcast markers cannot be used to access frames within the clip, and they
don’t appear as chapter markers in QuickTime.
You can use podcast markers to provide a slideshow (with URLs) for users to view when
playing audio podcasts.
These markers appear as red in the Preview window timeline.
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••

Compression markers: Compression markers are also known as manual compression markers.
These are markers you can add in the Compressor Preview window to indicate when
Compressor should generate an MPEG I-frame during compression. For more information
about I-frames, see About GOPs (groups of pictures) on page 99.
These markers appear as blue in the Preview window timeline.

••

Edit/cut markers: Edit/cut markers are also known as automatic compression markers. These
markers are intended to be at each cut or transition point in a sequence. During transcoding,
Compressor uses edit/cut markers to generate MPEG I-frames at these points, improving
compression quality.
These markers appear as green in the Preview window timeline.

Markers are supported in the following output file formats:
••

MPEG-2

••

MPEG-4 when configured for podcasting (audio-only with the Enhanced Podcast checkbox
selected)

••

QuickTime Movie

••

H.264 for Apple Devices

Important:  You can set and configure markers for other output file formats, but they are not
included in the encoded output file.

Manually add and remove markers
The Preview window includes comprehensive marker support, including the ability to manage
markers already added to the source media file, manually add or remove markers, and import
chapter marker lists. When you add a marker to a clip, it appears as a chapter marker by default.
You can then change the marker to a compression or podcast marker if you wish (see Add
compression or podcast markers on page 49).
Add a chapter marker to your clip
1 In the Preview window, choose Show Chapter/Podcast Markers from the Marker pop-up menu,
so that there’s a checkmark by it.

2 Choose a clip from the Batch Item pop-up menu or click the Batch Item selection button until
the clip you want appears in the pop-up menu.
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3 To determine where the marker is to be placed, do one of the following:
••

Drag the playhead to where you want to add a marker.

••

Enter a timecode value in the playhead timecode field.

4 To add a marker, choose Add marker from the Marker pop-up menu (or press M).
A purple chapter marker appears in the timeline.

A purple marker appears
under the playhead after
the marker is added.

5 Choose Edit from the Marker pop-up menu (or press Command-E).
A dialog for editing the marker appears.
6 Enter a name for the chapter marker in the Name field.

For chapter markers, this name appears in the output media file, where it can be seen with
QuickTime Player and in playback devices.
7 If you want to assign an image to the chapter marker, choose one of the following from the
Image pop-up menu:
••

Frame in source: By default, the frame displayed is the frame on which the marker is placed. To
use a different frame as the image, enter a different timecode value.

••

From File: Drag an image to the image well. You can also click Choose to open a file-selection
dialog and select a still-image file to assign to the marker.

8 Click OK.
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Remove a marker from your clip
1 To move the playhead to the marker you want to remove, click either the Move to Previous
Marker or Move to Next Marker control.
2 To remove the marker, choose "Remove marker" from the Marker pop-up menu (or press M).
Import a chapter marker list
1 In the Preview window, choose a clip from the Batch Item pop-up menu or click the Batch Item
selection button until the clip you want appears in the pop-up menu.
2 Choose Import Chapter List from the Marker pop-up menu.
A file-selection dialog opens so that you can locate and select the chapter marker file for that
source media file.
3 Select the chapter marker file and click Open.
The markers are imported and added to the Preview window timeline.
Note:  Although all markers imported by using a chapter marker list are configured as chapter
markers, you can change them to podcast or compression markers. You can also add URLs and
artwork to them as needed.
Important:  The timecode values in the list must be based on the source media file’s timecode.

Add compression or podcast markers
To manually add a compression or podcast marker to a clip, you first add a chapter marker and
then you edit the marker.
Note:  A podcast can have both chapter and podcast markers. The only difference is that the
viewer can navigate directly to a chapter marker but cannot navigate to a podcast marker. For
more information, see Markers and poster frames overview on page 46.
Manually add a compression or podcast marker to a clip
1 In the Preview window, choose the Show Chapter/Podcast Markers and Show Compression
Markers items from the Marker pop-up menu, so that there is a checkmark by them.

2 To determine where the marker is to be placed, do one of the following:
••

Drag the playhead to where you want to add a marker.

••

Enter a timecode value in the playhead timecode field.

3 To add a marker, choose “Add marker” from the Marker pop-up menu (or press M).
A purple chapter marker appears in the timeline.
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4 Choose Edit from the Marker pop-up menu (or press Command-E).
A dialog for editing the marker appears.

5 Choose Compression or Podcast from the Type pop-up menu.
6 in the Name field, enter a name for the marker.
Note:  Podcast marker names do not appear in the output.
7 To add a link, enter an Internet address in the URL field.
When viewing the output, you can click the URL to open a web browser and view the URL’s
website.
8 To assign an image to the chapter marker, choose one of the following from the Image
pop-up menu:
••

Frame in source: By default, the frame displayed is the frame on which the marker is placed. To
use a different frame as the image, enter a different timecode value.

••

From File: Drag an image to the image well. You can also click Choose to open a file-selection
dialog and select a still-image file to assign to the marker.

9 Click OK.
The marker in the timeline changes to blue if it’s a compression marker, or red if it’s a podcast
marker. You can use the Move to Previous Marker and Move to Next Marker buttons to select
other markers in the timeline to edit.
You can also import a chapter marker list. These lists can be in either the QuickTime TeXML format
(an XML-based format for constructing 3GPP-compliant timed text tracks in a QuickTime movie file)
or a plain text chapter list file. For information, see Plain text chapter marker lists on page 51.
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Plain text chapter marker lists
You can create a list of timecode points that Compressor can import to create markers. The
timecode values need to match the timecode of the track’s video clip. The list of timecode values
must be a plain text file; you can create it with TextEdit (as long as you save the file as plain text).
If you create the list with a more advanced word-processing application, be sure to save the file
as a plain ASCII text file with no formatting.

The file must follow these rules:
••

Each marker must be on a new line that starts with a timecode value in the format 00:00:00:00.
These values identify the marker positions.

••

After the timecode value, you can include a name for the marker. You can use a comma, space,
or tab character to separate the timecode value from the marker name.

••

Any lines that do not begin with a timecode value are ignored. This makes it easy for you to
add comments to the list.

••

The timecode values do not have to be listed in chronological order.

Set the poster frame
You can use Compressor to set the poster frame for a movie. This is the frame that appears in
iTunes to represent the movie. If you don’t set the poster frame, iTunes uses the frame 10 seconds
from the movie’s first frame.
Set the poster frame
1 In the Preview window, position the timeline playhead at the frame you want to be the poster frame.
2 Choose “Set poster frame” from the Marker pop-up menu.
A vertical line with a center dot appears in the timeline.
Move the playhead to the poster frame
mm In the Preview window, choose “Go to poster frame” from the Marker pop-up menu.
Note:  This setting is not available if the poster frame has not been set.
Remove the poster frame setting
mm In the Preview window, choose “Clear poster frame” from the Marker pop-up menu.
Note:  This setting is not available if the poster frame has not been set.
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Preview media
Previewing overview
The Preview window has two main roles. It allows you to play batch items before submitting
them for transcoding and to compare versions of your clip to ensure that the quality of the
output media file is acceptable.
When you use the Preview window to compare the original version of the clip with the version
that will be output, you can make and view real-time changes. This comparison lets you check
the effects of settings on your file before spending time and resources transcoding it. Do this to
check the quality of the output media file.

Original version of the clip

Scaled, cropped, and
filtered version of the clip

You can also use the Preview window to enlarge the preview area, manually add I-frames
(MPEG-1 and MPEG-2 only), and designate a portion of your media file for transcoding using the
In and Out markers.

Preview media as source or with settings applied
You can use the Preview window to play back either the original source media file or the file with
a setting applied to it. Source media files appear as a list of filenames. Any settings that have been
applied to the source media file are listed immediately below the file’s name and are indented to
make it easier to identify them. You see different options in the Preview window depending on
whether you choose to view the original source media file or the file with a setting applied.
Important:  Settings you make in the Encoder pane and the Frame Controls pane of the Inspector
cannot be previewed. Only the settings made in the Filters pane and Geometry pane can be
previewed. For an alternative method of previewing Encoder pane and Frame Controls pane
settings, see Transcode a portion of a clip on page 57.
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Preview a source media file
1 If the Preview window is not shown by default, open it by choosing Window > Preview.
Tip:  To open your file in the Preview window in one step, double-click the source media file in its
job in the Batch window.
2 Do one of the following:
••

Choose a source media file from the Batch Item pop-up menu (identified by its filename).
Selects the default
color bars image.
The original source
media file “Nancy
at table CU 5”

A setting applied to the source
media file “Nancy at table CU
5.” The checkmark indicates
that this is currently being
viewed in the Preview window.
••

Click the Batch Item selection buttons until the source media file appears in the pop-up menu.

••

Select the source media file in its job in the Batch window.
Only the Source View button is active (the Setting View button is dimmed). This is because you
selected a regular source media file, so you can only see the unadulterated clip—without the
split-screen divider or cropping bars.

3 Choose a preview screen size from the Preview Scale pop-up menu, or drag the Preview window
handle to a size you like.
This doesn’t affect the display frame size of the actual output media file. That can be set only in
the Geometry pane of the Inspector window.
4 To preview the selected source media file, click the Play button.
Source media files with markers already added, such as files from Final Cut Pro, show the markers
in the timeline. You can manage the markers if needed. For more information, see Markers and
poster frames overview on page 46.
You can use the Preview window to play back Dolby Digital Professional (AC-3) files. Compressor
includes a Dolby Digital decoder so that when you add an AC-3 source media file to a batch and
play it, you can to hear it using your computer’s current speakers. This includes everything from
the built-in stereo speakers, which play a mixed-down version of the AC-3 file if it contains more
than two channels, to a set of external surround speakers connected to a USB or FireWire output.
Important:  Because Compressor is decoding the Dolby Digital audio file, you cannot use your
computer’s optical output to preview Dolby Digital audio.
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This feature is important if you’re using the Dolby Digital Professional encoder because you
cannot preview the encoder’s settings in real time in the Preview window. Instead, you can add
the encoded AC-3 files to a batch and play them to verify that the encoder’s settings produced
good results. For information about creating a short test clip for this purpose, see Transcode a
portion of a clip on page 57.
Preview a clip with an assigned setting
The Compressor Preview window lets you see the effects of your setting—such as filters and frame
resizing—and make adjustments to these attributes while previewing the media file in real time.
1 If the Preview window is not shown, open it by choosing Window > Preview.
Tip:  To open the clip in the Preview window in one step, double-click the target (that contains
the setting) of a job in Batch window.
2 Do one of the following:
••

Choose a setting from the Batch Item pop-up menu (the indented setting names, not the
source filenames).

••

Click the Batch Item selection buttons until the clip with a setting appears in the pop-up menu.

••

Select the clip’s setting in its job in the Batch window.

Both Source View and Setting View buttons are active, so you can switch between these two
views. Because you selected a setting, you can use the split-screen slider and cropping boundary
in the Preview window.
The opening frame of the selected source media file appears in the Preview window, and the title
of the selected setting appears in the Batch Item pop-up menu. The left half of the screen displays
the source media file in its original form (Source view) and the right half displays what the output
image will look like with selected filters and other setting attributes applied to it (Output view).
Batch Item pop-up menu

Batch Item
selection buttons

Output view

Source view
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3 Click the Setting View button in the upper-right corner of the Preview window, and do any of the
following to assign settings:
Batch Item
pop-up menu

Preview Scale
pop-up menu

Source View and
Setting View buttons
Split-screen slider
Cropping boundary
and handles
Cropping dimensions
(also seen in Source
Inset fields in the
Geometry pane)

Split-screen divider

••

Choose a screen size from the Preview Scale pop-up menu, or drag the Preview window to a
size you like.
This doesn’t affect the display frame size of the actual output media file. That can be set only in
the Geometry pane of the Inspector window.
Note:  When you adjust the frame size of a setting (in the Geometry pane) while viewing it
in the Preview window, the frame size may not be resized accordingly. If this occurs, choose
Sample Movie or a different target from the Batch Item pop-up menu and then choose this
target again. It will display the correct frame size.

••

Drag the split-screen slider left or right across the top of the screen to move the split-screen
divider over more or less of the transcoded portion of the clip.

••

Use the cropping boundary to adjust the display frame size of your output media file.
You can check the results of your cropping by clicking the Source View and Setting View buttons.
Note:  The more you reduce the clip image by cropping it, the larger the scale factor of the
output image will be (as the framing geometry conforms to the settings of the output aspect
ratio rather than to the source file settings). This effect is similar to zooming in on an image,
which results in larger pixels and overall image degradation. So make sure that you don’t crop in
so far that the image is enlarged past its original size relative to the original size of the frame.
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••

In the Inspector, click the Filters button to view the filters list. Select the filter that you want to
adjust and make changes as necessary.
Click the Setting View button to see
the effect of the selected filter.

Selected filter settings
are displayed in the
Preview window.

Note:  To preview the effect of a filter on your media file, make sure that the checkbox for that
particular filter is selected in the filters list. Otherwise, the Preview window won’t recognize
that filter, and it won’t be part of the transcoding settings for that job. A selected filter has a
checkmark next to it in the filters list.
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••

If you want to make the display frame size of your output media file different from that of your
source media file, open the Geometry pane of the Inspector window and choose a preexisting
value from the Frame Size pop-up menu or enter different output size values in the Frame
Size fields.

Cropping dimensions
(also displayed in the
Inspector window when
you drag cropping bars)

Note:  MPEG-2 is limited to preestablished display frame sizes based on MPEG-2 specifications.
In this instance, all output size items are unavailable.
4 To view the clip, click the Play button in the Preview window.
For more information about these settings, see Previewing overview on page 52.

Transcode a portion of a clip
Although Geometry (cropping and scaling) and Filters adjustments are displayed instantly in the
Preview window, Encoder pane and Frame Controls pane settings are not. To preview Encoder pane
and Frame Controls pane settings, do a test transcode of a small section of your source media file.
You can use the Preview window to set In and Out points to transcode a portion of your media
file rather than all of it.
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Designate a portion of your media file for transcoding
1 If the Preview window is not shown by default, open it by choosing Window > Preview.
2 To set an In point, do one of the following:
••

Drag the In point to the appropriate location.

••

Drag the playhead to where you want transcoding to begin and click the Set In Point button.

In point
Playhead
Out point

Set In Point button

Set Out Point button

3 To set an Out point, do one of the following:
••

Drag the Out point to the appropriate location.

••

Drag the playhead to where you want transcoding to end and click the Set Out Point button.

Note:  When you use In and Out points to specify a segment of the source media file to transcode,
they apply to all targets assigned to the file’s job. You can add a source media file multiple times to
a batch, creating multiple jobs, and set the In and Out points differently in each job.
The only segment of the media file that will be transcoded is between the two points that you
set. The rest of the clip will not be transcoded.
For information about how to transcode the media file, see Jobs, targets, and batches
overview on page 137.
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Preview window
The Preview window contains the following controls:
Preview Scale pop-up menu
Source View and
Setting View buttons

Preview area

Timeline controls
In and Out controls
Transport controls

Selection and view controls
You can use the Batch Item selection controls to choose specific items from the Batch window
to show in the Preview window. You can also resize the Preview window and switch between
Source view and Setting view.
••

Batch Item selection buttons: Use these buttons to click backward or forward through the list of
source media files and clips with settings available for previewing. As you click through the list,
the selected batch item appears in the Batch Item pop-up menu.
Batch Item
selection buttons

Batch Item pop-up menu
••

Batch Item pop-up menu: Choose the source media file you want to preview, with or without its
assigned settings.

••

Preview scale pop-up menu: Adjusts the Preview screen size. The three settings are 100%, 75%,
and 50%, but you can also drag the Preview window resize control to any size you like.

••

Source View and Setting View buttons: Use these buttons to preview the selected batch item
using either the source’s aspect ratio and size or the setting’s aspect ratio and size. Source view
also provides a cropping boundary that you can use to define one or more edges to be cropped.
Setting view shows the cropped version of the media scaled to its aspect and size setting.
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In and Out controls
After you select the batch item, you can use the In and Out controls to see and adjust the In and
Out point timecode information.
In point timecode

Sets In point to current
playhead position.
••

Out point timecode

Sets Out point to current
playhead position.

In and Out point timecode fields: The exact locations of the In and Out points are displayed
here using the standard timecode format of hh:mm:ss:ff. You can manually edit these fields by
selecting the field and entering new values. If a new value is entered, the timeline’s In or Out
point moves to the specified point in the current batch item.
Note:  If your source media file has a timecode track, the Start and End timecode values of the
clip appear in the In and Out point timecode fields. Otherwise, the timecode starts at 00:00:00:00.

••

In and Out point buttons: You can use the Set In Point and Set Out Point buttons (next to the
timecode fields) to set In and Out points. (You can also set In and Out points by dragging; see
the “Timeline controls” section, below.)

••

Source/output information: The clip’s frame size and frame rate are shown in the lower-left
corner of the Preview window. The clip’s duration (from the In point to the Out point) is shown
in the lower-right corner. With the Source View button active, the frame size and frame rate
represent the source media file. With the Settings View button active, the frame size and frame
rate represent the setting for this batch item.
Note:  To see the total duration of the clip (without In and Out points), select the source file in
the Batch window and open the Inspector window (choose Window > Show Inspector).

Preview area controls
The preview area displays the currently selected batch item.

Split-screen slider
Cropping boundary

Cropping dimensions
(also seen in Source
Inset fields in the
Geometry pane)
Cropping handle for
the lower-right corner
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••

Split-screen slider: Drag the split-screen slider any distance across the top of the preview area
to get a comparison view between the source media file (left side) and output media file (right
side). In addition to the location of the slider at the top, the screen division is indicated by a
vertical white line bisecting the image.

••

Cropping boundary: The cropping boundary is available only in Source view. Use the handles to
drag the red boundary edges and corners in the direction you want to crop your output media
file. Use the center handle to drag the entire frame in any direction while still maintaining its
dimensions. The new values (for left, top, right, and bottom) appear dynamically in the preview
area as you crop the frame. If you also have the Inspector window open with the batch’s target
selected, you can see the same values changing in the cropping fields of the Geometry pane.
To show the results of the crop boundary settings, select the Setting view.

Timeline controls
The timeline controls provide information about the clip, including any markers it has and the
current In and Out point settings. You can also use the timeline to position the playhead at a
specific frame and set the In and Out points.
In point

Playhead timecode
••

Playhead

Out point

Marker

Playhead timecode: Shows the playhead’s position in the timeline using the standard timecode
format of hh:mm:ss:ff. You can enter a new value to precisely position the playhead in
the timeline.
Note:  If your source media file has a timecode track, the clip timecode appears in the playhead
timecode field. For everything else, the timecode starts with 00:00:00:00.

••

In and Out points: You can set new In and Out points by dragging the In or Out point to a
different location. As you change the In and Out points, the In and Out timecode fields at the
bottom of the Preview window update. (You can also set new In and Out points using the Set
In Point and Set Out Points buttons. See the “In and Out controls section” above.
Important:  In and Out points are not preserved after a transcode has been completed, so if
you want to resubmit a batch from the History window, you need to reapply these points to
your clip. For more information, see View batch information in the History window on page 151.
In and Out points are assigned to the source media file rather than the setting, so whatever In
and Out points you create will be the same for all other settings related to that source media
file in the current batch.

••

Playhead: Shows where the displayed frame is located within the clip. You can drag the
playhead to navigate quickly to a specific location within the clip.

••

Marker: Shows where a marker has been placed in the clip. The color of the marker
indicates its type:
••

Blue: Compression markers that you add manually

••

Purple: Chapter markers (named markers that are intended to be navigational chapter stops
or visual artwork in the output media file)
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••

Red: Podcast markers (named markers that are intended to be navigational chapter stops or
visual artwork in the output media file)

••

Green: Edit/cut markers (compression markers that are added automatically at edit points in
the Final Cut Pro sequence)

••

Gray bar with center dot: Poster frame (the bar indicates the frame chosen as the poster
frame for this file)

For more information, see Markers and poster frames overview on page 46.
Transport controls
These move the playhead backward or forward to the exact position of the next marker or In or
Out point, making it easy to navigate quickly between existing markers. You can also use these
buttons to quickly move the playhead to the start or end of the clip.
Play/Pause
Move to Previous Marker

Fast Backward

Move to Next Marker
Playback Loop Mode

Fast Forward

••

Play/Pause button: Starts or stops playback of the clip. If you stop playback, the playhead
remains at its current position. To return to the start of the clip, you need to drag the playhead
back to the beginning or click the Move to Previous Marker button.

••

Move to Previous Marker and Move to Next Marker buttons: Move the playhead to the previous or
next marker, the In or Out point, or the start or end of the clip if no more markers are present.

••

Fast Backward and Fast Forward buttons: Allow you to play your clip in either direction at twice
the normal speed. If one of these buttons is clicked during playback, clicking it a second time
returns playback to normal speed.

••

Playback Loop Mode button: Plays the media in a continuous loop.

Marker pop-up menu
Use the Marker pop-up menu to manage the clip’s markers. Although you can use markers
with all settings, they appear in the output file only when the setting uses the MPEG-1, MPEG-2,
MPEG-4 (when configured for podcasting), H.264 for Apple Devices, or QuickTime Movie output
file format. For more information, see Markers and poster frames overview on page 46.
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Choose items from the Marker pop-up menu to add, remove, show, hide, and edit markers and
poster frames.
••

Import Chapter List: Opens a file import dialog that allows you to import a file containing a list
of chapter marker times for the source media file. For more information, see Add compression
or podcast markers on page 49.

••

Add/Remove marker: The option you see changes depending on whether or not the playhead
is positioned on a marker.
••

If the playhead is not positioned on a marker: Choosing “Add marker” places a new marker in
the timeline at the playhead’s current position.

••

If the playhead is positioned on a marker: Choosing “Remove marker” deletes the current marker.

••

Edit: Available only when the playhead is positioned on a marker. Choosing Edit opens a
dialog that allows you to set the marker type and assign a URL and an image to it. For more
information, see Add compression or podcast markers on page 49.

••

Show Chapter/Podcast Markers: Controls whether chapter and podcast markers (those with
names) are shown in the timeline. A checkmark indicates they are shown.

••

Show Compression Markers: Controls whether compression markers (those without names) are
shown in the timeline. A checkmark indicates they are shown.

••

Show Edit/Cut Markers: Controls whether markers automatically placed at each edit point by
another application, such as Final Cut Pro, are shown in the timeline. A checkmark indicates
they are shown.

••

Set poster frame: Makes the current frame the poster frame, which is a still image that
represents a video or audio media file or a podcast chapter in applications such as iTunes and
the Finder. By default, the first frame in a video file is the poster frame.

••

Clear poster frame: Deletes the poster frame marker.

••

Go to poster frame: Moves the playhead to the poster frame.

Chapter 4    Assign settings and preview media

63

5

Custom settings
and output formats
Custom settings and output formats overview

Selecting a playback platform (Apple devices, DVD, web, CD, and kiosk) is the first choice you
need to make before you compress a source media file into a different output format. After you
decide on the platform, you can choose the appropriate output format for that platform.
Whatever the digital video format of your source media file, you can use one of the many
encoders supplied with Compressor to transcode the source file to the following industrystandard formats, all of which have their own particular attributes.
Platform

Available video formats

Available audio formats

iTunes and Apple devices

H.264: See iTunes and Apple device
output overview on page 65.

AIFF: See AIFF overview on
page 100.
MP3: See MP3 overview on
page 104.

Web delivery, including YouTube,
Facebook, and Vimeo

H.264: See Create QuickTime media
files on page 124.

H.264: See Create QuickTime media
files on page 124.

MPEG-1: See Create MPEG-1 files
for the web on page 108.

MPEG-1: See Create MPEG-1 files
for the web on page 108.

Blu-ray discs

H.264: See Create Blu-ray discs on
page 70.

AC-3 (Dolby Digital Professional): See
Dolby Digital overview on page 72.

High-definition (HD) DVD

MPEG-2: See MPEG-2 overview on
page 84.

AC-3 (Dolby Digital Professional): See
Dolby Digital overview on page 72.

Standard-definition (SD) DVD

MPEG-1: See Create MPEG-1 video
for DVD on page 109.

MPEG-1: See Create MPEG-1 audio
for DVD on page 110.

MPEG-2: See MPEG-2 overview on
page 84.

AC-3 (Dolby Digital Professional): See
Dolby Digital overview on page 72.
AIFF: See AIFF overview on
page 100.

Audio CD

CAF: See Create Common Audio
Formats settings on page 103.
MP3: See MP3 overview on
page 104.
AC-3 (Dolby Digital Professional): See
Dolby Digital overview on page 72.
DV Stream

See Create DV Stream settings on
page 133.

QuickTime Export Components files

See QuickTime Export
Components overview on
page 130.

Image sequence files

See Create image sequence
files on page 134.
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Before you can convert your existing media files to a DVD project, you must convert the video
to MPEG-1 (SD projects only), MPEG-2 (SD and HD projects), or H.264 (HD projects only) files.
Compressor can encode audio in the Dolby Digital Professional format (also known as AC-3).
Dolby Digital Professional is a very common compressed audio format for DVD-Video discs.
Compressor also supports two specialized situations:
••

For those situations in which you’re editing HD sources in Final Cut Pro and want to create
an SD DVD from them, Compressor includes a high-quality downconversion capability. HD
sources using 1080i or 720p resolutions use a high-quality transcoding process to create SD
MPEG-2 video output files.

••

For those situations in which you must fit the maximum video onto a DVD and don’t require
broadcast quality, Compressor includes the ability to export DVD-Video-compatible MPEG-1
format files.

iTunes and Apple device output
iTunes and Apple device output overview
Using Compressor, you can create iTunes-compliant H.264 files. These can be played in iTunes; on
an iPhone, iPad, or iPod; or with Apple TV.
Compressor includes preconfigured settings that use the H.264 for Apple Devices Encoder pane
to make it easy for you to create suitable media files.
For information about creating H.264 files for other uses (such as web video), see QuickTime
movie overview on page 121. For information about creating H.264 files for DVDs, see Custom
settings and output formats overview on page 64.
H.264 workflows
The efficiency and quality of H.264 provide a number of options for iPhone, iPad, iPod, and Apple
TV video producers. When choosing a device option, you can choose to create a file that plays on
a wide variety of devices or a file targeted to a specific device, such as an iPhone 4.
••

Options that are compatible with all devices don’t produce optimal results when played on
higher-resolution devices, such as Apple TV. However, these options produce smaller files,
which can be an advantage.

••

Options that are targeted at higher-resolution devices produce great results on those devices;
however, they result in larger files.

When choosing options, make sure to take into account the devices on which you want to play
the video, the video content, and how you intend to deliver the file.
Additionally, you can assign a clip’s poster frame using the Preview window. For more
information, see Apply frame controls to a setting on page 167. You can change the poster frame
in iTunes if necessary. For more information, see iTunes Help.
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Chapter and podcast markers
Chapter markers created in Final Cut Pro are passed through (transferred) to other output files
that can be recognized by QuickTime Player, iTunes (.m4v files), and Final Cut Pro.
You can also add podcast markers to the output file. Podcast markers are similar to chapter
markers (they can have a URL and artwork assigned to them); however, viewers cannot navigate
to them. They are intended to provide a slideshow function to audio podcasts. For information
about adding chapter and podcast markers, see Markers and poster frames overview on page 46.
Aspect ratios
The choice you make in the Device pop-up menu defines the width of the encoded file. The
choice you make in the Aspect Ratio pop-up menu defines the height of the encoded file.
Compressor scales the source video vertically to make it fit the height. This means that the
source video must be anamorphic (things look tall and skinny) in anticipation of being scaled to
fit the intended aspect ratio. Non-anamorphic video set to an aspect ratio other than its native
aspect ratio appears distorted in the encoded file.
Important:  If your source video is letterboxed, use the aspect ratio that matches the whole
video frame, including the black bars, or you will end up with distorted output files. You can use
the automatic crop feature to crop off the letterbox bars. For more information, see Geometry
overview on page 176.
The following choices are available in the Aspect Ratio pop-up menu for each device option:
••

4:3

••

16:9

••

1.85:1

••

2.35:1

Each choice results in a different height for the output media file. For example, with the iPod/
iPhone (VGA) setting, the 4:3 option results in a 640 x 480 file, whereas the 16:9 option results in
a 640 x 360 file.
If the source media file is either DV NTSC or HDV, but you’re unsure of your source media file’s
aspect ratio, click the Automatic button. This option analyzes the source media file’s aspect ratio
to determine the appropriate pixel dimensions.

Create H.264 settings
To ensure that your output media files are compatible with iPhone, iPad, iPod, and Apple TV, it’s
recommended that you use the standard settings provided in the Apple Devices group in the
Settings tab. For information about applying settings, see Assign settings to source media on
page 32.
You can also create media files compatible with iPhone, iPad, iPod, and Apple TV using batch
templates. For more information, see Quick and easy batch template workflow on page 14.
Note:  Files created using iPhone and iPod settings can also play on Apple TV.
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Create H.264 for Apple Devices settings
1 In the Settings tab, select a setting or create a new setting by choosing H.264 for Apple Devices
from the Create a New Setting (+) pop-up menu.
2 In the Encoder pane of the Inspector window, choose H.264 for Apple Devices from the File
Format pop-up menu.

3 Choose from the following Encoder pane options:
••

Extension: This field displays the H.264 for Apple Devices file extension (.m4v) automatically
after the H.264 for Apple Devices output format is chosen from the File Format pop-up menu
or the Create a New Setting (+) pop-up menu in the Settings tab.

••

Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It’s relevant only if
you’re using Compressor with distributed processing and with multi-pass encoding. For more
information, see Job segmenting and two-pass or multi-pass encoding on page 249.

••

Device: Choose one of the following device options from this pop-up menu:
••

iPod/iPhone (VGA): This option creates video output files with a frame width of 640 pixels.

••

iPod/iPhone (Anamorphic): This option creates video output files with a frame width of 640
(anamorphic) pixels.

••

iPod/iPhone (QVGA): This option creates video output files with a frame width of 320 pixels.

••

Apple TV SD: This option creates video output files with a frame width of 640 pixels and a
higher bit rate range than those created using the iPod/iPhone (VGA) option.

••

Apple TV SD (Anamorphic): This option creates video output files with a frame width of 720
(anamorphic) pixels.

••

Apple TV HD: This option creates video output files with a frame width of 1280 pixels, except
when the aspect ratio is set to 4:3. In that case, the video output files have frame dimensions
of 960 x 720 (anamorphic) pixels for frame rates above 24 fps and 1280 x 720 (square) pixels
for lower frame rates.

••

Apple TV 3rd Generation: This option, intended for the third-generation Apple TV and iPad
models, creates video output files with a frame width of 1920 pixels.

Chapter 5    Custom settings and output formats

67

••

••

iPhone (Local/WiFi): This option creates video output files with a frame width of 854 pixels.

••

iPhone (Cellular): This option creates video output files with a frame width of 176 pixels.

••

iPad/iPhone with Retina display: This option creates video output files with a frame width of
1280 pixels.

Aspect Ratio: Use this pop-up menu to choose the exact pixel dimensions of the output media
file. The available options depend on which device option you chose. For more information,
see iTunes and Apple device output overview on page 65.
The Aspect Ratio setting also has an Automatic button. Clicking the Automatic button causes
the encoder to choose the aspect ratio that matches the source video file.
Important:  When the Aspect Ratio setting is in automatic mode, Compressor can choose from
a wider variety of values to better match the source video (with the values determined and
displayed when this output format is applied to a source media file). For the best results, it’s
recommended that you use the automatic mode for the Aspect Ratio setting.

Aspect Ratio
Automatic button

Note:  By default, the Frame Controls feature is set to Automatic. The Frame Controls retiming
controls are engaged only if the source file is interlaced. For more information, see Frame
controls overview on page 166.
••

Frame Rate: Use this pop-up menu to choose from the options listed below.
The Frame Rate setting also has an Automatic button. Clicking the Automatic button causes
the encoder to choose the frame rate that matches the source video file.
Frame Rate
Automatic button

••

29.97: Used for NTSC-based video

••

25: Used for PAL-based video

••

24: Used for standard video

••

23.98: Used for NTSC-based video

••

15: Used for web-based video
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••

Bit Rate: Use this slider to choose the bit rate to use for the output video, or enter a number
in the text field. The available ranges depend on the Device setting. The setting you should
choose depends on how the output is to be used. Higher bit rates produce better picture
quality, but they also produce larger output files.

••

Audio: Use this pop-up menu to choose from the four audio bit rate options listed below.

••

••

None: Use this option to exclude audio from the output media file.

••

24 Kbps: Creates an audio bitstream at 24 kbps for the iPhone (Cellular) device option.

••

128 Kbps: Creates an audio bitstream at 128 kbps.

••

256 Kbps: Creates an audio bitstream at 256 kbps.

Frame Sync: Also known as the key frame interval, the Frame Sync value represents how often a
key frame is inserted in the H.264 stream. The lower the number, the more smoothly the video
can be manipulated (scrubbed) during playback (more frequent key frames). The higher the
number, the more efficient the compression (less frequent key frames). The available range is
from 2 to 10 seconds; the default is 5 seconds.
The Frame Sync setting also has an Automatic checkbox. Selecting the Automatic checkbox
causes the encoder to choose a frame sync rate that matches the source video file.

••

Multi-pass: Similar to two-pass MPEG-2 encoding, multi-pass offers the best possible quality.
For faster (single-pass) encoding, turn this feature off by deselecting the checkbox.
Note:  If you’re also using distributed processing, you may want to turn off job segmenting. For
more information, see Job segmenting and two-pass or multi-pass encoding on page 249.

••

Include Dolby 5.1: Use this checkbox to add a Dolby Digital Professional 5.1 surround sound
audio track, in addition to the standard AAC audio track, to the output movie. This feature is
intended to be used when creating output files from source files that include surround sound
audio. The Dolby Digital Professional audio track is played by Apple TV only when connected
to a system with a suitable Dolby Digital decoder. The AAC audio track plays in all other cases.
Note:  Selecting the Include Dolby 5.1 checkbox creates a true Dolby Digital Professional 5.1
surround sound audio track only if your source audio includes 5.1 surround sound audio.
If your source audio includes only stereo audio, the Dolby Digital Professional 5.1 surround
sound audio track has only two channels of actual audio.

4 Click Save.
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Create Blu-ray discs

Compressor includes the ability to easily create H.264 settings specifically configured for Blu-ray
and AVCHD discs.
Blu-ray, also known as Blu-ray Disc (BD), is a format that was developed to enable recording,
rewriting, and playback of high-definition (HD) video. The format offers more than five times the
storage capacity of traditional DVDs and can hold up to 25 GB on a single-layer disc and 50 GB
on a dual-layer disc.
An AVCHD disc can be thought of as a simpler HD disc that is burned to red laser media. The
resulting disc plays in Blu-ray Disc players that are compatible with the AVCHD format.
The efficiency and quality of H.264 creates a number of options for optical disc producers:
••

Video resolutions supported by standard-definition (SD) DVDs are also supported by Blu-ray
Disc. This means that a Blu-ray disc can use an HD video resolution file for its main content,
such as a feature film, and then use SD video resolution files for additional features like trailers
and a “making of” documentary.

••

The Create Blu-ray Disc job action can be used to burn an AVCHD disc using red laser media.
An AVCHD disc provides a way to play H.264 video in Blu-ray Disc players that are compatible
with the AVCHD format.

••

Because H.264 can deliver HD video at SD bit rates, you can get more HD content on a regular
DVD-5 disc than you might expect for an AVCHD disc.

Create H.264 for optical disc
1 In the Settings tab, select a setting or create a new setting by choosing H.264 for Blu-ray from
the Create a New Setting (+) pop-up menu.
2 Choose the H.264 for Blu-ray format from the File Format pop-up menu in the Inspector.
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3 To configure settings, choose from the following options:
••

Extension: Displays the H.264 for Blu-ray file extension (.264) automatically after the H.264
for Blu-ray output format is chosen from the File Format pop-up menu or the Create a New
Setting (+) pop-up menu in the Settings tab.

••

Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It’s relevant only if
you’re using Compressor with distributed processing and with multi-pass encoding. For more
information, see Job segmenting and two-pass or multi-pass encoding on page 249.

••

Stream Usage: Use this pop-up menu to choose how you intend to use the H.264 stream.
Compressor modifies the bit rate range settings based on the usage you choose.

••

••

Blu-ray: Choose this option if you intend to use the stream to create a standard Blu-ray disc.

••

AVCHD: Choose this option if you intend to use the stream and the Create Blu-ray Disc job
action to burn an AVCHD disc using a standard DVD burner. This disc can be played in Bluray Disc players that are compatible with the AVCHD format. AVCHD discs can have up to a
maximum of 50 chapter markers.

Video Format: Use this pop-up menu to choose from the four options listed below. All of them
are HD progressive formats.
The Video Format setting also has an Automatic button. Clicking the Automatic button causes
the encoder to choose the video format that matches the source video file.

Video Format
Automatic button

••

••

NTSC: This format is referred to as 480p. It uses a 720 x 480 frame size with an anamorphic 16
x 9 format at 59.94 fps.

••

PAL: This format is referred to as 576p. It uses a 720 x 576 frame size with an anamorphic 16 x
9 format at 50 fps.

••

720p: This format uses a 1280 x 720 frame size with a 16 x 9 format at either 59.94 fps for
NTSC or 50 fps for PAL.

••

1920x1080: This format is referred to as 1080p. It uses a 1920 x 1080 frame size with a 16 x 9
format at either 59.94 fps for NTSC or 50 fps for PAL.

Frame Rate: Use this pop-up menu to choose a frame rate for the output media file.
The Frame Rate setting also has an Automatic button. Clicking the Automatic button causes
the encoder to choose the frame rate that matches the source video file.

Frame Rate
Automatic button

Note:  If you choose a format from the Video Format pop-up menu, the Frame Rate pop-up
menu is filled in automatically.
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Use the Frame Rate pop-up menu to choose from the following options:
••

23.98: Used for NTSC-based video

••

25: Used for PAL-based video

••

29.97: Used for NTSC-based video

••

50: Used for PAL-based video

••

59.94: Used for NTSC-based video

••

Average Bit Rate: Use the slider to choose an average bit rate to use for the output video,
or enter a value in the field. Although the available range for a Blu-ray disc is between 5
Mbps and 30 Mbps, typical video bit rates with H.264 might range from 7 Mbps to 15 Mbps,
depending on your DVD bit budget and the nature of your source media files. The available
range for AVCHD discs is 5 Mbps to 15 Mbps.

••

Maximum Bit Rate: Choose a maximum bit rate between 6 Mbps and 35 Mbps for a Blu-ray
disc, or between 6 Mbps and 17 Mbps for an AVCHD disc. You can also enter any number
within these ranges in the accompanying field. The Maximum Bit Rate setting cannot be
lower than the Average Bit Rate setting. As a general rule, set your maximum bit rate at least 1
Mbps higher than your average bit rate, to allow for bit rate variability in achieving the goal of
constant quality.

••

Multi-pass: Select this checkbox to turn on multi-pass encoding. Similar to two-pass MPEG-2
encoding, multi-pass offers the best possible quality. For faster (single-pass) encodes, turn this
feature off by deselecting the checkbox. For more information, see Job segmenting and twopass or multi-pass encoding on page 249.

4 Click Save As.

Dolby Digital Professional files
Dolby Digital overview
Compressor provides the tools you need to encode and batch-encode Dolby Digital Professional
(AC-3) audio files.
Dolby Digital Professional format (also known as AC-3) is a very common compressed audio
format for DVD-Video discs. Compressor accepts multichannel sound files in a variety of formats
and gives you complete control over the AC-3 encoding process. Dolby Digital programs can
deliver 5.1-channel surround sound with five discrete full-range channels (left, center, right, left
surround, and right surround) plus a sixth channel for low-frequency effects (LFE), sometimes
known as “the subwoofer.” Another surround option is Dolby Surround, with four channels
(left, center, right, and surround). But not all AC-3 audio is 5.1 surround sound. Dolby Digital
Professional is commonly used to encode stereo files to greatly reduce their file size.
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For more information about creating surround sound audio files using other output formats, see
Assign files to surround sound channels on page 74.
Note:  It’s important to understand that Compressor cannot take stereo audio files and create
5.1 surround sound from them. If you want to create a 5.1 surround sound AC-3 audio file, you
must first create the six channels of audio it requires. This must be done using other applications
outside Compressor.
Following are some things to keep in mind as you configure and encode Dolby Digital
Professional AC-3 files.
Source media files
There are a few guidelines to be aware of when encoding Dolby Digital Professional output files
from your source media files.
Depending on the format, a file can contain a single channel (mono), dual channels (stereo), or
multiple channels. Compressor supports Dolby Digital Professional in all these configurations.
Sound files intended for Dolby Digital Professional encoding must conform to the following rules:
••

All source files should be the same duration. (If they aren’t, Compressor sets the duration of
the AC-3 stream to match the duration of the longest file.)

••

All files must have a 48 kHz sample rate (as required for DVD).

••

AC-3 streams must have a multiple of 1536 samples. If the selected input files do not,
Compressor adds digital silence to the end of the files.

Note:  Compressor can support any kind of source files that contain surround sound and highresolution audio up to 64 bits per sample (floating point) and sample rates up to 192 kHz.
Previewing the encoder settings
The settings made in the Dolby Digital Professional Encoder pane cannot be previewed. If you
have an external surround sound device connected to the USB, FireWire, or other output from
the computer, you will be able to hear the audio assigned to the different channels, but it won’t
include any settings, such as the Dialog Normalization or Compression Preset settings.
Important:  Because the audio output is not Dolby Digital, the optical output cannot be used to
verify the audio assigned to each channel.
The only way to verify the settings is to submit the batch and listen to the results. If you’re unsure
of the settings, use the Preview window to encode a short portion of the source as a test. For
more information, see Transcode a portion of a clip on page 57.
You can import an AC-3 file as a source media file into a Compressor batch. Compressor includes
a built-in Dolby Digital decoder that it uses to decode the AC-3 files. This decoder properly
applies any settings you made in the Dolby Digital Professional Encoder pane, allowing you to
hear their effects without having an external Dolby Digital decoder. You can also transcode the
AC-3 files to a different format.
Note:  Surround sound AC-3 files are downmixed to stereo if you don’t have an external surround
sound system connected to the computer.
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Convert stereo audio to Dolby Digital Professional format
Follow these steps to encode a stereo (2/0 L,R) Dolby Digital Professional (AC-3) stream from a
stereo source media file.
Encode an AC-3 stream
1 Add source audio files to the Batch window.
For details, see Importing overview on page 17.
2 Save the batch by choosing File > Save As (or pressing Command-Shift-S), entering a name for
the batch, selecting a location, and clicking Save.
3 To apply the appropriate Apple setting from the Dolby Digital Professional category to the
source audio file, do one of the following:
••

Choose Target > New Target With Setting, choose a setting, and click Add.

••

In the Batch window, Control-click in an empty part of the job, choose New Target With Setting
from the shortcut menu, choose a setting, and click Add.

••

Drag a setting from the Settings tab to the source audio file’s job in the Batch window.

4 Make any adjustments to the setting in the Encoder pane of the Inspector window.
For more information, see Dolby Digital Professional Encoder pane on page 78.
Note:  Compressor maps channels intelligently. Here are some examples:
••

If you import a stereo source file and apply a mono 1/0 (C) audio coding mode to it: The file
is downmixed.

••

If you apply a surround audio coding mode to the stereo file: The left and right channels are
mapped to the left front (L) and right front (R) channels, leaving the other channels of the
coding mode silent.

••

If you assign a stereo file to the left front or left (rear) surround channel: Compressor picks the left
channel and ignores the right channel.

5 Click Submit.
For information about encoding surround sound files, see Assign files to surround sound
channels on page 74. For information about playing your AC-3 audio files with Compressor, see
Preview media as source or with settings applied on page 52.

Assign files to surround sound channels
Compressor offers a streamlined channel assignment technique that can save you time. You can
also use the manual method for assigning individual audio files to surround sound channels.
You can also combine surround audio source files with a video file to make a single Compressor
job. This is useful in audio post-production workflows in which surround audio stems (submixes)
are created separately from the final picture edit. Compressor treats the video and up to six
audio files as a single asset. For example, you could apply the Create DVD job action to make a
DVD with 5.1-channel surround sound.
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Assign files automatically to surround channels using channel identifier codes
1 In the Finder, append the channel identifier code of the target surround channel to the filename
of each source audio file using these codes:
••

-L: Left front channel

••

-R: Right front channel

••

-C: Center front channel

••

-Ls: Left surround channel

••

-Rs: Right surround channel

••

-S: Center surround channel

••

-LFE: Low-frequency effects channel (subwoofer, LFE)

For example, to assign an AIFF file to the left surround channel, rename the file filename-Ls.aiff (where
filename is the name of your file). The channel identifier codes must include the hyphen, as shown.
Note:  OS X may add a file extension like .aiff. This will not interfere with this channel
assignment method.
This procedure works only when you drag files into the Batch window. If you drag the files onto
the Compressor application icon, they’ll appear as separate source files, each in its own job.
Note:  If you’re creating Dolby Digital Professional (AC-3) surround sound streams, you won’t
use all the channels at once. For a diagram of the Dolby audio coding modes, see Dolby Digital
Professional Encoder pane on page 78.
2 Drag the renamed source audio files to the Batch window.
If the following conditions are met, Compressor automatically collapses the entire group of files
into what appears as a single surround source media file in the Batch window:
••

The files in the group must be named correctly. (See the channel identifier codes listed above.)

••

The total number of files in the group must be fewer than seven.

The Inspector window shows the audio files assigned to each channel.

Click a channel’s icon to
change the file assigned
to that channel.
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Note:  You can click a channel icon in the Inspector window to change the file assigned to it.
3 To apply the appropriate Apple setting from the Dolby Digital Professional category to the
source audio file’s job, do one of the following:
••

Choose Target > New Target With Setting, choose a setting, and click Add.

••

In the Batch window, Control-click in an empty part of the job, choose New Target With Setting
from the shortcut menu, choose a setting, and click Add.

••

Drag a setting from the Settings tab to the source audio file’s job in the Batch window.

4 Make any necessary adjustments in the Inspector window and click Submit.
Compressor creates an AC-3 surround audio stream. For information about playing your AC-3
audio files with Compressor, see Dolby Digital overview on page 72.
Manually assign source audio files to channels of a surround sound stream
1 To import the source audio files, do one of the following:
••

Choose Job > New Job With Surround Group (or press Command-Control-I).

••

Click the Add Surround Sound button in the Batch window.

••

Control-click the batch and choose New Job With Surround Group from the shortcut menu.

The channel assignment interface opens.
2 To assign a source audio file to a particular channel, do one of the following:
••

Drag the source audio file from the Finder to the icon for a specific channel (for example, L).

••

Click the icon for a specific channel (for example, L) and use the Open dialog to locate the
source audio file intended for that channel.

The file is now assigned to the L (left front) channel.

3 Repeat step 2 for each source audio file that you intend to include in the surround stream.
Note:  If you’re creating Dolby Digital Professional (AC-3) surround sound streams, you won’t
use all the channels at once. For a diagram of the Dolby audio coding modes, see Dolby Digital
Professional Encoder pane on page 78.
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4 When you’ve finished adding source audio files to the channel assignment interface, click OK.
The group of surround files appears as a single surround source media file job in the Batch
window, and the icons are also shown in the Inspector window.

Click a channel’s icon to
change the file assigned
to that channel.

Note:  You can click a channel icon in the Inspector window to change the file assigned to it.
5 To apply the appropriate Apple setting from the Dolby Digital Professional category to the
source audio file, do one of the following:
••

Choose Target > New Target With Setting, choose a setting, and click Add.

••

In the Batch window, Control-click in an empty part of the job, choose New Target With Setting
from the shortcut menu, choose a setting, and click Add.

••

Drag a setting from the Settings tab to the source audio file’s job in the Batch window.

6 Make any necessary adjustments in the Inspector window and click Submit.
Compressor creates an AC-3 surround audio stream. For information about playing your AC-3
audio files with Compressor, see Dolby Digital overview on page 72.
Combine a video file with surround audio files to make a single source media file
1 To manually assign source audio files to channels of a surround sound stream, follow steps 1
through 5 above.
2 Click the Add Video button and use the resulting Open dialog to choose the video file.
Note:  This feature supports QuickTime source media files only. Image sequences are
not supported.
3 Make any necessary adjustments in the Inspector window and click Submit.
You can further streamline the channel assignment process by encapsulating the automatic
method described above in a Droplet. For more information about Droplets, see Create
Droplets on page 198.
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Dolby Digital Professional Encoder pane
This section contains detailed information about the various tabs within the Dolby Digital
Professional (AC-3) Encoder pane of the Inspector window.

You make your Dolby Digital Professional settings using the tabs described below, by either
modifying an existing setting or creating a new setting in the Settings tab. The Dolby Digital
Professional pane opens with the Audio tab on top.
Basic settings
Use the following basic settings to set up a Dolby Digital Professional (AC-3) job or batch:
••

Extension: This field displays the Dolby Digital Professional file extension (.ac3) automatically
after the Dolby Digital Professional output format is chosen from the File Format pop-up
menu or the Create a New Setting (+) pop-up menu in the Settings tab.

••

Allow Job Segmenting: This checkbox allows you to turn off job segmenting. Because job
segmenting isn’t used for audio-only encodes, this checkbox is dimmed when you choose the
Dolby Digital Professional file format. For more information, see Job segmenting and two-pass
or multi-pass encoding on page 249.

••

Audio, Bitstream, and Preprocessing: These buttons open the Audio, Bitstream, and
Preprocessing tabs described next.

Audio tab
All the most important Dolby Digital Professional settings are accessible in the Audio tab.
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••

Target System: Compressor limits available settings to those appropriate for the target system.
If you’re encoding for use with DVD Studio Pro, choose DVD Video. Choose DVD Audio only
if you’re encoding for use in a DVD Audio authoring application. To remove the setting limits,
choose Generic AC-3.

••

Audio Coding Mode: Specifies the audio channels of the encoded stream. This setting also has
an Automatic button.

Audio Coding Mode
Automatic button

For example, “3/2 (L, C, R, Ls, Rs)” means three front channels (left, center, right), and two rear
channels (surround). “2/0 (L, R)” is essentially a standard stereo file. The audio coding mode
affects settings such as the available bandwidth and surround channel preprocessing. If you
click the Automatic button (next to the Audio Coding Mode pop-up menu), Compressor
makes its best guess at the intended audio coding mode, based on available source audio files.
L

C

L

R

LFE

Ls

R
LFE

Ls

Rs

2/2 channels

C

R

LFE

S
3/1 channels

L

3/0 channels

L

R

R

C

LFE

LFE

2/0 channels
(LFE option not available)

1/0 channels
(LFE option not available)

LFE

Rs

L

R

LFE

3/2 channels

L

C

S
2/1 channels

Note:  In the Audio Coding Mode pop-up menu, “S” stands for a single rear surround channel,
and in this illustration, “LFE” stands for low-frequency effects (also known as the subwoofer). For
more information, see Assign files to surround sound channels on page 74.
••

Enable Low Frequency Effects: Select this checkbox to include the LFE channel in the encoded
stream (not available for 1/0 mono or 2/0 stereo).

••

Sample Rate: Specifies the sample rate. All files intended for video and audio DVD authoring
must have a 48 kHz sample rate as required by the DVD specification. The 32 kHz and 44.1 kHz
sample rates are available only when Generic AC-3 is the target system.
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••

Data Rate: The choices depend on the coding mode and target system. The higher the rate, the
better the quality. AC-3 streams have a constant data rate. At 448 kbps, which is the default
for 5.1 encoding, one minute of AC-3 audio takes about 3.3 MB of storage space. For stereo
encoding, rates of 192 kbps and 224 kbps are typical and will produce good results.

••

Bit Stream Mode: Defines the purpose of the encoded audio material. The information is
included in the finished stream and can be read by some decoding systems.

••

Dialog Normalization: Specifies the average volume of the dialogue, using decibels of full
scale (dBFS), in your sound files relative to full modulation. The playback device uses this
information to maintain similar volume among different AC-3 streams. The goal is to make all
AC-3 encoded audio files have the same listening level, regardless of the source file.
It’s especially important to properly use the Dialog Normalization feature if you have different
audio files (with different volume levels) going on to a DVD. If you know the average level for
each file, enter that number in the Dialog Normalization field for each file. For example, if the
dialogue in your Final Cut Pro project averages around –12 dB on the audio meter, enter “–12”
in the Dialog Normalization field.
Note:  This normalization is between the audio streams on the DVD, not within an individual
audio stream itself. For that type of normalization, use an audio editing tool. You can enter
values from –1 dBFS to –31 dBFS. The difference between the value you enter and 31 dBFS
(which represents the normal dialogue listening level) is the amount that the source audio will
be attenuated.
••

If you enter –31 dBFS: The attenuation is 0 dB (31 dBFS–31 dBFS), and the source audio levels
are not affected at all.

••

If you enter –27 dBFS: The attenuation is 4 dB (31 dBFS–27 dBFS).

••

If you enter –12 dBFS: The attenuation is 19 dB (31 dBFS–12 dBFS).

The louder the source file, the smaller the value you enter, and the more the audio in the
encoded file is attenuated during playback.
If you don’t know the sound level of the source file or for some other reason want to ensure
the Dolby Digital Professional encoder does not affect your sound levels, enter “–31” for the
Dialog Normalization and choose None from the Compression Preset pop-up menu (located in
the Preprocessing tab).
Important:  It’s critical that you set Dialog Normalization correctly if you intend to use any of
the Compression Preset settings. The Compression Preset settings assume that the audio, after
the dialogue has been normalized, is at the normal listening level of 31 dBFS. Levels that are
consistently louder than that result in distorted sound and erratic levels.
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Bitstream tab
These settings are stored in the finished stream for use by the playback device. Leave them at
their default values unless you have a specific technical reason for changing them.

••

Center Downmix, Surround Downmix: If your encoded audio has these channels, but the player
does not, the channels are mixed into the stereo output at the specified level.

••

Dolby Surround Mode: When encoding in 2/0 (stereo) mode, this setting specifies whether the
signal uses Dolby Surround (Pro Logic).

••

Copyright Exists: Select this checkbox to specify that a copyright exists for this audio.

••

Content is Original: Select this checkbox to specify that this audio is from the original source
and not a copy.

••

Audio Production Information: Select this checkbox and fill in the fields below to specify how
the encoded audio content was mixed. Playback devices may use this information to adjust
output settings.
••

Peak Mixing Level: Specifies peak sound pressure level (SPL) (between 80 dB and 111 dB) in
the production environment when this mix was mastered.

••

Room Type: Specifies information about the mixing studio.

Preprocessing tab
Preprocessing options are applied to the audio data before encoding. With the exception of the
Compression Preset setting, leave these settings at their default values unless you have a specific
technical reason for changing them.
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••

Compression Preset: Specifies one of the dynamic range processing modes built into the AC-3
format. The default setting of Film Standard Compression should be used only when you’re
encoding an original mix intended for cinema. In almost all cases, you should choose None.
Important:  It’s critical that you set Dialog Normalization correctly in the Audio tab if you intend
to use any of these Compression Preset settings. The Compression Preset settings assume that
the audio, after the dialogue has been normalized, is at the normal listening level of 31 dBFS.
Levels that are consistently louder than that result in distorted sound and erratic levels.
Note:  If you’re building a Dolby Digital Professional 5.1-channel surround sound DVD, choose
Film Standard Compression.

••

General Digital Deemphasis: Specifies whether input audio data is preemphasized and needs to
be deemphasized before encoding.

••

LFE Channel Low-Pass Filter: Select this checkbox to apply a 120 Hz low-pass filter to the lowfrequency effects (LFE) channel. Turn off this filter if the digital signal fed to the LFE’s input
doesn’t contain information above 120 Hz.

••

Full Bandwidth Chan. Low-Pass Filter: Select this checkbox to turn on a low-pass filter with a
cutoff near the available audio bandwidth that is applied to the main input channels. If the
digital signal fed to the main input channels doesn’t contain information above the available
audio bandwidth, you can turn off this filter, and Compressor automatically determines the
available bandwidth.

••

Full Bandwidth Chan. DC Filter: Select this checkbox to turn on a DC high-pass filter for all input
channels as a simple way to remove DC offsets. Most mixed audio material is already free of
DC offsets.

••

Surround Channels 90º Phase Shift: Select this checkbox to generate multichannel AC-3 streams
that can be downmixed in an external two-channel decoder to create true Dolby Surround–
compatible output.

••

Surround Channels 3 dB Attenuation: Select this checkbox to apply a 3 dB cut to the surround
channels of a multichannel film soundtrack being transferred to a consumer home theater
format. Cinema surround channels are mixed 3 dB “hot” (higher) relative to the front channels
to account for cinema amplifier gains.
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Spatial mixing options
Below are additional suggestions for using the channels in a Dolby Digital Professional program.
Center channel
In a multichannel system, there are three ways to achieve a centrally placed sound image:
••

Create a “phantom center” (mix sound to the left and right equally, as with stereo): This method
is commonly used, but assumes the listener is seated exactly between the speakers (which is
not possible in automobiles and not always the case in homes). The timbre of sound is not the
same as from a direct speaker because of cross-cancelation effects.

••

Use the center channel alone: This creates a stable center image for listeners in any location. (To
prevent the audio from sounding too focused or narrow, its reverb can be spread to the left
and right channels.)

••

Use all three front channels equally or in various proportions: This method allows for greater
control of the range of spatial depth and width. The phantom center can be reinforced by
additional signals in the center channel, which can be enhanced by signals spread into the
left/right pair. The disadvantage is that sound from all three speakers may not blend well or
may not arrive at the listener at the same time, causing side effects such as comb filtering,
shifts in tone color, or smearing. To counteract these side effects, you can first process the
additional signals to change their spatial character, timbre, or prominence relative to the main
center signal.

Surround channels
Subtle surround effects can greatly enhance the listener’s sense of depth compared to
conventional stereo. Popular music often benefits from creative use of surround. But don’t
overdo it. The film industry guideline—don’t use surround effects to distract the listeners from
the story—also works well for music.
LFE channel limitations
The low-frequency effects (LFE) channel is a separate signal with a limited frequency range and
is created by the mixing engineer and delivered alongside the main channels in the mix. A “brick
wall” filter at 120 Hz in the Dolby Digital Professional encoder limits use of the LFE channel to
the bottom two audible octaves. Dolby recommends limiting the signal to 80 Hz when mixing
your sound.
In most music productions (with exceptions such as the famous cannon shots in Tchaikovsky’s
1812 Overture), the LFE channel isn’t necessary. The LFE signal is also discarded in the Dolby
Digital Professional downmix process, so that intense bass signals don’t stress small stereo
systems. Be sure not to include vital information in the LFE channel that would be missed in
mono, stereo, or Pro Logic playback.
Because LFE is separate from other channels, its ability to blend with higher frequencies can be
affected by filters used to generate the LFE signal. To ensure a cohesive audio signal, keep the
entire signal together in the main channel or channels.
Avoid creating an LFE channel for material originally produced without one. Dolby Digital
Professional’s five main channels are all full range, and the LFE channel doesn’t increase the
frequency response. Dolby Digital Professional decoders offer bass management, directing
low frequencies to a subwoofer or other suitable speakers. An LFE track may interfere with
bass management.
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Stereo playback
Even with the popularity of 5.1 systems, you should always address stereo reproduction. There
are three basic ways to do this:
••

Prepare a new stereo mix from the original multitrack elements (using conventional stereomixing sessions).

••

Prepare a studio-adjusted downmix from the multichannel mix. This method takes advantage
of the work that has gone into mixing the 5.1 version. It retains flexibility in the exact
proportions of each channel represented in the final stereo mix.

••

Let the decoder derive a stereo downmix, based on preset formulas in the decoder. Downmix
options and dynamic range control effects can be previewed and adjusted in the production
studio, and a range of adjustments are possible.

Always check the mix on an inexpensive surround system to evaluate how well it sounds on
modest playback systems.
Note:  For more information about Dolby Digital Professional, visit the Dolby Laboratories Inc.
website at http://www.dolby.com.

MPEG-2 files
MPEG-2 overview
MPEG-2 is an internationally accepted compression standard developed by the Motion Picture
Experts Group (MPEG). MPEG-2 allows you to create broadcast-quality video files and was
designed to support high-resolution, high-bit-rate video. It’s the video compression format used
for high-quality video titles on DVD, high-definition (HD) broadcast, and home satellite dish
systems. All DVD players contain the hardware required for MPEG-2 playback.
The Compressor MPEG-2 encoder can create MPEG-2 video streams for the DVD-Video format.
To create DVD-Video discs, you can use a DVD authoring application in conjunction with
Compressor, or you can use the Create DVD job action, which is part of the Create DVD template.
For more information, see Post-transcoding actions overview on page 184 and Create a batch on
page 18.
Standard-definition (SD) MPEG-2
Standard MPEG-2 is full frame rate (23.98 to 29.97 fps) and full-screen resolution (720 x 480 for
NTSC and 720 x 576 for PAL). SD MPEG-2 has the following characteristics:
••

Support for interlaced video: MPEG-2 can support either interlaced or progressive video.
Because MPEG-2 streams are generally played from a local DVD drive rather than over a
network with variable bandwidth, video frame rate usually stays constant, and the video
normally looks completely smooth.

••

No streaming support: MPEG-2 is not suitable for streaming video files over the web because it
requires a high bit rate (2 to 9 Mbps) to maintain acceptable image quality.
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HD sources and MPEG-2
Compressor has several different options and workflows for transcoding HD video source files
into MPEG-2 files.
••

HD on Blu-ray: Compressor can output MPEG-2 files for creating HD-resolution Blu-ray discs
from either HD or SD source media. Compressor can retain the various frame sizes and frame
rates of HD video when transcoding to MPEG-2. Compressor also supports the higher bit rates
required by the Blu-ray format. For more information about creating output for Blu-ray discs,
see Create Blu-ray discs on page 70. For information about adding the Blu-ray job action to a
job, see Post-transcoding actions overview on page 184.
Note:  The other output file format option for Blu-ray discs is H.264, also known as MPEG-4 Part 10.

••

HD to SD downconversion: For those situations in which you’re editing HD sources in Final
Cut Pro and want to create an SD DVD from them, Compressor provides high-quality
downconversion. Compressor retains as much detail as possible during scaling and correctly
preserves progressive or interlaced formats when encoding to MPEG-2 for DVD.
When you import source media into the Batch window, you can click the source’s name in the
Batch window to see resolution, frame rate, and duration information in the lower-left corner
of the Preview window.

Elementary, transport, and program streams
There are three common MPEG-2 stream types that are used to deliver MPEG-2-encoded video:
••

Elementary streams: These streams contain only one MPEG-2 content channel and no audio.

••

Transport streams: These streams can contain several MPEG-2 content channels and associated
audio. All the channels are multiplexed together, allowing the receiver to choose which to play
back. Compressor supports creating single-channel transport streams that can also include
associated audio.
Transport streams can also recover from interruptions during playback, making them ideally
suited for broadcast and streaming applications where noise or network congestion can lead
to interruptions.

••

Program streams: These streams contain only one MPEG-2 content channel and its associated
audio. Program streams require an error-free delivery method and are primarily used for
storage or processing within a computer.

By default, the Compressor MPEG-2 encoder creates elementary MPEG-2 streams. In the Extras
tab of the MPEG-2 Encoder Pane, you can configure the MPEG-2 encoder to create transport
or program streams and choose whether they should include audio. For more information, see
MPEG-2 Encoder pane on page 89.
Note:  The SD DVD and Blu-ray options in the Stream Usage pop-up menu output only
elementary streams. If you choose either of these and then configure the output to be either
a transport or program stream, the Stream Usage setting changes to Generic. For more
information, see MPEG-2 Encoder pane on page 89.
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Create MPEG-2 files
This section includes step-by-step instructions for setting your MPEG-2 attributes prior to
creating MPEG-2 output files with Compressor. Make your MPEG-2 settings from the MPEG-2
Encoder pane by either modifying an existing setting or creating a new one in the Settings tab.
Stage 1: Open the MPEG-2 Encoder pane and choose video format settings
It’s important to match the video format, aspect ratio, and field dominance to those of your
source media file. For a more detailed description of each of these settings, see MPEG-2 Encoder
pane on page 89.
1 In the Settings tab, select a setting or create a new setting by choosing MPEG-2 from the Create
a New Setting (+) pop-up menu.
The MPEG-2 Encoder pane opens in the Inspector window with the Video Format tab displayed.

Choose the type
of MPEG-2 stream
to create.
Click the Automatic
buttons to have the
encoder match the
source media file.

Manually configure these
settings if you don’t intend
to match the source media file.

2 In the Stream Usage pop-up menu, choose the setting (Generic, SD DVD, or Blu-ray) that matches
how you intend to use the encoded video.
This ensures that the MPEG-2 encoding options are restricted to those that are supported by
your intended usage.
3 Choose a format from the Video Format pop-up menu or click its Automatic button.
4 Choose a frame rate from the Frame Rate pop-up menu or click its Automatic button.
5 Choose an aspect ratio from the Aspect Ratio pop-up menu or click its Automatic button.
Before you can choose your aspect ratio, you must determine whether the intended shape of
your source video is 4:3 (normal) or 16:9 (widescreen).
6 In the Field Dominance pop-up menu, choose a field dominance setting based on your source
media type.
For example, for DV choose Bottom First. Or click the Field Dominance Automatic button to let
Compressor determine the correct setting.
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7 If you want to use the timecode from your source video, leave the “Choose start timecode”
checkbox unselected.
Otherwise, select this checkbox and enter a new timecode value.
8 If you selected the “Choose start timecode” checkbox, and your video format is NTSC, select the
“Drop frame” checkbox if you want to use drop frame (rather than non-drop frame) timecode.
Stage 2: Open the Quality tab and choose quality settings
In the Quality tab, you set the MPEG-2 encoding attributes that have the greatest influence on
the resulting quality of your MPEG-2 video output file: encoding mode, average and maximum
bit rate, and type of motion estimation.
1 To open the Quality tab, click the Quality button in the MPEG-2 Encoder pane of the Inspector.
Choose a mode that
fits your time and
quality requirements.
Choose bit rates that
fit your file size and
quality requirements.
Choose a Motion
Estimation setting.

2 Make a selection from the Mode pop-up menu.
For best image quality, choose “One pass VBR Best” or “Two pass VBR Best.” For faster encoding
with excellent image quality, choose “One pass VBR” or “Two pass VBR.” For HD sources, choose
either “One pass VBR Best” or “Two pass VBR Best.”
With two-pass modes, the source media file is examined on the first pass and transcoded
on the second pass, with bit rates tailored to the video content. In contrast, one-pass modes
transcode the material more quickly, but allocate bits less optimally than do the corresponding
two-pass modes.
3 Choose an average bit rate using the Average Bit Rate slider or field, or click the Automatic button.
Note:  Your choice of bit rate may be influenced by several factors, including the complexity of
your source video, the format and number of your audio streams, and the total duration of all
video clips to fit on your DVD.
Choose an appropriate bit rate based on the content and length of your source video and the
intended size (in bytes) of your output file. In DVD authoring, the entire video must fit on the
DVD disc—the lower the bit rate, the more data you can store. However, the higher the bit rate,
the better the image quality is.
As you change the Average Bit Rate value (with the slider or the field), the bit rate calculator
at the bottom of the Quality tab dynamically shows the maximum number of minutes of
video on a DVD-5 disc. The calculator assumes 1.5 Mbps for audio (two-channel AIFF). For more
information, see MPEG-2 bit rates and formats on page 97.
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4 If available, use the Maximum Bit Rate slider or field to set a maximum bit rate.
Because SD DVD players support peak bit rates of up to 10.08 Mbps for video plus audio, you
should set the maximum video bit rate between 8.0 and 8.5 Mbps if you’re using a 1.5 Mbps
(two-channel AIFF) audio track.
Note:  For best results, make sure the maximum bit rate is at least 1 Mbps higher than the
average setting. Larger differences can produce better results.
5 Choose one of the following settings from the Motion Estimation pop-up menu:
••

Good: The fastest motion estimation setting—sufficient when there is relatively low motion
between frames

••

Better: A good general-purpose motion estimation setting—provides very good results even in
the presence of complex interlaced motion

••

Best: The highest-quality setting to handle the most demanding and complex motion for
interlaced sources—somewhat slower than the Better mode

Stage 3: Open the GOP tab and choose GOP settings
Select a suitable GOP structure and size and decide whether you want the GOPs to be open or
closed. For more information about GOPs, see About GOPs (groups of pictures) on page 99.
Note:  These settings are not adjustable if you chose an HD video format in the Video Format tab.
1 To open the GOP tab, click the GOP button in the MPEG-2 Encoder pane of the Inspector.
Choose a GOP structure
to control how many
B-frames are used.

Choose open
or closed GOPs.
Choose a GOP size.

2 Choose a GOP structure from the GOP Structure pop-up menu.
For the majority of MPEG-2 encoding jobs for DVD authoring, choose the IBBP GOP structure.
3 Choose a GOP size from the GOP Size pop-up menu.
For the majority of MPEG-2 encoding jobs for DVD authoring, choose a GOP size of 15 for NTSC
and a GOP size of 12 for PAL and 24p.
The options available in the pop-up menu vary depending on the GOP structure you choose and
whether the GOP is open or closed.
4 Decide whether you want the GOP pattern to be open or closed, and click the appropriate button.
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Stage 4: Choose Extras settings
You can control the inclusion or exclusion of specific MPEG-2 authoring information in the
Extras tab.
1 To open the Extras tab, click the Extras button in the MPEG-2 Encoder pane of the Inspector.

2 If you want Compressor to parse specific MPEG-2 authoring information rather than parse the
information later in DVD Studio Pro, select the “Add DVD Studio Pro metadata” checkbox.
Important:  Selecting this checkbox may make your MPEG-2 files incompatible with any DVD
authoring tools other than DVD Studio Pro 2 (or later).
3 If you want to exclude automatic compression markers from the stream but still retain the
chapter markers, select the “Include Chapter Markers only” checkbox.
4 To create transport or program streams, select the Multiplexed MPEG-1/Layer 2 Audio checkbox.
For more information about settings in the Extras tab, see MPEG-2 Encoder pane on page 89.

MPEG-2 Encoder pane
This section contains detailed information about the various tabs within the MPEG-2 Encoder
pane in the Inspector window. You make your MPEG-2 settings using these tabs, by either
modifying an existing setting or creating a new setting in the Settings tab.
The MPEG-2 Encoder pane opens with the Video Format tab on top.
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Basic settings
•• Extension: Displays the MPEG-2 file extension (.m2v) automatically after the MPEG-2 output
format is chosen from the File Format pop-up menu.
••

Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It’s relevant only if
you’re using Compressor with distributed processing and with multi-pass encoding. For more
information, see Job segmenting and two-pass or multi-pass encoding on page 249.

••

Stream Usage: This pop-up menu allows you to choose how you intend to use the MPEG-2
stream. Compressor modifies the available options and bit rate ranges based on the option
you choose.

••

••

Generic: This option allows you complete access to all the MPEG-2 settings. This is the only option
that supports the MPEG-2 640 x 480 video format in addition to the standard-definition (SD) and
high-definition (HD) video formats. It’s also the only option that supports creating transport and
program streams. It supports the complete bitrate range of 2.0 Mbps to 40.0 Mbps.

••

SD DVD: This option restricts the encoding options to those allowed by the SD DVD
specification. These include the NTSC and PAL video formats and a bitrate range of 2.0 Mbps
to 9.0 Mbps.

••

Blu-ray: This option restricts the encoding options to those allowed by Blu-ray video discs.
These include the SD and HD video formats and a bit rate range of 10.0 Mbps to 40.0 Mbps.

Video Format, Quality, GOP, and Extras: These buttons open the Video Format, Quality, GOP, and
Extras tabs. Their settings are explained in the following sections.

Video Format tab
You use the Video Format tab to make settings related to video formats, frame rates, aspect
ratio, field dominance, and timecode. All of these, except the timecode setting, can be set to
automatically configure themselves based on the video being encoded.

The Video Format tab contains the following controls:
••

Video Format: Choose your output video file format as NTSC, PAL, 720p, HD 1440x1080, HD
1920x1080, or a variety of versions of 640-width formats. The Stream Usage setting determines
which of these formats are actually available. When you choose a Video Format setting, the
other settings in this tab are filled in with default values, or they are dimmed, indicating that
there are no options for that setting. The NTSC and PAL items refer to SD settings for the NTSC
and PAL TV standards. Of the major-market DVD regions, NTSC is used in North America and
Japan, and PAL is used throughout Europe.
Generally, the output video format should match the source video format. For interlaced video
originating from traditional NTSC or PAL camcorders, choose NTSC or PAL from this pop-up
menu. If you’re unsure of your source media file’s video format, you can choose Automatic. This
setting analyzes your source media file’s frame rate to determine the correct video format.
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If you click the Video Format Automatic button, the GOP size is limited to 12 or 15 (based on
whether the video is PAL or NTSC), with a closed IBBP pattern. With Automatic selected, you
cannot change the frame rate setting in this tab, or the GOP settings in the GOP tab. For more
information about GOPs, see About GOPs (groups of pictures) on page 99.

Video Format
Automatic button

Note:  Because MPEG-2 uses fixed video frame sizes, Compressor enters the output frame size
in the fields in the Geometry pane based on your video format selection.
The video format you choose determines the options for the associated characteristics such as
frame size and rate, aspect ratio, and field dominance.
Note:  The normal frame dimensions of SD NTSC digital video are 720 x 486. If you want
to transcode a source file using the NTSC setting, Compressor crops the file to achieve the
required MPEG-2 frame size of 720 x 480, unless you’ve already specified cropping attributes
for your setting. If not, Compressor crops two rows of pixels from the top and four from the
bottom. This crop attribute is only temporary and is not saved in the setting. You can see the
effects of the crop by double-clicking the setting in the job to open the Preview window.
••

Frame Rate: Choose the intended frame rate for the MPEG-2 output file. Film and some video
camcorders create progressive material at 24 fps (or the NTSC variant 23.98 fps). Although the
term “24p” implies video with a frame rate of 24 fps, the frame rate is usually 23.976 fps (rounded
to 23.98 fps). To transcode these sources for DVD playback on NTSC-related TVs, choose the 23.98
setting. For more information, see About GOPs (groups of pictures) on page 99.

Note:  The NTSC frame rate is frequently referred to as 29.97 fps. Similarly, the “NTSC version”
of 24 fps is referred to as 23.98 fps. Both these numbers are actually approximations of the
true values of 30/1.001 and 24/1.001, or 29.97003 and 23.97602 shown to more decimal places.
These numbers show that 29.97 is a pretty good approximation of 30/1.001 (only 3 frames drift
in 100,000 seconds), but that 23.976 would be much better than 23.98. In fact, even though
23.98 is used as shorthand in Compressor Help and in the Compressor user interface, accuracy
of 23.976 or better is maintained internally in Compressor, and generally within QuickTime as
well. For more information, see About GOPs (groups of pictures) on page 99.
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••

Aspect Ratio: Choose the aspect ratio of your video file. The default is 4:3. The other option
of 16:9 is used for anamorphic DVD. The aspect ratio determines how the picture fills the
television screen. A 16:9 (widescreen) DVD viewed on a typical 4:3 television appears in
letterbox format (black bars at the top and bottom of the screen). However, a widescreen DVD
displayed on a 16:9 (widescreen) TV fills the screen.

••

Field Dominance: Choose whether the top field or the bottom field of your interlaced source
media file will be the dominant (first) field in the output MPEG-2 video file. If you choose
Automatic (the default), Compressor analyzes the source video and attempts to determine
field dominance automatically. The bottom field is dominant for DV source video. This setting
does not pertain to the 720p video format, because that format must be progressive.

Note:  For interlaced video, the top field is also known as the upper or odd field, and the
bottom field is also known as the lower or even field.
••

Choose start timecode: If you leave the checkbox unselected (the default), Compressor embeds
the source media file’s existing timecode in the output media file. Selecting this checkbox
allows you to override the source media file’s timecode and enter a new timecode value in the
timecode field. This field is dimmed unless the checkbox is selected, and if it’s left blank, the
output media file uses the default starting timecode value of 00:00:00:00.

••

Drop Frame: If you select the “Choose start timecode” checkbox, and you want your timecode
to be drop frame (rather than non-drop frame), you must also select this checkbox.
Timecode is a numbering system for labeling the frames in a video sequence. The type of
timecode designed for 30 fps video has a frame counter that counts from 0 to 29 and then
increments the seconds counter and returns to 0. This type of timecode, also known as nondrop frame timecode, maintains an accurate measure of elapsed time for true 30 fps video.
However, the NTSC frame rate is 29.97 fps, so drop frame timecode was defined to provide
a more accurate measure of elapsed time for NTSC. Drop frame timecode skips frame
numbers 0 and 1 once a minute on the minute, except for every 10 minutes. For example,
drop frame timecode 01:08:59;29 is followed by 01:09:00;02, skipping timecode numbers
01:09:00;00 and 01:09:00;01.
Note:  Drop frame timecode applies only if you’re using interlaced NTSC video.
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Quality tab
The Quality tab allows you to set the bit rate for your video so that it can be transcoded to a
suitable data size and quality.
In addition to the controls, the lower-right corner shows an estimate of how many minutes of
video would fit on a 4.7 GB DVD using the current settings. This time assumes a single AIFF audio
stream to be used with the MPEG-2 stream.

Mode pop-up menu

Motion Estimation
pop-up menu
Time estimate for a 4.7
GB disc with a stereo
AIFF audio stream
••

Mode: Choose one of the following MPEG-2 encoding modes. (HD-quality modes are “One pass
VBR Best” and “Two pass VBR Best.”)

••

One pass CBR: Using this mode, the output MPEG-2 video stream’s bit rate is held approximately
constant from one GOP to the next. This is the fastest Compressor MPEG-2 encoding mode,
and it provides good to very good quality, especially at bit rates between 5 and 9 Mbps.

••

One pass VBR: This VBR (variable bit rate) encoding mode aims to maintain constant quality
(at the expense of constant bit rate) for the transcoded video file. This means that in scenes
with much detail or fast motion, Compressor allows a higher bit rate than it allows in less
detailed or still parts of the stream. In spite of this bit rate variability, Compressor ensures
that your specified average bit rate is achieved accurately and that the maximum bit rate is
not exceeded. Unlike the two-pass modes, “One pass VBR” doesn’t have a “bird’s-eye” view of
the source media prior to encoding, so its bit allocation is less optimized than that of “Two
pass VBR.” Nonetheless, for most standard-definition (SD) media files at bit rates of 3.5 Mbps
and above, this mode provides good to excellent quality and transcodes quickly.

••

One pass VBR Best: This is similar to “One pass VBR,” but Compressor applies greater effort
to its internal decision-making process. Although “One pass VBR Best” transcodes slower
than “One pass VBR,” it provides excellent to outstanding SD video quality at bit rates of 3
to 3.5 Mbps and above. Bit rates for high-definition (HD) MPEG-2 can range from 10 to 29
Mbps average, 12 to 29 Mbps maximum. Compared to “One pass VBR,” “One pass VBR Best”
provides higher quality, especially for difficult material at low bit rates. For short streams of
1 to 2 minutes or less, if you’re using “One pass VBR” or “One pass VBR Best,” the average bit
rate accuracy may be compromised by as much as 10 to 30 percent.
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••

••

Two pass VBR: In this mode, Compressor reads through the entire source video file twice.
In the first of these passes, Compressor analyzes the entire source video stream prior to
transcoding it to determine the degree of encoding difficulty of each scene. It then creates
a bit rate allocation plan that gives a higher bit rate to complex scenes and a lower bit rate
to easy scenes, in order to achieve the specified average bit rate without exceeding the
specified maximum bit rate. In the second pass, Compressor does the actual compression,
creating the MPEG-2 output video file according to its bit rate allocation plan. As with “One
pass VBR,” the goal of “Two pass VBR” is constant quality rather than constant bit rate. Unlike
“One pass VBR,” “Two pass VBR” is able to establish an overview of where best to spend its
bits across the entire source media file, before beginning the actual encoding. The result of
this process is that transcoding time is almost twice that of “One pass VBR.” Although the
benefit is not twice the quality, “Two pass VBR” provides more consistent overall quality than
“One pass VBR,” especially in source media files with a substantial difference between the
most and the least complex scenes.

••

Two pass VBR Best: In this mode, Compressor devotes more effort to its internal decisionmaking process than it does for “Two pass VBR.” Encoding time for “Two pass VBR Best” is
slower than for “Two pass VBR,” but it provides the best possible quality that the Compressor
MPEG-2 encoder has to offer. This mode provides outstanding quality at bit rates of 3 to 3.5
Mbps and above for SD video. For information about using the two-pass modes with job
segmenting, see Job segmenting and two-pass or multi-pass encoding on page 249.

Average Bit Rate: Set the average bit rate by dragging the slider or entering a number in the
accompanying field. The available range depends on the Stream Usage setting. You can
also click the Automatic button to the right of the field to have Compressor determine the
appropriate average and maximum bit rates.
Note:  The average bit rate setting directly controls the size of the encoded file. The maximum
bit rate setting does not affect the encoded file’s size.

••

Maximum Bit Rate: Set the maximum bit rate by dragging the slider or entering a number in
the accompanying field. The available range depends on the Stream Usage setting.
Note:  This slider is available only with the VBR modes and cannot be set lower than the
average bit rate. The slider is also not available if the Automatic button is active.

••

Motion Estimation: The items in this pop-up menu provide trade-offs between image quality
and processing time, especially if there is a lot of motion in the source file.
••

Good: The fastest motion estimation setting. This mode does well even with significant
amounts of motion between frames, if the motion has minimal interfield motion within
frames. For example, footage that has been exposed to frame rate conversion or other
effects processes tends to have little interfield motion. In general, use Good with the onepass encoding modes.

••

Better: A good general-purpose motion estimation setting. The Better mode provides
good results even with complex interlaced motion. Better works well for almost all types
of interlaced video sources, even shaky footage from handheld consumer camcorders. In
general, use Better with “One pass VBR” and “Two pass VBR.” If you’re using a progressive
video format, the Better mode does only frame-based motion estimation, and not fieldbased motion-vector searching, which isn’t relevant for progressive source files. In this case
the Better mode will run somewhat faster.

••

Best: This is the highest-quality motion estimation setting and should be used for the most
demanding and complex motion for interlaced sources. It’s slower than the Better mode.
In general, use the Best mode to maximize quality when using “One pass VBR Best” or “Two
pass VBR Best.”
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GOP tab
You use the GOP (group of pictures) tab to select a GOP format, structure, and size. For more
information, see About GOPs (groups of pictures) on page 99.
Note:  If you choose any of the HD video formats in the Video Format tab, the settings in the GOP
tab cannot be changed and default to a closed IBBP GOP structure with a size of 12 (for PAL) or
15 (for NTSC).

••

GOP Structure: Choose an option from this pop-up menu to specify whether there will be two,
one, or no B-frames between the reference frames within a GOP. GOP structure, along with
GOP size, determines the number of I-frames, P-frames, and B-frames that are used within a
GOP during encoding.
Note:  For most MPEG-2 encoding situations intended for use on a DVD, choose IBBP as the GOP
structure setting, and a GOP size of 15 for NTSC, or 12 for PAL. These selections give the best
results in most situations. For more information, see About GOPs (groups of pictures) on page 99.

••

••

IP: No B-frames are used with this setting. Choose IP only if your media contains fast motion
that isn’t encoded with sufficient quality using an IBBP or IBP structure.

••

IBP: One B-frame is used between reference frames (I-frames and P-frames). Choose this
setting only if your media contains fast motion that isn’t encoded with sufficient quality
using an IBBP structure.

••

IBBP: Use IBBP for the majority of MPEG-2 encoding situations, along with a GOP size of 15
for NTSC, or 12 for PAL. Two B-frames are used between reference frames with this setting.

Open and Closed: Closed GOPs don’t contain any frame that refers to a frame in the previous
or next GOP, whereas open GOPs begin with one or more B-frames that reference the last
P-frame of the previous GOP. Closed GOPs created by the Compressor MPEG-2 encoder begin
with an I-frame. Select your GOP type (open or closed) based on whether and how you create
chapter markers for DVD authoring and whether you intend to use multiple video angles in
your title. For more information, see About GOPs (groups of pictures) on page 99.
••

Open: Select this option to create open GOPs.

••

Closed: Select this option to create closed GOPs.
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••

GOP Size: Choose how many frames are contained within your GOP, following the format of the
chosen GOP structure. The maximum GOP size you can choose within Compressor is 15 frames
(NTSC) or 12 frames (PAL and 720p). The minimum GOP size for all video formats is 6 frames
(closed GOP) or 7 frames (open GOP). The relationship between GOP structure and GOP size
gives you GOP patterns. For more information, see About GOPs (groups of pictures) on page 99.

••

Pattern: This field cannot be edited but displays the actual GOP pattern based on your chosen
GOP structure and size.

Extras tab
You use the Extras tab to include or exclude specific MPEG-2 authoring information.

••

Add DVD Studio Pro metadata: Selecting this checkbox allows Compressor to parse specific
MPEG-2 authoring information during the transcoding process to accelerate the import
process into DVD Studio Pro. However, these MPEG-2 files will be incompatible with versions of
DVD Studio Pro 1.5 or earlier. Leaving the checkbox unselected means the information will be
parsed later in DVD Studio Pro.
Note:  MPEG-2 streams with additional DVD Studio Pro metadata are compatible only
with DVD Studio Pro 2 (or later). MPEG-2 streams created with this checkbox selected are
incompatible with versions earlier than DVD Studio Pro 2 or with other DVD authoring
tools. All Apple settings have this checkbox selected by default. To make your MPEG-2 files
compatible with other DVD authoring tools, deselect this checkbox, and then save the setting.

••

Include Chapter Markers only: Selecting this checkbox excludes unnamed compression markers
from the stream but still retains the chapter markers. Leaving the checkbox unselected allows
all markers to be recognized in the output media file. For more information about chapter
markers, see Add compression or podcast markers on page 49.
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••

YUV 4:2:2 Color encoding (Not for DVD use): Select this checkbox to enable 4:2:2 color encoding.
This option is supported in the creation of MPEG-2 elementary, program, and transport
streams, but it’s available only when the Stream Usage pop-up menu is set to Generic.

••

Multiplexed MPEG-1/Layer 2 Audio: Select this checkbox to create a multiplexed stream (rather
than an elementary stream). You can make the output file either a transport stream or a program
stream. For information about the different stream types, see MPEG-2 overview on page 84.
The audio in this stream is MPEG-1 Layer 2, with a sample rate of 44.1 kHz or 48 kHz
(depending on the source) and a bit rate of 384 kbps. To create an audio-only (MPEG-1/Layer 2
Audio) elementary stream, see Create MPEG-1 audio for DVD on page 110.
Important:  Generic is the only Stream Usage setting that supports transport and program
streams. Selecting the Multiplexed MPEG-1/Layer 2 Audio checkbox changes your Stream
Usage setting to Generic if it’s currently anything else.

MPEG-2 bit rates and formats
The following sections contain useful information for creating MPEG-2 output media files.
Bit rates
When determining average and maximum bit rates for standard DVD playback, remember to
consider the bit rate of your audio track as well as the MPEG-2 bit rate.
You must keep the total of both average and maximum audio and video bit rates under 10.08
Mbps, the maximum guaranteed transfer rate from standard DVD players. Because DVDcompatible audio formats are constant bit rate (CBR), there is no maximum audio bit rate to
worry about.
For example, if you’re using AIFF audio at 1.5 Mbps, you should keep both the average and
maximum video bit rates under 8.5 Mbps. Typically, your average bit rate is lower than this (for
example, 3.5 Mbps for 2 hours of footage on your DVD). However, your maximum bit rate must
also stay below this number. A maximum bit rate of 8.0 Mbps is recommended to provide an
extra margin for error (for example, to accommodate subtitle streams). If you’re using one of
the DVD-compatible compressed audio formats such as Dolby Digital or MPEG-1/Layer-2, your
audio bit rate may be as low as 0.2 to 0.4 Mbps, in which case you can set your maximum bit rate
about 1 Mbps higher.
Also, as a general rule, set your maximum bit rate at least 1 Mbps higher than your average bit
rate, to allow for bit rate variability in achieving the goal of constant quality.
The following table shows some average bit rates and corresponding footage times for a 4.7 GB DVD:
Average bit rate

Approximate duration for 4.7 GB DVD

3.5 Mbps

121 minutes

5.0 Mbps

94 minutes

6.0 Mbps

82 minutes

7.5 Mbps

68 minutes

8.0 Mbps

65 minutes

Note:  When “One pass VBR” or “One Pass VBR Best” is chosen for very short clips (less than a
minute or two in length), the resulting MPEG-2 output file size may not accurately reflect the
average bit rate you specified. If the MPEG-2 output media file is larger than you want, you can
try transcoding it again at a lower average bit rate.
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MPEG-2 video frame sizes and formats
Because MPEG-2 uses fixed video frame sizes, Compressor enters the output frame size in the
fields in the Geometry pane based on your video format selection.
The video format you choose in the Video Format pop-up menu determines the options for the
associated characteristics such as frame size and rate, aspect ratio, and field dominance. For more
information, see MPEG-2 Encoder pane on page 89.
Video format

Frame size (pixels)

Frame rate (fps)

Aspect ratio

Scanning method

NTSC

720 x 480

23.98 (progressive
only), 29.97

4:3 or 16:9

Interlaced,
progressive

PAL

720 x 576

25

4:3 or 16:9

Interlaced,
progressive

720p

1280 x 720

23.98, 25, 29.97, 50,
59.94

16:9

Progressive

HD 1440 x 1080

1440 x 1080

23.98 (progressive
only), 25, 29.97

16:9

Interlaced,
progressive

HD 1920 x 1080

1920 x 1080

23.98 (progressive
only), 25, 29.97

16:9

Interlaced,
progressive

640 x 480 (1.33)

640 x 480

23.98, 25, 29.97

4:3 or 16:9

Interlaced,
progressive

640 x 360 (1.78)

640 x 360

23.98, 25, 29.97

4:3 or 16:9

Interlaced,
progressive

640 x 352 (1.82)

640 x 352

23.98, 25, 29.97

4:3 or 16:9

Interlaced,
progressive

640 x 384 (1.67)

640 x 384

23.98, 25, 29.97

4:3 or 16:9

Interlaced,
progressive

640 x 320 (2.00)

640 x 320

23.98, 25, 29.97

4:3 or 16:9

Interlaced,
progressive

About 24p (23.98p)
For DVD authoring and encoding, 24p refers to a video sequence that contains 24 progressive
(non-interlaced) frames per second, with NTSC-related standard-definition (SD) frame dimensions
(720 x 480 for MPEG-2). Film-based movies have a native frame rate of 24 fps, and because the
MPEG-2 format is able to represent 24 fps video internally, many commercial movie DVDs are
encoded in this way. But any time you use NTSC video in your project, the frame rate of filmtransferred material is slowed down from 24 fps to 23.976 fps (rounded to 23.98) and a 2:3:2:3
pulldown is added. So, the more accurate term is actually 23.98p.
Compressor can also do this for 24p source video files. For such material, the 23.98 frame
rate option (in the Video Format tab) compresses each source frame one-for-one, without
compressing repeated frames or fields in order to achieve a 29.97 fps display rate. This results in
higher quality at a lower compressed bit rate than would be possible if the 24p material were
converted to 29.97 fps prior to transcoding. Compressor also sets internal MPEG-2 frame flags
correctly, so that DVD players will properly apply the 3:2 pulldown process for display on 29.97
fps interlaced NTSC TV sets.
Note:  If your source video has a frame rate of 24.00 fps rather than 23.98 fps, Compressor skips
one out of every 1000 source frames. If the 24p source video is 23.98 fps, Compressor transcodes
all source frames, without skipping (or repeating) any of them.
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About GOPs (groups of pictures)
A major feature of MPEG-2 encoding is its ability to remove redundancy, not only within a frame
but also among a group of frames. MPEG-2 uses three frame types (I, P, and B) to represent the
video. A group of pictures (GOP) setting defines the pattern of the three frame types used. These
three frame types are defined in the following ways:
••

Intra (I): Also known as the key frame. Every GOP contains one I-frame. The I-frame is the only
MPEG-2 frame that can be fully decompressed without any reference to frames that precede
or follow it. It’s also the most data-heavy, requiring the most disk space. If you want to place an
I-frame at a scene change or some other specific frame location, you need to manually set it
using the Preview window. This is known as a forced I-frame. For more information, see Markers
and poster frames overview on page 46.

••

Predicted (P): Encoded from a “predicted” picture based on the closest preceding I- or P-frame.
P-frames typically require much less disk space than do I-frames because they reference a
preceding I- or P-frame in the GOP.
Note:  Both I-frames and P-frames are also known as reference frames, because a B-frame may
refer to either one or both frame types.

••

Bi-directional (B): Encoded from an interpolation of succeeding and preceding reference
frames, either I-frame or P-frame. B-frames are the most storage-efficient MPEG-2 frame type,
requiring the least amount of disk space.

The use of B- and P-frames is what allows MPEG-2 to remove temporal redundancy, contributing
to its ability to compress video efficiently.
You need to consider the following factors when choosing a GOP setting.
GOP structure
This setting specifies whether there will be two, one, or no B-frames between the reference
frames within a GOP. GOP structure, along with GOP size, determines the number of I-, P-, and
B-frames that are used during transcoding.
The GOP structure you choose depends on how far apart P-frames should be spaced. Because a
P-frame is predicted from the previous reference frame (either an I-frame or a P-frame), if there
are one or two B-frames in between, the prediction must cover the distance objects can move
over the duration of two to three frames.
In principle, the less average motion there is from one frame to the next, the farther apart
P-frames can be spaced, and the greater the compression can be. For most video material,
the IBBP structure is a good choice. Material with unusually fast motion throughout the entire
sequence may benefit from an IBP or IP structure, but in such cases a relatively high bit rate (6 to
8 Mbps for SD video) may be required for good quality.
GOP size
This setting specifies the number of frames within a GOP. Because exactly one I-frame exists
per GOP, longer GOP sizes generally provide greater compression, because B- and P-frames are
smaller than I-frames.
For most media, spacing I-frames about 1/2 second apart gives good results. This equates to a
GOP size of 15 frames for NTSC and 12 frames for PAL. The DVD-Video specification prohibits GOP
lengths from being much longer than this. Generally, only material with scene changes occurring
less than 1/2 second apart frequently throughout the video benefits from shorter GOP sizes.
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Open and closed GOPs
Open GOPs are most efficient because they allow an extra B-frame in the GOP pattern. Open
GOPs start with a B-frame that is able to look at the last P-frame from the preceding GOP as well
as the first I-frame of its own GOP.
Open GOP
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By definition, closed GOPs cannot contain any frame that refers to a frame in the previous or next
GOP. In contrast, open GOPs begin with one or more B-frames that reference the last P-frame of
the previous GOP. Closed GOPs created by Compressor always begin with an I-frame.
Open GOPs generally provide slightly better compression than do closed GOPs of the same
structure and size. The illustration above shows that a closed GOP contains one more P-frame
than does an open GOP of the same length. Because P-frames generally require more bits than
do B-frames, the open GOP achieves slightly better compression.
There are limitations to using open GOPs for DVD-Video discs that are created using a DVD
authoring application. One limitation is that only closed GOPs are permitted within MPEG-2
streams that will be used for mixed-angle or multi-angle DVDs.
The other limitation is that DVD chapter markers can be set only at the beginning of a closed
GOP. The best time to define chapter markers is before doing MPEG-2 transcoding. For example,
if you specify your chapter markers in Final Cut Pro, you can set Compressor to do MPEG-2
transcoding with open GOPs. Compressor then forces a closed GOP to begin only at the specified
chapter markers and makes all other GOPs open. You can also accomplish this by specifying
“forced I-frames” in the Compressor Preview window and giving them a chapter name to be used
by a DVD authoring application.
However, if you want to specify chapter markers at any GOP boundary after your video has been
transcoded in the MPEG-2 format, you should use only closed GOPs. This freedom is limited, as it
allows you to set chapter markers only at GOP boundaries, rather than at any video frame.

AIFF files
AIFF overview
The Audio Interchange File Format (AIFF) was developed by Apple for storing high-quality audio.
The format was intended for DVD or CD authoring and is now one of the most commonly used
audio file formats for the Mac OS.
Note:  Choose the AIFF option from the File Format pop-up menu only if you need to create
a specialized AIFF file. If you’re creating a standard AIFF file, choose the Common Audio
Formats option.
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QuickTime audio sample sizes and rates
If you have the disk space and bandwidth, it’s best to leave your audio uncompressed.
Uncompressed audio normally uses 8-bit (phone quality) or 16-bit (CD quality) samples. Compressor
supports up to 64 bits per sample floating point and a maximum sample rate of 192 kHz.
Choosing an audio codec for distribution
MPEG-4 Audio (AAC) is a good general-purpose audio delivery codec and is compatible with a
wide variety of playback devices. For slower computers, less-compressed formats, such as IMA,
or completely uncompressed formats, such as AIFF, may be better choices, because they are less
processor intensive, thus allowing the computer to focus on the more challenging video stream.

Create AIFF settings
When you choose the AIFF output file format as your output format, you can only create audio
settings (because AIFF is an audio-only format). If you want to add an audio codec to your AIFF
preset, you need to open the Sound Settings dialog and choose your audio codec settings
from there.
Create an AIFF audio codec setting
1 In the Settings tab, select a setting or create a new setting by choosing AIFF from the Create a
New Setting (+) pop-up menu.
2 Choose AIFF from the File Format pop-up menu in the Encoder pane of the Inspector window.

Choose AIFF.
Extension field
Click to open the Sound
Settings dialog.

QuickTime AIFF
Summary table

Note:  The Extension field displays the AIFF file extension (.aiff) automatically after the AIFF
output format is chosen from the File Format pop-up menu or the Create a New Setting (+)
pop-up menu in the Settings tab. Don’t alter this field.
The Allow Job Segmenting checkbox allows you to turn off job segmenting. Because job
segmenting isn’t used for audio-only encodes, this checkbox is not available with the AIFF file
format. For more information, see Job segmenting and two-pass or multi-pass encoding on
page 249.
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3 Click the Settings button in the AIFF Encoder pane.
The Sound Settings dialog opens.

Choose an audio
codec from the
Format pop-up menu.

4 Choose an audio codec from the Format pop-up menu and either accept its default settings or
customize the other audio codec settings:
••

Channels: Choose the type of channel output, such as mono, stereo, or some type of
multichannel output, depending on the codec.

••

Rate: Choose the sample rate you want to use for your media file. The higher the sample rate,
the higher the audio quality, but the larger the file. Downloading a larger file takes longer and
requires more bandwidth.

••

Show Advanced Settings: This checkbox remains dimmed unless the codec you chose from the
Format pop-up menu offers additional options. For information about the additional options
for a codec, contact the codec’s manufacturer.

Note:  You can see full details of the current contents of your preset by viewing the QuickTime
AIFF Summary table in the Encoder pane.
5 To save your settings, click OK.
6 In the AIFF Encoder pane of the Inspector, click Save.

Common Audio Formats files
Common Audio Formats overview
The Common Audio Formats setting makes it easy to create audio files in the following formats:
••

AIFF: The Audio Interchange File Format (AIFF) was developed by Apple for storing highquality audio. The format was intended for DVD or CD authoring and is now one of the most
commonly used audio file formats for the Mac OS.
Note:  Use the Common Audio Formats setting to create standard AIFF files. If you need to
create specialized AIFF format files, choose the AIFF option from the File Format pop-up menu.

••

Apple CAF: The Apple Core Audio Format (CAF), developed by Apple, provides high
performance and flexibility and is scalable to future ultra-high-resolution audio recording,
editing, and playback. It has an unrestricted file size and supports a wide variety of metadata.

••

WAVE: The Waveform audio file format (WAVE) is primarily used on Windows computers.
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Create Common Audio Formats settings
When you choose Common Audio Formats as your output format, you can only create audio
settings (because it’s an audio-only format).
Create a Common Audio Formats setting
1 In the Settings tab, select a setting or create a new setting by choosing Common Audio Formats
from the Create a New Setting (+) pop-up menu.
2 Choose an audio format from the "File type" pop-up menu in the Common Audio Formats
Encoder pane of the Inspector window.
3 Do one of the following:
••

To configure settings automatically: Automatic mode is on by default, so do nothing. In automatic
mode, Compressor determines the number of channels, the sample rate, and the sample size
based on the source file, and the “Channel layout,”“Sample rate,” and “Sample size” pop-up
menus are dimmed. When the automatic mode is off, you can manually configure these settings.

Automatic button

••

To configure settings manually: Click the Automatic button to turn automatic mode off, and
then choose from the following options:
••

Extension: This field displays the file extension after you choose an audio format from the
“File type” pop-up menu.

••

Allow Job Segmenting: This checkbox allows you to turn off job segmenting. Because job
segmenting isn’t used for audio-only encodes, this checkbox is dimmed with the Common
Audio Formats. For more information, see Job segmenting and two-pass or multi-pass
encoding on page 249.

••

Channel layout: Choose the number of channels (Mono, Stereo, or 5.1).

••

Sample rate: Choose from the available sample rates (32000, 44100, 48000, 96000, 176400,
or 192000).

••

Sample size: Choose from the available sample sizes (16, 24, or 32).

4 Click Save.
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MP3 files
MP3 overview
MP3 is a specific type of MPEG encoding known formally as MPEG Audio Layer 3. MP3 uses
perceptual audio coding and psychoacoustic compression to remove all superfluous information
(specifically the redundant and irrelevant parts of a sound signal that the human ear doesn’t hear
anyway). The result is that MP3 encoding shrinks the original sound data from a CD (with a data
rate of 1411.2 kilobits per second of stereo music) by a factor of 12 (down to 112 to 128 kbps) without
sacrificing very much sound quality. Proponents of MP3 actually claim that there is no sacrifice in
sound quality, but audio professionals can usually hear the difference on good equipment.
MP3 is a widely adopted standard for compressed audio files, so it can be used in many different
ways, including for music and podcasts.
Music
Almost every portable digital music player supports the MP3 audio format. By using the higher
bit rates, for example 256 kbps, you can create an excellent-quality audio file using a much
smaller file size than with uncompressed audio.
You can also add metadata to the file so that when the output media file opens in many players
(including iTunes), information such as the artist and the album name appears.
Podcasts
The MP3 format’s wide range of supported bit rates makes it ideal for delivering podcasts at a
variety of quality levels, making it possible for people listening to the podcast to choose a file
size and quality level.
Note:  For the most options when creating enhanced audio podcasts, use the MPEG-4 output
format. You can add chapter and podcast markers with URLs and artwork to the output file. For
more information, see MPEG-4 Part 2 overview on page 114.

MP3 transcoding workflow
How you use Compressor to transcode your audio into MP3 format files depends on how you
intend them to be used. The basic workflow is described below.
Stage 1: Create a batch
As with any transcode, you need to start by creating a batch. For more information, see Create a
batch on page 18.
Stage 2: Create jobs with the source audio files
Import the source audio files either by dragging them from the Finder to the batch or by
choosing Job > New Job With File.
Stage 3: Add annotations (if needed)
If you intend to play the MP3 files with a device or an application such as iTunes, you can add a
variety of annotations, such as artist, album, title, and so on, that can be read and displayed. For
more information, see Inspector window on page 27.
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Stage 4: Add targets with an MP3 setting to each of the jobs
Each of the jobs requires at least one target—in this case the jobs need targets with an MP3
setting. If there is more than one job, it’s easiest to select all the jobs by choosing Edit > Select All
and then choose Target > New Target With Setting to apply the same setting to all the jobs.
Stage 5: Submit the batch for transcoding
To start the transcoding process, click the Submit button. For more information, see Submit a
batch on page 147.

Create MP3 settings
You make your MP3 settings by either modifying an existing setting or creating a new setting in
the Settings tab.
Create an MP3 setting
1 In the Settings tab, select a setting or create a new setting by choosing MP3 from the Create a
New Setting (+) pop-up menu.
2 Choose MP3 from the File Format pop-up menu in the MP3 Encoder pane of the Inspector.

Note:  Because job segmenting isn’t used for audio-only encodes, the Allow Job Segmenting
checkbox is dimmed.
3 To configure settings manually, choose from the following options:
••

Stereo Bit Rate: Choose a bitrate from the pop-up menu.
The higher the bit rate that you choose, the higher the audio quality and the larger the file size.
The most common bit rate for stereo MP3 files is between 128 kbps and 192 kbps. Lower bit rates
are more appropriate for sound files containing voice recordings (as opposed to music).
Here are some example settings:
••

32 kbps: AM radio quality, suitable for medium-quality speech

••

96 kbps: FM radio quality, suitable for high-quality speech or medium-quality music

••

128 kbps: Suitable for good-quality music

••

256 kbps and 320 kbps: Suitable for music that is near CD quality
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••

Use Variable Bit Rate Encoding (VBR): Select this checkbox to have Compressor vary the number
of bits used to store the music depending on the complexity of the music. This can help keep
file size to a minimum.

••

Sample Rate: Choose the number of times per second that the music waveforms are captured
digitally. The higher the sample rate, the higher the quality and the larger the file size. Don’t
choose a sample rate higher than the rate used originally to store the music or you’ll waste
space. CD quality, for example, is 44.100 kHz, so choosing a higher rate when you’re encoding
from a CD is unnecessary.

••

Channels: If you don’t have stereo speakers or if your audio files are monaural, choose Mono
(mono files are about half the size of stereo files). If you’ll be listening to your MP3 files using
your stereo system, choose Stereo.

••

Joint Stereo: When this checkbox is not selected, your MP3 files contain one track for the right
stereo channel and one track for the left. In many cases, the two channels contain related
information. When the Joint Stereo checkbox is selected, one channel carries the information
that’s identical on both channels, and the other channel carries the unique information. At bit
rates of 160 kbps and below, this can improve the sound quality of your converted audio.

••

Smart Encoding Adjustments: Select this checkbox to have Compressor analyze your encoding
settings and music source, and then adjust settings to maximize quality.

••

Filter Frequencies Below 10 Hz: Select this checkbox to have Compressor filter inaudible
frequencies, resulting in smaller, more efficient files without perceptible loss of quality.

4 Click Save.

MPEG-1 files
MPEG-1 overview
MPEG-1 is an internationally accepted compression standard developed by the Motion Picture
Experts Group (MPEG). MPEG-1 allows you to create VHS-quality video files and was designed to
support SIF (Standard Interface Format) non-interlaced (progressive) video using relatively low
bit rates. (Compressor supports 0.5 Mbps to 2 Mbps.) It also allows you to create compressed
one-channel and two-channel audio.
MPEG-1 is a widely adopted standard, so it can be used in many distribution methods, including
optical discs, the web, and audio-only files.
DVD, VCD, and CD-ROM
MPEG-1 is the video compression format used for video CD (VCD) titles and is compatible for use
on DVD titles since all DVD players contain the hardware required for MPEG-1 playback. MPEG-1
is commonly used in videos distributed on CD-ROM. Its low bit rate and small file sizes are useful
when you must fit multiple hours of video onto a DVD and do not require the broadcast quality
of MPEG-2 encoding. A DVD can contain a mix of MPEG-2 and MPEG-1 video.
On the web
Because MPEG-1 was one of the first widely adopted compression standards, it has the
advantage of being compatible with most media players. This makes MPEG-1 attractive for use
on the web when you need maximum compatibility with relatively high quality.
Audio-only files
You can use MPEG-1 Layer 2 audio compression as an alternative to Dolby Digital Professional or
DTS compression for DVDs. For details, see Create MPEG-1 audio for DVD on page 110.
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About system and elementary streams
You can use Compressor to create system or elementary MPEG-1 streams.
••

System streams: System streams, also known as multiplexed streams, combine the video
and audio components into the same file. This type of stream is most often used in
web applications.
Compressor automatically creates a system stream when you enable both the Video and
Audio tabs in the same setting.

••

Elementary streams: With elementary streams, there are separate files for the video and audio
components. Elementary streams are required by some applications.
Compressor automatically creates an elementary stream when only the Video or Audio tab
is enabled, but not both. To create elementary streams of both the video and the audio, you
must use two settings—one with the Video tab enabled using the file extension .m1v and a
second with the Audio tab enabled using the file extension .m1a.

MPEG-1 specifications
Compressor supports all the MPEG-1 specifications for frame sizes, frame rates, video encoding,
and audio encoding.
MPEG-1 frame sizes and frame rates
Compressor can produce full-frame-rate video (25 fps and 29.97 fps for DVD and 23.976 fps, 25
fps, and 29.97 fps for the web) with SIF resolutions dependent on the use.
••

Web: 320 x 240

••

NTSC: 352 x 240

••

PAL: 352 x 288

Although the NTSC and PAL resolutions are roughly half the full resolution of MPEG-2 video,
when played on a DVD player they automatically expand to fill the entire screen.
MPEG-1 file format specifications
MPEG-1 video encoding uses a process very similar to that used in MPEG-2 encoding—many of
the same terms and settings apply. In Compressor, the encoding settings are set as follows:
••

Encoding mode: One pass

••

GOP structure: Open

••

GOP pattern: BBIBBP

••

GOP length: 15 frames for NTSC; 12 frames for PAL

These settings are fixed and apply to all Compressor MPEG-1 video output files. For information
about group of pictures (GOP) settings, see MPEG-1 Encoder pane on page 112. For information
on the encoding mode, see MPEG-1 Encoder pane on page 112.
You can force the creation of I-frames at specific points in the MPEG-1 output files by placing
compression markers on these frames. You can add these markers to the source media file using
Final Cut Pro, or you can add them manually in the Preview window. For more information, see
Markers and poster frames overview on page 46.
The MPEG-1 format does not support named chapter markers.
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Create MPEG-1 files for the web
Follow these instructions to create MPEG-1 files encoded for the web.
Stage 1: Open the MPEG-1 Encoder pane and choose video settings
1 In the Settings tab, choose MPEG-1 from the Create a New Setting (+) pop-up menu.
The MPEG-1 Encoder pane opens in the Inspector with the Video tab displayed.
2 Name the new setting “MPEG-1 for Web.”
3 Select the Enabled checkbox.
Select to enable
the Video tab.
Click the Automatic
button or choose
a frame rate.
Select Web to set the
resolution to 320 x 240.
Choose the bit rate.

4 Click the Automatic button next to the Frame Rate pop-up menu.
You can also choose 23.976, 29.97, or 25 from the Frame Rate pop-up menu if you know the
frame rate of the source video.
5 Select the Web option.
This sets the resolution of the output to 320 x 240.
6 Specify the bit rate to use by dragging the Bit Rate slider.
Important:  Set the bit rate as low as possible to get acceptable picture quality.
Stage 2: Choose audio settings
1 To open the Audio tab, click the Audio button in the MPEG-1 Encoder pane of the Inspector.
2 Select the Enabled checkbox.
Select to enable
the Audio tab.

Choose the sample rate.
Choose the bit rate.

Select the number
of audio channels.
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3 Choose 44.1 kHz from the Sample Rate pop-up menu.
4 Select Stereo when using two-channel audio sources, or Mono when using one-channel
audio sources.
5 Specify the bit rate to use by dragging the Bit Rate slider.
Important:  Set the bit rate as low as you can set it to get acceptable audio quality. Use a higher
bit rate when encoding stereo.
6 To save this setting, click Save.

Create MPEG-1 video for DVD
Follow the instructions below to author a DVD with MPEG-1 elementary streams.
Stage 1: Create a new setting in the Settings tab
1 In the Settings tab, choose MPEG-1 from the Create a New Setting (+) pop-up menu.
This adds a new setting to the existing list.
2 Name the new setting “MPEG-1 Video for DVD.”
For more information about creating settings, see Create and modify settings on page 35.
Stage 2: Open the MPEG-1 Encoder pane and configure video settings for DVD
1 Click the Encoder button in the Inspector and choose MPEG-1 from the File Format
pop-up menu.
2 To open the Video tab, click the Video button.
3 Select the Enabled checkbox.
Select to enable
the Video tab.
The file extension
changes to .m1v once
the Audio tab is disabled.
Choose the frame rate.
Select DVD to set the
resolution to match
the frame rate.
Choose the bit rate.

4 Choose a frame rate—either 29.97 for NTSC or 25 for PAL—from the Frame Rate pop-up menu.
5 Select the DVD option.
This sets the resolution of the output to match the selected frame rate.
6 Set the bit rate to 1.15 Mbps by dragging the Bit Rate slider, or enter a value.
Note:  The typical value used for DVD projects is 1.15 Mbps, with 1.856 Mbps being the
maximum allowed.

Chapter 5    Custom settings and output formats

109

Stage 3: Make an elementary video stream
In order for the output media file to be an elementary video stream, you must turn off the
audio setting.
1 To open the Audio tab, click the Audio button in the MPEG-1 Encoder pane of the Inspector.
2 Deselect the Enabled checkbox.
This ensures that this setting (preset) creates only an elementary video stream and sets the file
extension to .m1v.
Deselect to disable
the Audio tab.

3 To save the MPEG-1 Video for DVD setting, click the Save button.
To make it easy to use this and the MPEG-1 audio presets with a source, you can create an
MPEG-1 for DVD preset group. For more information, see Example: Create custom groups and
settings for DVD on page 41.

Create MPEG-1 audio for DVD
Follow the instructions below to author a DVD with MPEG-1 elementary streams.
Stage 1: Create a new setting in the Settings tab
1 In the Settings tab, choose MPEG-1 from the Create a New Setting (+) pop-up menu.
This adds a new setting to the existing list.
2 Name the new setting “MPEG-1 Audio for DVD.”
For more information about creating settings, see Create and modify settings on page 35.
Stage 2: Make an elementary audio stream
1 Click the Encoder button in the Inspector and choose MPEG-1 from the File Format pop-up menu.
2 To open the Video tab, click the Video button.
3 Deselect the Enabled checkbox.
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This ensures that this preset creates only an elementary audio stream and sets the file
extension to .m1a.
The file extension
changes to .m1a once
the Video tab is disabled.
Deselect to disable
the Video tab.

Stage 3: Open the Audio tab and configure audio settings for DVD
1 To open the Audio tab, click the Audio button in the MPEG-1 Encoder pane of the Inspector.
2 Select the Enabled checkbox.
Select to enable
the Audio tab.

Choose the 48 kHz
sample rate.
Choose the bit rate.

Select either Stereo
or Mono.

3 Choose 48 kHz from the Sample Rate pop-up menu.
4 Select Stereo when using two-channel audio sources, and Mono when using one-channel
audio sources.
5 Choose the bit rate to use from the Bit Rate pop-up menu.
The typical values used for DVD projects are 192 kbps and 224 kbps.
6 To save the MPEG-1 Audio for DVD preset, click Save.
To make it easy to use this and the MPEG-1 video presets with a source, you can create an
MPEG-1 for DVD preset group. For more information, see Example: Create custom groups and
settings for DVD on page 41.
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MPEG-1 Encoder pane
This section contains detailed information about the various tabs within the MPEG-1 Encoder
pane of the Inspector window. You make your MPEG-1 settings using these tabs, by either
modifying an existing setting or creating a new setting in the Settings tab.

The MPEG-1 Encoder pane opens with the Video tab on top and contains the following items.
Basic settings
•• Extension: This field displays the MPEG-1 file extension (.mpg) automatically after the MPEG-1
output format is chosen from the File Format pop-up menu or the Create a New Setting (+)
pop-up menu in the Settings tab. The extension changes to the video-only extension (.m1v) if
the Audio tab is disabled or the audio-only extension (.m1a) if the Video tab is disabled.
••

Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It’s relevant only if
you’re using Compressor with distributed processing and with multi-pass encoding. For more
information, see Job segmenting and two-pass or multi-pass encoding on page 249.

••

Video and Audio: These buttons open the Video and Audio tabs, described next.
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Video tab
You use the Video tab to make settings related to the video format.

Automatic button

••

Enabled: Make sure this checkbox is selected if you want the MPEG-1 output format to include
the Video tab settings.

••

Frame Rate: Choose the frame rate of the video you’re encoding. The Purpose buttons (Web
and DVD) modify the options available in this pop-up menu:

••

••

With Purpose set to Web: The Frame Rate choices are 23.976, 25 (PAL frame rate), 29.97 (NTSC
frame rate), and Automatic.

••

With Purpose set to DVD: The Frame Rate choices are 25 (PAL frame rate), 29.97 (NTSC frame
rate), and Automatic.

Automatic button: Clicking the Automatic button forces the encoder to choose the frame rate
that most closely matches the source frame rate.
Note:  Using the Automatic setting with nonstandard source frame rates may result in output
frame rates that don’t match the intended video frame rate. For example, a source frame rate
of 15 fps with Purpose set to DVD results in an automatic selection of 25 (PAL). If you intend to
use the output on an NTSC DVD, you must choose 29.97 as the frame rate.

••

••

Purpose: Select the intended purpose for the output files.
••

Web: Forces the resolution to 320 x 240 regardless of the Frame Rate setting.

••

DVD: Allows the Frame Rate setting to determine the resolution. With the 29.97 fps frame
rate, the resolution is 352 x 240. With the 25 fps frame rate, the resolution is 352 x 288.

Bit Rate: Use this slider to set the bit rate to use for the output video, or enter a number in the
field. Although the available range is from 0.5 Mbps to 2.0 Mbps, the actual setting you should
use depends on how the output is to be used. Higher bit rates produce better picture quality,
but they also produce larger output files.
••

For web projects: Choose a bit rate that best balances the picture quality with file size and
download expectations.

••

For VCD projects: The recommended video bit rate is 1.15 Mbps, with a system stream
(multiplexed video and audio in the same file) bit rate of under 1.3944 Mbps.

••

For DVD projects: The typical video bit rate is 1.15 Mbps, with 1.856 Mbps being the
maximum allowed.
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Audio tab
You use the Audio tab to make settings related to the audio format.

••

Enabled: Make sure this checkbox is selected if you want the MPEG-1 output format to include
the Audio tab settings.

••

Sample Rate: Choose the sample rate of the output audio.

••

••

••

48 kHz: Required for use on DVDs.

••

44.1 kHz: Used on audio CDs. This is the most commonly supported sample rate.

Channels: Select the channel valence (stereo or mono) for the output media file.
••

Stereo: Select this option to create a stereo output audio file.

••

Mono: Select this option to create a mono output audio file.

Bit Rate: Set the bit rate to use for the output audio (64 kbps, 128 kbps, 192 kbps, 224 kbps,
or 384 kbps). Higher bit rates produce higher-quality audio, but they also produce larger
output files.
Note:  The 224 kbps and 384 kbps settings are not available when Channels is set to Mono.

MPEG-4 files
MPEG-4 Part 2 overview
Compressor provides the tools you need to create exceptional MPEG-4 transcoded files.
MPEG-4 Part 2 (known as MPEG-4 video in QuickTime 6) plays an important role in the evolution of
standards for the Internet and wireless multimedia industries, where it has been widely adopted.
Use MPEG-4 Part 2 if your output files should be compatible with MPEG-4 Part 2 devices or
players, such as the millions of smartphones and digital still cameras that capture and play back
MPEG-4 Part 2 video.
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H.264, also known as MPEG-4 Part 10, is a newer technology than MPEG-4 Part 2, providing up to
four times the frame size of video encoded with the MPEG-4 Part 2 codec at a given data rate. But,
just as MPEG-1 and MPEG-2 are still used in the industry today, MPEG-4 Part 2 continues to be used.
Note:  MPEG-4 Part 2 is both a QuickTime codec (MPEG-4 Video) and an output format. This
chapter discusses MPEG-4 Part 2 as an output format.
MPEG-4 Part 2 offers the following advantages:
••

Standards compliance: Output is compatible with MPEG-4 Part 2 devices and other standardsbased (ISMA) players, such as mobile phones.

••

High-quality video: A versatile transcoder that can be set to a target data rate and—using onepass variable bit rate (VBR)—can maximize the highest-quality output or speed for the fastest
possible transcode.

••

Advanced Audio Coding (AAC): MPEG-4 audio accommodates a wide variety of source audio,
and brings true variable bit rate (VBR) audio transcoding to QuickTime. It uses the Advanced
Audio Coding (AAC) codec, which provides more clarity than MP3 audio at the same bit
rate with smaller file sizes, or files of the same size at higher quality. You can also include
podcasting information, such as chapter and podcast markers with artwork and URLs, as well
as a variety of text annotations.

••

Hinting for streaming: Hinting refers to how a video stream is divided into streamable pieces.
To create streaming video, the streaming server needs some hints about what data to send
out and when. These hints consist of defining a maximum packet size and maximum packet
duration. A hint track contains information needed to stream your output file. A hint track
is created for every streamable media track in the output file (video and audio), and the
streaming server uses the hint track to turn the media into real-time streams.

MPEG-4 Part 2 default settings
If you don’t need to customize the video and audio settings of your MPEG-4 Part 2 file, you can
easily transcode your source media files by accepting the default MPEG-4 Part 2 output format
settings. For more information, see Create MPEG-4 Part 2 settings on page 116.
Default Video tab settings
These are the default video settings for MPEG-4 Part 2 output media files:
••

Video Enabled: Selected

••

Video compression: H.264 baseline profile

••

Frame Rate: 29.97 fps

••

Key Frame Interval: 30 frames

••

Bit Rate: 1000 kbps

Either enter a number in
the Bit Rate field or use
the slider to set the bit rate.

Chapter 5    Custom settings and output formats

115

Default audio tab settings
These are the default audio settings for MPEG-4 Part 2 output media files:
••

Audio Enabled: Selected

••

Channels: Stereo

••

Sample Rate: 44.100 kHz

••

Quality: High

••

Bit Rate: 128 kbps

Streaming tab settings
These are the default streaming settings for MPEG-4 Part 2 output media files:
••

Streaming hints enabled: Selected

••

Packet Maximum Size: 1,450 bytes

••

Packet Maximum Duration: 100 milliseconds

If these settings are acceptable to you, there is nothing further that you need to do, and you can
begin transcoding source media files immediately.

Create MPEG-4 Part 2 settings
If you want to customize your MPEG-4 Part 2 file format settings, follow the instructions below.
Stage 1: Open the MPEG-4 Encoder pane and adjust video settings
The Video tab allows you to make settings for the quality (ISMA profile), frames rate (fps), key
frame interval, and bit rate of your MPEG-4 Part 2 output file.
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1 In the Inspector window, click the Encoder button and choose MPEG-4 from the File Format
pop-up menu.
The MPEG-4 Encoder pane opens, with .mp4 in the Extension field and the Video tab open.

Note:  The Allow Job Segmenting checkbox allows you to turn off job segmenting. It’s relevant
only if you’re using Compressor with distributed processing and with multi-pass encoding.
Because the MPEG-4 Part 2 format uses single-pass VBR, you can leave this checkbox selected
in all cases for added speed gains with distributed processing. For more information, see Job
segmenting and two-pass or multi-pass encoding on page 249.
2 Adjust the following MPEG-4 video settings:
••

Video Enabled: Make sure that this checkbox is selected if you want the MPEG-4 Part 2 output
format video settings to be applied.

••

Video compression: Choose the MPEG-4 compression format to use:
••

MPEG-4 basic: Ensures playback on all MPEG-4 Part 2 devices.

••

MPEG-4 improved: Gives better output quality, but this setting is not compatible with older
MPEG-4 Part 2 devices.

••

H.264 main profile: Similar to the H.264 baseline profile but with support for standarddefinition (SD) video requirements.

••

H.264 baseline profile: Primarily for video conferencing and mobile applications.

••

Frame Rate: Choose or enter a number to set the overall frame rate of your output media file,
or click the Automatic button to have Compressor choose the frame rate.

••

Key Frame Interval: Enter a value to designate how often (number of frames) you want key
frames created in your output media file, or click the Automatic button to have Compressor
choose the key frame interval rate (the displayed value is 0 with Automatic on; the actual value
is determined during the encoding process).

••

Multi-pass: Select this checkbox for higher-quality results but at the expense of longer
encoding times. This checkbox is available only when you choose an H.264 option from the
Video Compression pop-up menu.

••

Bit Rate: Drag the slider to set the overall video bit rate for your output media file, or enter a
number in the accompanying field.
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If you don’t want to edit any other attributes, you can assign the MPEG-4 setting to any source
media file in the usual way. For more information, see Assign settings to source media on
page 32. Otherwise, go to the next stage to edit MPEG-4 audio settings.
Stage 2: Open the Audio tab and adjust MPEG-4 audio settings
You use the Audio tab to set the audio track quality, sample rate, and bit rate of the MPEG-4
output file.
1 To open the Audio pane, click the Audio button in the MPEG-4 Encoder pane of the Inspector.

Sample Rate
pop-up menu
Bit Rate slider

2 Adjust the following MPEG-4 audio settings:
••

Audio Enabled: Make sure that this checkbox is selected if you want the MPEG-4 Part 2 output
format audio settings to be applied.

••

Channels: Select mono or stereo output for your audio file.

••

Sample Rate: Choose one of the following sample rates: 8, 11.025, 12, 16, 22.05, 24, 32, 44.1, or
48 kHz. You can also choose Recommended to have Compressor choose a sample rate that is
suitable based on the Channels and Bit Rate settings.
Note:  If you choose Recommended, the sample rate is not determined until the transcode
actually starts.

••

••

Quality: Choose the audio quality of your output media file:
••

Low: This setting allows for fast transcoding, but at the expense of output file quality.

••

Medium: The audio quality is better than Low, but transcoding takes longer.

••

High: This is the best audio quality setting available. Use this setting when the audio quality
is important for the output media file and you don’t mind how long transcoding takes.

Bit Rate: Drag the slider to set the overall audio bit rate for your output media file
between 16 kbps (2 KB/sec.) and 320 kbps (40 KB/sec.). You can also enter a number in the
accompanying field.

If you don’t want to edit any other attributes, you can assign MPEG-4 settings in the usual way.
For more information, see Assign settings to source media on page 32. Otherwise, go to the next
stage to edit streaming settings.
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Stage 3: Open the Streaming tab and edit streaming settings
You use the Streaming tab to set hints for your output file, as well as set the maximum packet
size and packet duration limits of the MPEG-4 Part 2 output file. You can also set your output
media file to work with an older version of QuickTime Streaming Server (version 4.1 or earlier).
1 To open the Streaming tab, click the Streaming button in the MPEG-4 Encoder pane of the Inspector.

2 Adjust the following MPEG-4 streaming settings:
••

Streaming hints enabled: Make sure that this checkbox is selected if you want the MPEG-4 Part
2 output format streaming settings to be applied.

••

QuickTime Streaming Server Compatibility (pre 4.1): Select this checkbox if you want your output
media file to work with an older version of QuickTime Streaming Server (version 4.1 or earlier).
You don’t need to select this checkbox if you’re using a version of QuickTime later than 4.1,
because any streaming compatibility issues are automatically resolved.

••

Packet Maximum Size: Enter a number to specify the largest allowable file size (in bytes) for a
streaming packet in your output media file. The packet size you set should be no larger than
the largest packet used on any network between the streaming server and the viewer.

••

Packet Maximum Duration: Enter a number to specify the longest allowable duration (in
milliseconds) for a streaming packet in your output media file. The duration affects MPEG-4
Part 2 audio only. It limits the maximum amount of audio (in milliseconds) in any packet,
which limits the audio dropout created by the loss of a packet.

Although the output format setting is the most important component of the Compressor
workflow, you can also add other settings and presets, such as filters, cropping, frame sizing,
actions, and destinations.

Create settings for an audio podcast
Compressor makes it easy to create an enhanced audio podcast based on the MPEG-4 output
format. An enhanced audio podcast includes podcasting information such as chapter and
podcast markers with artwork and URLs, as well as a variety of text annotations. Follow the
instructions below to create a setting for an audio podcast.
Stage 1: Open the MPEG-4 Encoder pane and configure it for audio-only output media files
1 In the Inspector window, click the Encoder button and choose MPEG-4 from the File Format
pop-up menu.
2 To open the Video tab, click the Video button.
3 Deselect the Video Enabled checkbox.
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4 To open the Audio tab, click the Audio button.
5 Select the Audio Enabled checkbox.
This sets the MPEG-4 output to be an audio-only (.m4a) file. You can also specify the other
settings in the Audio tab as needed.
Stage 2: Configure the MPEG-4 output to include podcasting information
1 Select the “Enhanced Podcast (m4a file)” checkbox near the bottom of the MPEG-4 Encoder pane
of the Inspector window.
This checkbox is available only when the Video Enabled checkbox in the Video tab is deselected.
Selecting the “Enhanced Podcast (m4a file)” checkbox ensures that any annotations you add, as
well as any chapter and podcast markers with their artwork and URLs, are embedded with the
output media file.

Deselect this checkbox
to activate the “Enhanced
Podcast (m4a file)” checkbox.

Select this checkbox to include
podcasting information in the
output media file.

2 To save the setting so that you can apply it to a source media file’s target, click Save.
Stage 3: Open the Additional Information tab and enter annotations
1 In the Batch window, click a non-target area of the job created by the source media file.
The Inspector window shows the A/V Attributes, Additional Information, and Job Action tabs.
2 Click the Additional Information tab.
The Additional Information tab is where you can add annotations, such as a title and an artist, to
the output media file.
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3 Choose an item from the Add Annotation pop-up menu to add it to the output media file.

Choose items from this
pop-up menu to include
them as annotations in
the output media file.

The item appears in the Annotation column.
4 Double-click the item’s Value column and type the text for the annotation.
5 Repeat step 3 and 4 for each annotation item you want to add to the output media file.
For more information, see Inspector window on page 27.
You can use the setting you create to output an audio podcast.
Before you submit your podcast for processing, you can use the Preview window to add and
configure chapter and podcast markers for the output media file. After the encoding process
finishes, you can open the output media file in QuickTime Player to verify that the markers, URLs,
and artwork appear as intended.

QuickTime movie files
QuickTime movie overview
QuickTime is cross-platform multimedia technology that allows OS X applications to capture and
play back video, audio, and still-image files. QuickTime is an open standard with many built-in
codecs and is both a multimedia and streaming media architecture. It’s widely used for both
authoring and delivery. For example, many video editing and compositing applications use
QuickTime as their base format. QuickTime contains a wide range of video and audio codecs
suitable for everything from streaming video to DVD. The QuickTime architecture can also handle
file formats other than QuickTime movies, such as AVI files and 3G streams. For more information
about creating those kinds of formats, see QuickTime Export Components overview on page 130.
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QuickTime media files for the web
You can play your output media files over the web with QuickTime, once the files are compressed
to a data rate appropriate for the bandwidth you expect your audience to have. You can do this
by making your output media files either QuickTime Fast Start movies (pre-buffered download)
or QuickTime Streaming movies.
You can choose different streaming options from the Streaming pop-up menu in the QuickTime
Movie Encoder pane.
Chapter and podcast markers for QuickTime output
Chapter markers created in Final Cut Pro are passed through (transferred) to other output files
that can be recognized by QuickTime Player, iTunes (.m4v files), and Final Cut Pro. For information
about adding chapter and podcast markers, see Markers and poster frames overview on page 46.

QuickTime video codecs
Codec stands for compressor (CO)/decompressor (DEC) pairs. You use different codecs for different
playback methods (such as the web or DVD). Once you know the playback method of your target
audience, you can pick a suitable codec. To decide which codec is right for your needs, you must
choose the necessary level of compression to meet your data rate limits and the level of quality
you want.
Each codec offers advantages and disadvantages. Some codecs are more appropriate for storing
certain types of media; others introduce more artifacts. Some compress slowly and decompress
quickly, and others compress and decompress at the same speed. Some codecs can compress
a file to 1/100 of its original size, and others decrease the file size very little. Some codecs are
available only on specific operating system platforms, some require a particular processor, and
some require a minimum version of QuickTime for playback.
When choosing a codec, consider the following:
••

Minimum system requirements of your target audience

••

Source material

••

Quality of the compressed media file

••

Size of the compressed media file

••

Compression/decompression time for the media file

••

If the media file will be streamed

Compressor comes equipped with the standard video codecs that QuickTime offers and the
additional codec options that come with QuickTime Pro. Unless you know that people in your
target audience have a particular codec installed on their computers, you should use one of the
standard QuickTime codecs to ensure universal compatability.
Note:  See the relevant QuickTime documentation for more information about choosing video
codecs and how to get the best out of the video codec settings.
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Video codecs can be divided into the following two types:
••

Lossless codecs: Lossless codecs completely preserve the data they compress and are usually
used to transfer footage from one editing suite to another. Lossless codecs can require high
data rates and high-end computers with specialized hardware. Examples of lossless codecs are
the Animation, 8-bit, and 10-bit uncompressed 4:2:2 codecs.

••

Lossy codecs: In comparison to lossless codecs, lossy codecs return only an approximation
of the data and are usually used to deliver finalized video to an end user. The level of
approximation is determined by the quality of the codec. Typically there is a trade-off between
the output quality of the codec and its achievable level of compression. With some codecs, a
compression ratio of at least 5:1 can be reached without visible degradation. An example of a
lossy codec is the Photo-JPEG codec.
Low-quality lossy compression introduces unnatural visual artifacts that may become
noticeable to the human eye. Using a lossy codec, you should compress your media file only
once, because compressing a file multiple times adds more artifacts.

QuickTime audio codecs
If you have the disk space and bandwidth, the best thing you can do is leave your audio
uncompressed. Uncompressed audio normally uses 8-bit (phone quality) or 16-bit (CD quality)
samples. (Compressor supports up to 64 bits per sample floating point and a maximum sample
rate of 192 kHz.) If you have disk space and bandwidth limitations, you must compress your
audio. However, audio takes up less disk space than video, so it doesn’t need to be compressed
as much as video.
The two most important components of audio codecs are sample rates and size. The sample
rate sets the sound quality, and the sample size sets the dynamic range of the sound. QuickTime
audio codecs allow you to set both the sample rate and size of your source media file.
Choosing an audio codec
AAC is a good general-purpose audio delivery codec and is compatible with a wide variety
of playback devices. For QuickTime movies playing on slower computers, IMA 4:1 is a better
choice because it’s less processor intensive, thus allowing the computer to focus on the more
challenging video stream.
Sound sample rates
Digitized sound consists of sound samples captured at different frequency rates. The more sound
samples per second, the higher the sound quality. For example, audio CDs use a 44.1 kHz sample
rate, DVDs sample at 48 kHz, and telephone networks sample voices at 8 kHz. The sample rate
you choose depends on the nature of the sound. Music requires a higher sample rate than voice,
because music contains a wider range of frequencies. Spoken voice has a more limited range of
frequencies, so you can choose a lower sample rate and still maintain acceptable audio quality. In
most cases, you should choose the highest sample rate available.
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Reducing the sample rate can shrink a media file by as much as 5:1. The audio quality will be
affected, but not as much as it would be if you used 8-bit sampling. The following table shows
common sample rates and the audio device quality to expect at each rate.
Sample rate

Audio device quality

48 kHz

DAT/DV/DVD

44 kHz

CD

22 kHz

FM radio

8 kHz

Telephone

Sound sample size
The sound sample size determines the dynamic range of the sound. For example, 8-bit
sound provides for 256 possible values, whereas 16-bit sound allows for more than 65,000
possible values.
Choose 16-bit sound for music that has both soft and loud sections, such as orchestral music. For
spoken voice or music that has a more or less constant volume level, choosing 8-bit sound can
still yield good results.
If you need to shrink your media file, you can reduce the sample size from 16 bits to 8 bits. This
cuts the file size in half but also degrades the audio quality.

Create QuickTime media files
There are many QuickTime video and audio codecs that you can choose from in Compressor. You
access all codecs from the Compression Settings and Sound Settings dialogs, which you open
from the QuickTime Movie Encoder pane.
Stage 1: Open the QuickTime Movie Encoder pane and choose basic settings
1 In the Settings tab, select a setting or create a new setting by choosing QuickTime Movie from
the Create a New Setting (+) pop-up menu.
2 Click the Encoder button in the Inspector window.
The QuickTime Movie Encoder pane appears, containing the Video and Audio Settings buttons,
the Enabled pop-up menus, the Streaming pop-up menu, the Options button (dimmed), and the
Summary table.
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The Extension field displays the QuickTime file extension (.mov) automatically after the
QuickTime Movie output format is chosen from the File Format pop-up menu or the Create a
New Setting (+) pop-up menu in the Settings tab. For more information, see Job segmenting and
two-pass or multi-pass encoding on page 249.

Extension field
Streaming pop-up menu
Clean aperture selection

Summary table

Options button (dimmed
unless Hinted Streaming
is selected)

If you’re using Compressor with with distributed processing and with multi-pass encoding, you
can turn off job segmenting by deselecting the Allow Job Segmenting checkbox.
3 Choose your video and audio settings (see the tasks below for additional instructions):
••

Enabled/Disabled/Pass-through: Use these pop-up menus to enable or disable Video and Audio
settings. Enabled means the video or audio track will be included in the output movie. Disabled
means the video or audio track will be excluded from the output movie. Pass-through (audio
only) means Compressor will copy the audio into the output movie without modifying it. An
example of this might involve high-definition (HD) files with multitrack audio that you want to
convert to standard-definition (SD) files without disturbing the audio tracks.
Note:  If you export a sequence from Final Cut Pro to Compressor (by choosing File > Export >
Using Compressor) and apply a setting with “Pass-through” selected, the audio portion of the
setting is changed to a PCM setting with the sequence’s setting and channel count, but with
only a single track created on output. If you require audio pass-through for a Final Cut Pro
project, export a QuickTime movie (by choosing File > Export > QuickTime Movie) and import
the movie into Compressor.
Important:  If a setting has “Pass-through” selected, the Filter pane audio filters are not
available. Additionally, the Frame Controls pane retiming controls will not correct the audio,
potentially causing synchronization errors with the video.
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4 Choose a QuickTime streaming option from the Streaming pop-up menu:
••

None: If you choose this setting (the default), your output media file will not stream over
the Internet.

••

Fast Start: This option allows your output media file to be viewed even before it’s fully
downloaded from its server.

••

Fast Start-Compressed Header: This setting achieves the same results as Fast Start (allowing
your output media file to be viewed before it’s fully downloaded from the server), but the
output media files are smaller.

••

Hinted Streaming: This setting allows hint tracks to be added to the output media file so that it
can be used with QuickTime Streaming Server.

5 If you chose Hinted Streaming from the Streaming pop-up menu, click the Options button to
open the QuickTime Hint Exporter Settings dialog, which allows you to choose extra hinting
settings for your stream.
6 To define clean picture edges in the output file, make sure the “Add clean aperture information”
checkbox is selected.
Information is added to the output file that defines how many pixels to hide to ensure that no
artifacts appear along the edges. When the output file is played using QuickTime Player, this
setting can result in the pixel aspect ratio being slightly altered.
When the checkbox is deselected, no clean aperture information is added to the output file. This
was the standard behavior in Compressor 3.0.5 and earlier.
Note:  This checkbox does not affect the actual pixels in the output file—it only controls whether
information is added to the file that a player can use to hide the edges of the picture.
7 Click Save.
The Summary table displays full details for the settings you’ve chosen.
Stage 2: Add a QuickTime video codec
The Video Settings button in the QuickTime Movie Encoder pane provides access to the currently
installed QuickTime video codecs.
All codecs are compatible with QuickTime, but if you intend to play back the output file using
QuickTime Player, the following delivery codecs are recommended:
••

H.264

••

Photo-JPEG
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If a particular setting can’t be changed, it remains dimmed. Some video codecs—such as
Photo-JPEG—allow you to make additional settings. If this is the case, the Options button
becomes available.
1 Click the Video Settings button in the QuickTime Movie Encoder pane of the Inspector.
2 In the Compression Settings dialog, choose a video codec from the Compression Type pop-up
menu and either accept its default settings or customize the other settings (in the Motion, Data
Rate, and Compressor areas).
Choose a frame rate
from this pop-up menu.

Choose a compression type
from this pop-up menu.

Click the Options button for
more configuration settings.

The settings in the Compression Settings dialog vary depending on which codec you choose in
the Compression Type pop-up menu.
3 Choose the video codec you want to add to your preset from the Compression Type
pop-up menu.
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4 If available, specify the following settings in the Motion area:
••

Frame Rate: Choose a frame rate, or choose Custom to enter a frame rate manually.
With this pop-up menu, you can reduce the frame rate of your original file to reduce the
size of the compressed file. Higher frame rates make for smoother motion but require more
bandwidth. You use the Frame Rate pop-up menu to choose a different frame rate, but for best
results you should change it to a number that the original file can be easily divided by. For
example, if your original file had a frame rate of 30 fps, you should use a frame rate of 10 fps
or 15 fps. Choosing a frame rate of 24 fps would result in uneven motion and even dropped
frames, because 30 is not evenly divisible by 24.

••

Key Frames: If your selected codec allows it, use the Key Frames Every field to enter the
number of frames you want between your key frames. Codecs based on the temporal
compression method use key frames. These act as a reference frame for the next sequence
of frames, so that any data redundancy between the key frame and the ensuing frames can
be removed. In between key frames are the less detailed delta frames. You need to insert key
frames throughout your media file because content changes. Some video codecs allow you
to insert a key frame every certain number of frames, whereas other video codecs scan the
whole file to detect where the major similarities and differences occur and insert the key
frames accordingly.
If there’s a lot of motion in your media file, you need key frames more often than you do with
something more static, such as a talking head sequence.

5 If available, specify the following settings in the Data Rate area:
••

Data Rate: Use this field to set the number of kilobytes per second (KB/sec.) required to deliver
your media file. This setting is useful if you have a specific bit rate (such as a DSL connection)
or amount of space (on a DVD or CD-ROM). You should choose a data rate that is appropriate
for your delivery medium and set it as high as possible within your data limitations. When you
set a data rate, you override other codec quality settings because the codec compresses the
file as much as it needs to based on its data rate limit.
Remember that the data rate is only for the video track of a media file. If your media file also
contains audio, you must allow some space for that too.

6 If available, click the Options button in the Compressor area to make additional changes.
This button remains dimmed unless the codec you chose from the Compression Type pop-up
menu offers options. For more information about the additional options for a codec, contact the
codec’s manufacturer.
7 To save your changes, click OK.
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Stage 3: Add a QuickTime audio codec
The Audio Settings button in the QuickTime Movie Encoder pane provides access to the
currently installed QuickTime audio codecs.
All codecs are compatible with QuickTime, but if you intend to play back the output media file
using QuickTime Player, the following delivery codecs are recommended:
••

AAC

••

IMA 4:1

For more information about audio codecs, see QuickTime audio codecs on page 123.
If a particular audio setting cannot be changed, it remains dimmed. Most audio codecs allow you
to make additional settings. If this is the case, various buttons and controls become available.
1 Click the Audio Settings button in the QuickTime Movie Encoder or AIFF Encoder pane of
the Inspector.
2 In the Sound Settings dialog, choose the audio codec you want to add from the Format
pop-up menu.
Show Advanced
Settings checkbox

Format pop-up menu
Rate field
and pop-up menu

3 Choose a channel output (such as mono, stereo, or multichannel output, depending on the
codec) from the Channels pop-up menu.
4 Choose a sample rate for your media files using the Rate field and pop-up menu.
The higher the sample rate, the higher the audio quality but the larger the file. Downloading a
larger file takes longer and requires more bandwidth.
5 To see settings for the codec you chose, select the Show Advanced Settings checkbox (if it’s available).
For information about the additional options for a codec, contact the codec’s manufacturer.
6 To save your changes, click OK.
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QuickTime Export Components files
QuickTime Export Components overview
You can use Compressor to output a variety of additional formats using the QuickTime
component plug-in feature.
Compressor and QuickTime can be extended to support additional codec options and thirdparty formats. The QuickTime component plug-in feature allows you to export exotic file formats
that can play on third-party devices and operating systems, such as mobile phones. Unlike
standard QuickTime movies, these exported files cannot be played back with QuickTime Player
or other QuickTime-based applications. (For information about the native QuickTime movie file
format, see QuickTime movie overview on page 121.)
In the past, creating these kinds of files required multiple steps and multiple operating systems:
exporting the file, moving it to a computer on another platform, and then encoding using
another software application. The QuickTime Export Components feature allows you to control
the third-party encoding engine without having to open another application. This streamlines
your workflow and saves you the time and hassle of working with multiple operating systems
and software packages.
With no additional third-party software, Compressor currently supports transcoding to 3G, AVI,
and Apple iPod. The QuickTime Export Components feature in Compressor was developed to
make it possible to add export plug-ins in the future. You would simply install the third-party
software and then choose the corresponding output file format from the Encoder Type pop-up
menu in the QuickTime Export Components Encoder pane of the Inspector window.
To learn more about currently available plug-ins and updates, go to the Compressor support
website at http://www.apple.com/support/compressor.

Create QuickTime Export Components settings
When you choose QuickTime Export Components as your output format, you can only create
settings for export plug-ins that are already installed.
The QuickTime Export Components output format includes an iPod encoder type. This
encoder creates an output file suitable for playing on an iPod, using an H.264 encoder for the
video and an AAC encoder for the audio. All settings (frame size, frame rate, and so on) are
automatically set.
Drawbacks of using this plug-in (as opposed to using the H.264 for Apple Devices output format)
include not being able to take advantage of distributed processing, to include chapter markers,
or to use the Frame Controls pane.
For more information about creating iPod output media files, see iTunes and Apple device
output overview on page 65.
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Create a QuickTime Export Components setting
1 In the Settings tab, select a setting or create a new setting by choosing QuickTime Export
Components from the Create a New Setting (+) pop-up menu.
2 Choose QuickTime Export Components from the File Format pop-up menu.

Choose QuickTime
Export Components.
Extension field
Choose an encoder plug-in.
Click to see the options
for the encoder plug-in.

If necessary, you can change the default settings:
••

Extension: This field indicates the file extension for the output format chosen from the Encoder
Type pop-up menu.

••

Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It’s relevant only if
you’re using Compressor with distributed processing and with multi-pass encoding. For more
information, see Job segmenting and two-pass or multi-pass encoding on page 249.

••

Encoder Type: Use this pop-up menu to choose from the available export component output
formats (plug-ins).

3 Click the Options button (if available).
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The Settings window for that particular output file format opens.

Configure settings
for the QuickTime
export component.

Important:  Use the third-party export module user interface to explicitly enter the image size
and frame rate for the output file. Do not leave the Image Size and Frame Rate settings in the
third-party user interface at their default values.
4 To save your settings, click OK.
Note:  The Compressor Frame Controls feature is not available when using the QuickTime Export
Components feature.
5 In the QuickTime Export Components Encoder pane of the Inspector, click Save.

DV Stream files
DV overview
Because of its low cost and wide availability, the DV video format is extremely popular for
standard-definition (SD) video capture and delivery.
How you use Compressor to transcode your video into DV Stream format files depends on how
you intend the output file to be used. The basic steps are listed below.
••

Create a batch: As with any transcode, you need to start by creating a batch. For more
information, see Create a batch on page 18.

••

Create jobs with the source video files: Import the source video files either by dragging them
from the Finder to the Batch window or by choosing Job > New Job With File.

••

Add targets with a DV setting to each job: Each of the jobs requires at least one target—in this
case the jobs need targets with a DV Stream setting. If there is more than one job, it’s easiest
to select all the jobs by choosing Edit > Select All and then choose Target > New Target With
Setting to apply the same setting to all the jobs.

••

Submit the batch for transcoding: Click the Submit button to start the transcoding process. See
Submit a batch on page 147.
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Create DV Stream settings
This section contains detailed information about the various settings within the DV Stream
Encoder pane of the Inspector window. You make your DV settings by either modifying an
existing setting or creating a new setting in the Settings tab.
Create a DV Stream setting
1 In the Settings tab, select a setting or create a new setting by choosing DV Stream from the
Create a New Setting (+) pop-up menu.
2 Choose the DV Stream format from the File Format pop-up menu in the DV Stream Encoder
pane of the Inspector.
3 To configure any setting automatically, click the Automatic button next to the setting.

Automatic buttons for
the Format, Aspect
Ratio, and Field
Order values

4 To configure settings manually, choose from the following options:
••

Extension: This field displays the DV file extension (.dv) automatically after the DV Stream
output format is chosen from the File Format pop-up menu or the Create a New Setting (+)
pop-up menu in the Settings tab.

••

Allow Job Segmenting: This checkbox allows you to turn off job segmenting. For more
information, see Job segmenting and two-pass or multi-pass encoding on page 249.

••

Format: Choose either NTSC or PAL as the output video format.

••

Aspect Ratio: Choose either 16:9 or 4:3 as the output video aspect ratio.
Note:  The 16:9 aspect ratio uses anamorphic video.

••

Field Order: Choose “Bottom field first” (required for interlaced DV video) for interlaced sources
or Progressive for progressive sources.

5 Click Save.
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Create image sequence files

The Image Sequence output format creates a set of still-image files representing the source
video frames. Use this encoder to convert a video clip to an image sequence for use with
compositing applications that aren’t compatible with QuickTime.
Note:  You can also use Compressor to import an image sequence. For more information, see Add
image sequences to batches on page 25.
Create an Image Sequence setting
1 In the Settings tab, select a setting or create a new setting by choosing Image Sequence from
the Create a New Setting (+) pop-up menu.
2 Apply the setting to a job in the Batch window.
Make sure the resulting image sequence target is selected.
3 In the Inspector, click the Encoder button and choose Image Sequence from the File Format
pop-up menu.
The Image Sequence Encoder pane appears.

Choose Image Sequence.
Choose an image type.
Choose a frame rate
from the Frame Rate
pop-up menu, or click
the Automatic button.

4 To configure settings, choose from the following options:
••

Extension: This field displays the TIFF file extension (.tiff) automatically after the Image Sequence
output format is chosen from the File Format pop-up menu or the Create a New Setting (+)
pop-up menu in the Settings tab. Don’t alter this field. You can change the output format with the
Image Type pop-up menu. This field is updated automatically with your choice of output format.

••

Allow Job Segmenting: This checkbox allows you to turn off job segmenting. It’s relevant only if
you’re using Compressor with distributed processing and with multi-pass encoding. For more
information, see Job segmenting and two-pass or multi-pass encoding on page 249.

••

Image Type: Use this pop-up menu to choose one of the following image sequence types for
the output media:

••

TIFF (Tagged Image File Format): TIFF is one of the most common and flexible still-image
formats and was developed to create a standard file format for storing and exchanging digital
graphics used in desktop publishing. It’s compatible with a wide range of compositing and
image processing applications.
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••

TARGA (Truevision Advanced Raster Graphics Adapter): TARGA, also commonly referred to as TGA,
is a raster graphics format commonly used by animation and video applications.

••

DPX: DPX is a common file format for digital intermediate and visual effects work and is an
ANSI/SMPTE standard (268M-2003).

••

IFF (Interchange File Format): IFF is a generic file format originally introduced by the Electronic
Arts company in 1985 (in cooperation with Commodore-Amiga) to ease transfer of data
between software products produced by different companies.

••

JPEG (Joint Photographic Experts Group): JPEG is a common still-image format.

••

OpenEXR: OpenEXR is a high dynamic range (HDR) image file format developed by Industrial
Light & Magic for use in computer imaging applications.

••

Frame Rate: Use this field and pop-up menu to enter the frame rate at which you want the still
images to be created. The higher the frame rate, the greater the number of still images created
and the larger the output file. For example, if you choose 30 fps, Compressor creates 30 still
images for every second of the video clip you’re transcoding. If you choose 8 fps, Compressor
creates only 8 still images per second.

••

Create unique output directory: Select this checkbox to create a folder for the resulting output
files. The folder is given the same name as the media file, and the files are stored inside the
folder and named frame-nnn. For example, if the output filename is test, the directory path is
destination/test/frame-nnn.
If you don’t select this checkbox, the output files are stored at the top level of your destination
folder and named filename-nnn rather than frame-nnn. Be aware that even at the slow rate of
8 fps, a large number of files are created when you transcode to this output format, so creating
an output directory is a good way to keep your files organized.

••

Add leading zeros to frame numbers: Select this checkbox to add leading zeros to the frame
number. When you choose this method, all the output files consist of multidigit filenames,
such as frame-000001 (or filename-000001 if these files aren’t being saved in a unique output
directory). If you don’t select this checkbox, each file uses a regular filename, such as frame-1
(or filename-1 if these files aren’t being saved in a unique output directory).

••

Scale image to preserve aspect ratio: Affects only video media using non-square pixels, such as
NTSC and PAL formats, and only when you’re not intentionally changing the video frame size.
Select this checkbox to scale the output files to use square pixels and maintain the original
aspect ratio (which results in an increase or decrease in the number of horizontal and vertical
pixels). If the checkbox is not selected (the default setting), the output files use the same pixel
aspect ratio and have the same number of horizontal and vertical pixels as the original video.

5 Click Save.
Important:  Use FTP software to upload the image sequence to remote servers.
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Adjust the pixel aspect ratio of an image sequence job before transcoding
Because all still-image types require square pixels (a pixel aspect ratio of 1.0), Compressor may
have to alter the pixel dimensions of an image sequence job. To view or adjust these parameters,
select the target in the Batch window and click the Geometry button in the Inspector. If you plan
to use the image sequence in an application that can be set to a specific size and pixel aspect
ratio (such as Motion), make the appropriate changes in the Geometry pane before encoding.
1 In the Batch window, select the image sequence target.
2 In the Geometry pane of the Inspector window, use the Frame Size pop-up menu to choose the
appropriate output dimensions (such as 720 x 480, 1920 x 1080, and so on) for the image sequence.
3 In the Pixel Aspect pop-up menu in the Geometry pane, choose the appropriate pixel aspect
ratio for your image sequence.
For more information about the Geometry pane, see Geometry pane on page 179.
Note:  You can see the current contents of your setting by viewing the Summary pane of the
Inspector window.
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Assign destinations
and submit batches

6

Jobs, targets, and batches overview

A job consists of a source media file with at least one target—composed of a setting and a
destination—assigned to it. You create the jobs by importing the source media files.
For a job to be complete, and thus ready to be submitted for transcoding, you need to add one
or more targets to it. Each target contains a setting, which defines how the file is transcoded, and
a destination, which defines where the transcoded file is saved and how it’s named. Each target
also allows you to manually enter the name for the output file.
Compressor provides a number of options for assigning settings and destinations to your
targets and submitting and resubmitting batches. If you’re going to use a combination of
settings and destinations often, you can create a preset. For more information about creating
presets in these windows, see Assign settings to source media on page 32 and Destinations
tab and Inspector on page 143.

Work with destinations
Destinations overview
Compressor allows you to choose a location to save your transcoded files, called a destination.
If you don’t assign a destination, the output file is saved to the same folder as the source media
file. This may be satisfactory for your needs, but if there are various remote uploading servers,
or if you just want a specific type of output file to end up in a specific location, you must assign
that destination.
If you have a volume open on your desktop, it’s treated the same as a local destination and you
can save output media files directly to that volume, without the extra steps needed for remote
destinations, such as specifying the host name and entering the user name and password. When
you use the remote option for your destination, you can save to any folder in the user’s directory
of that remote computer.
After you create your destinations, they are available in the Batch window. Additionally, when
creating custom settings, you can assign a default destination that’s automatically used. For
details, see Assign settings to source media on page 32.
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Assign destinations
When you assign settings to your targets, the default destination is automatically also assigned.
You can set the default destination in Compressor preferences. (Choose Compressor >
Preferences.) The default destination can be one of those supplied with Compressor or a custom
destination you create. For details about working with destinations, see Create and modify
destinations on page 140.
You can replace the default destination with any other destination, or even manually choose a
location to save the output file. There are a number of ways to assign a destination to a source
file. As with assigning settings, different methods have different advantages.
Assign a destination by dragging
1 In the Settings and Destinations window, click the Destinations tab.
2 Select a destination and drag it to the target in the Batch window.

Drag the destination
to a job with a target
in the Batch window.

Select a destination
to apply to the target.

The destination part of the target updates to show the new destination.
Note:  When you assign a destination by dragging, you can assign it only to a single job.
Additionally, you cannot create a temporary destination using this method.
Using the dragging method, you can also create a new target (with an empty setting) by
dragging the destination to an empty part of the job.
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Assign a destination using menu commands
1 Select all targets that you want to assign the destination to.
2 Do one of the following:
••

Choose Target > Destination > [Destination].

••

Control-click one of the targets and choose Destination > [Destination] from the
shortcut menu.

Use the target’s shortcut menu
to change the destination for
the selected targets.

The destination you choose appears in the destination section of each selected target.
Note:  You can also assign a temporary destination by choosing Other. In the dialog that appears,
you can create a new destination for just that batch submission. This destination is not saved and
applies only to the submitted batch.
Modify or enter a new output filename
In addition to defining where to save the output file, destinations also define how the output file
is named. The output filename is created when you assign a destination, but you can modify it or
enter a new name.
mm Click in the output filename area and edit the existing name, or triple-click the existing name to
enter a new name.

The output
filename
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Create and modify destinations
You use the Destinations tab together with the Inspector window to create and assign a
destination and to add file identifiers (placeholder filename elements such as the date or the
setting name) to your output file.
You can create the following destinations:
••

Local: Any directory on your own computer

••

Open Volume: Any shared volume open on your desktop

Note:  By default, the output media file destination is the folder from which the source media
files originated, but you can change the default destination to any other preset.
Create a destination
1 In the Settings and Destinations window, click the Destinations tab.
2 Click the Create a New Destination (+) button.
3 In the dialog that appears, navigate to your chosen destination folder or mounted volume, and
click Open.
A new destination with the folder’s name appears in the Custom folder of the Destinations tab,
along with the path to the folder you just assigned.
4 Double-click the new destination in the Destinations tab.
The Inspector window opens, showing information about the new destination.
5 In the Inspector, do either of the following:
••

Modify the name of the new destination in the Name field.

••

Modify the pathname of the new destination by clicking Choose and navigating to a new
folder in the dialog that appears.

6 Add file identifiers to your output filename using the pop-up menu in the Output Filename
Template field.

Choose the elements you
want in the output filename.

You can also manually edit this field by doing any of the following:
••

To rearrange the order of the file identifiers: Drag them into a new order.

••

To add custom text: Click on either side of the file identifiers and enter custom text.

••

To remove a file identifier: Select the identifier and press Delete.

The Sample From Defined Template field in the Inspector window shows a sample of the output
filename with the file identifiers you added. The default file identifier combination is Source
Media Name-Setting Name.
Note:  Avoid creating filenames that begin with a period (.). The resulting file will be visible only
in the command line and not visible in the OS X Finder.
For more details about these settings, see Destinations tab and Inspector on page 143.
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Change the default destination
1 Choose Compressor > Preferences.
2 Choose a destination from the Default Destination pop-up menu.
The destination you choose appears as the default destination when you import a new source
file in the Batch window.
Delete a destination
1 Click the Destinations tab in the Settings and Destinations window.
2 In the Destinations tab, select the destination you want to remove, and click the Delete Selected
Destinations (–) button.
Important:  There is no confirmation step in this process, so make sure you want to remove the
destination before clicking the button.

Delete Selected
Destinations button

Duplicate a destination
1 In the Settings and Destinations window, click the Destinations tab.
2 Select the destination you want to copy, and click the Duplicate Selected Destination button.
Duplicate Selected
Destination button
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A copy of the destination appears. Rename the duplicate destination as appropriate.

The duplicated destination

If a warning triangle appears
When there is a problem with your destination, a yellow warning triangle appears. You must resolve
this problem before you can successfully transcode. Warning triangles appear in the Destinations
tab if your computer can't connect to or write to the destination, and in the Batch window if:
••

There is already an identical file at that destination

••

Two destinations have the same name

••

Your computer can't connect to or write to the destinatlon

The warning appears at whatever level the problem originated (preset, job, or batch) and
propagates upward, so that if the problem occurs at the preset level, you see warning triangles
next to the preset and job.
If you hold the pointer over the warning triangle for a few seconds, a tooltip displays information
about the nature of the problem. Alternatively, you can click the warning triangle to display
information about the problem.
Click the warning symbol to
see an explanation about
why it is there.

As soon as you resolve the problem, the warning triangle disappears, and you can continue
to transcode.
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Destinations tab and Inspector
You use the Destinations tab together with the Inspector window to create and assign a
destination, and to add file identifiers to your output file.
Create a New
Destination button
Duplicate Selected
Destination button

Delete Selected
Destinations button

Default filename
identifiers
Output
Filename
Template
pop-up menu
Sample
filename line

Destinations tab
•• Destinations list: This lists destination names and pathnames.
There are four default destinations in the Apple folder: Cluster Storage is a cluster’s scratch
storage location; Desktop is the user’s Desktop folder; Source is the folder from which the
source media file originated; and User’s Movies Folder is the Movies folder in the user’s home
folder.
Note:  Cluster Storage applies only to installations of Compressor that have distributed
processing enabled.
••

Create a New Destination (+) button: To create a destination, click this button. A file-selection
dialog appears in which you can select a destination folder.

••

Duplicate Selected Destination button: Makes a copy of the selected destination, placing it in
the Custom folder. Using this option allows you to create a new destination from a preexisting
destination, which you can then adjust according to your needs, rather than creating a new
destination from scratch.

••

Delete Selected Destinations (–) button: Removes a selected custom destination from the
Destinations tab immediately. You are not asked for confirmation, so be sure you want to
remove the destination before clicking this button.
Note:  You cannot remove the destinations from the Apple folder.
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Inspector items
When you double-click or select a destination in the Destinations tab, the Inspector window
opens. It contains the following items:
••

Name: Use this field to modify the name of the destination preset.

••

Output Filename Template: Use this pop-up menu to add file identifiers to your output media
file. You can manually edit this field. Choosing one of the following file identifiers adds it to
your output media filename:
••

Date: Date the file was transcoded in the YYYY-MM-DD format

••

Setting Name: Name of the setting used for the transcoding job

••

Source Media Name: Source media filename without its extension

••

Source Media Extension: Extension of the source media file

••

Sample From Defined Template: Displays a sample of what the output filename will look
like with any file identifiers you’ve added. You cannot edit the Sample line, but it changes
dynamically based on the file identifiers you add or delete.

••

Path: Displays the path to the destination folder.
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Set up targets and jobs
Set up targets
Targets contain three items: a setting, a destination, and an output filename.
Drag the dividers to expand
a target’s section and make
it easier to see the entry.

Target Add
and Remove
buttons
Output
filename

Setting

Destination

You can use a variety of methods to add targets to a job. The most common is to add a setting or
destination to the job.
Add an empty target to a job
In the Batch window, do one of the following:
mm Select one or more jobs and choose Target > New Target.
mm Select one or more jobs, Control-click in an empty area of one of them, and choose Target >
New Target.
mm Click the Add (+) button of an existing target.
Copy targets to another job
1 Select the targets to copy.
2 Hold down the Option key and drag the targets to the new job.
Delete targets
Do one of the following:
mm Select one or more targets and press Delete.
mm Click the Remove (–) button in a target.
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Add and copy jobs
Jobs are most often created by adding source media files to a batch. You can use several other
methods to add jobs to a batch.
Add an empty job to a batch
mm Choose Job > New Job.
Delete a job from a batch
mm Select the job and press the Delete key.
Copy jobs from one batch to another
Do one of the following:
mm Drag a batch tab out of the Batch window to view the batches in separate windows and then
drag a job from one window to the other.
mm Select the jobs to be copied, press Command-C, select the batch to copy them to, and then
press Command-V.

Chain jobs
Chaining jobs is useful when you need to apply multiple settings to a source media file, but need
to have each setting applied after the previous one has finished. To chain two jobs together,
you take the output file of one job and make it the source file of the chained job. This makes it
possible to control the order in which the settings modify the source media file.
Chain selected targets to new jobs
1 Select the targets whose outputs you want to chain to new jobs.
2 Do one of the following:
••

Choose Job > New Job With Target Output.

••

Control-click one of the targets and choose New Job With Target Output from the
shortcut menu.

New jobs are added to the batch with the chain thumbnail and the name of the output file of
the targets they are chained to.
The chained job’s source
name is the output filename
of the target it is chained to.

The chained job’s thumbnail
is this chain link icon.

For an example of chaining two jobs together, About reverse telecine on page 173.
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Submit batches
Submit a batch
After you’ve configured the jobs and their targets within a batch, you’re ready to submit the
batch for processing.
Tip:  Before committing to a long transcoding session, do a quick test with a small section of the
source media file. If there’s a problem (such as an incorrect setting or a reference file that can’t
find the files it refers to), you can make the correction without losing a lot of time. Such tests also
allow you to preview Encoder pane and Frame Controls pane results that aren’t visible in the
Preview window. For a quick way to select a small section of the source media file, see Transcode
a portion of a clip on page 57.
Make sure the test section is specific to the type of settings you applied. For example, pick
a high-motion section if you’re doing frame rate or field order conversions using the Frame
Controls pane.
Submit a batch for processing
1 Make sure the batch to be submitted is selected in the Batch window.
2 Do one of the following:
••

Choose File > Submit.

••

Click the Batch window’s Submit button.

The submit dialog appears.

3 Check the Name field to confirm the batch name.
You can change this name to something more meaningful about this batch. This is the name
that is used for this submission in both Share Monitor and in the History window in Compressor.
For more information about Share Monitor, see Share Monitor Help.
4 Use the Cluster pop-up menu to choose which computer or cluster will process the batch:
••

If you choose This Computer: Compressor does not involve any other computers in completing
the batch unless you select This Computer Plus, which creates an ad hoc cluster including This
Computer and any available service nodes.
For more information, see Enable managed and unmanaged services on page 228.

••

If you choose a cluster: Compressor submits the batch to the cluster for processing (This
Computer Plus is not available).

You may need to authenticate yourself depending on the choice you make. For more details, see
Distributed processing overview on page 215.

Chapter 6    Assign destinations and submit batches

147

5 Choose a priority level for the batch from the Priority pop-up menu.
6 Click Submit or press Return to submit the batch for processing.
The History window shows the batch progress. For more information about the History window,
see Compressor window overview on page 10.
Note:  The History window opens automatically if it isn’t already open.
You can also monitor the transcoding progress with Share Monitor by clicking its icon in the
Batch window. For more information about Share Monitor, see Share Monitor Help.
You can set Compressor preferences to automatically open Share Monitor. For more details, see
Set Compressor preferences on page 211.
Note:  When submitting larger batches (for example, nine source media files with three settings
assigned to each), there is about a 10-second delay after submitting the batch. Be patient.
Compressor is preparing the large batch before it can be properly submitted for processing.
If you’re transcoding a large batch, you should turn off the screen saver application on your
computer. This will improve the transcoding speed because resources aren’t being diverted to
the screen saver.
Click the warning symbol to
see an explanation about
why it is there.

After the batch has been submitted, a yellow triangle with an exclamation point appears in
the batch to let you know that a file with that name now exists at that destination, and that if
you submit again, that file will be overwritten. For more information, see If a warning triangle
appears on page 142.
Submit a batch using previous settings
You can bypass the submit dialog when submitting a batch. The submitted batch automatically
uses the settings from the previously submitted batch.
Do one of the following:
mm Choose File > Submit with Previous Settings.
mm Click the Submit with Previous Settings item in the Batch window toolbar (if present).
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Resubmit a batch from the History window
All batch submission information is stored in the History window. This information includes the
details about all of the batch’s jobs and targets, including which source media files were assigned
to them. You can use this information to resubmit a batch simply by dragging a particular entry
from the History window back to the Batch window.
For more information about the History window, see View batch information in the History
window on page 151.
1 In the Batch window, click the History button.
2 Locate the batch you want to resubmit.
Note:  This is where giving the batch submission a recognizable name can help.
3 Drag the submission from the History window to the Batch window.
When you drag a batch from the History window to the Batch window, Compressor creates a
new, untitled tab in the Batch window for that batch. The batch appears in the new tab with all
its original details (source media files, targets, assigned settings, destinations, output formats, and
batch name). You can now make any changes to the batch and resubmit it.
Save a batch file
There may be times when you configure a batch but aren’t able to submit it right away. In those
cases, you may find it useful to save the batch settings to use later.
Note:  As you work, keep in mind that the .compressor extension appears in the Batch window
tabs if Finder preferences are set to show all file extensions.
1 Choose File > Save As (or press Command-Shift-S).
2 In the dialog that appears, enter a name for the file if you don’t want to use the default name.
3 Choose a destination for the file from the Where pop-up menu.
4 Click Save.
Note:  Batch filenames have a .compressor extension added to them.
Open a batch file within Compressor
1 Choose File > Open (or press Command-O).
2 In the dialog that appears, locate and select the batch file to open.
3 Click Open.
You can also open a batch file by double-clicking it in the Finder, dragging the batch file to the
Compressor application icon, or choosing File > Open Recent and selecting a file.
Note:  An error message appears if Compressor cannot locate one or more of the source files
listed in the batch file, and only those sources it finds will appear.
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Transcode different clips from one source media file
If you have a large source media file and you want to transcode only a few different sections of it,
you can do this in one batch submission.
1 In the Batch window, add the source media file to the batch, once for each clip that you want
to make.
A new job is created each time you import the source media file
2 Add settings to each job.
A unique identifier is applied to the output filename, so that you can easily identify each clip
after it’s transcoded.

Unique file
identifiers are
automatically
applied to
each job.

3 To open the Preview window, do one of the following:
••

Choose Window > Preview (or press Command-2).

••

Click the Preview button in the Batch window.

4 In the Preview window, use the Batch Item selection buttons or pop-up menu to navigate to
each media file you want to transcode.
5 In the first media file, drag the In and Out points to the first section of media you want to
transcode, and repeat for the next media file by dragging its In and Out points to the next
section you want to transcode.
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You can also press the I (In) and O (Out) keys to move the markers to the current location of
the playhead.

In point

Out point

6 Return to the Batch window and click Submit.
For more information about the Preview window, see Previewing overview on page 52.
For more information about using the Batch window, see Create a batch on page 18.

View batch information in the History window
The History window shows the progress of a batch currently being transcoded. It also shows
information about previously submitted batches, including details about when particular job
batches were submitted from your computer.
Open the History window
mm To have the History window open automatically: Submit a batch.
mm To view the History window at any time: Choose Window > History (or press Command-1).
View the progress of a transcode
mm Submit a batch.
If it’s closed, the History window opens automatically and shows the progress of the transcode.
To pause or cancel the transcode, click the Pause or Cancel button.
Click the disclosure triangle
to see the details of each
target of this submission.

The name of
this submission

Click the Pause button
to temporarily pause
transcoding. Click
it again to resume
transcoding.

Click the Cancel button to
cancel the transcode.
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View information about previously submitted batches
Do any of the following:
mm To view all batches submitted on a specific date: Click the disclosure triangle next to the date.
Click the disclosure triangle
to see the details of that
day’s submissions.

mm To view information about a batch: Click the disclosure triangle next to the batch name.
Clicking this disclosure
triangle shows the
submission details.

Click the Reveal in
Finder button to show
the encoded file in
a Finder window.

A target from the
submitted batch

mm To quickly access the transcoded file: Click the Reveal in Finder button.
mm To change the order in which items are sorted: Click the Reverse Sort Order button at the bottom of
the History window.
Resubmit a batch
mm Drag a batch from the History window to the Batch window.
Remove a batch from the History window
Do one of the following:
mm Select a batch and press the Delete key.
mm Click the Clear button at the bottom of the History window.
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Advanced functions

7

Add filters
Filters overview
Compressor has a variety of filters (such as color-correction, noise-removal, and edge-sharpening
filters) you can use to adjust your source media file before transcoding, to improve the output
quality of your video and audio. The best way to assign these filter settings is to look at, and
listen to, your source media file, and then choose the most suitable filter for your output
purposes. You can view the results of an applied filter in the Preview window.
There are two categories of filters available in the Filters pane of the Inspector:
••

Video filters modify specific visual aspects of your source media, such as brightness and contrast,
color, noise levels, interlacing, and so on. For more information, see Video filters on page 156.

••

Audio filters modify sound aspects in your source media, such as dynamic range, peaking,
equalizer effects, and so on. For more information, see Audio filters on page 163.

When you select a filter in the filters list, additional controls become available so that you can
customize your settings.

Choose video filters,
audio filters, and
color output.
Filters list

Filter controls

The Filters pane also contains a pop-up menu to manually choose the type of color space applied
to your selected filters during transcoding. For more information, see Color output on page 165.
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Add and adjust filters
Use the Filters pane in the Inspector to add video and audio filters to your settings. If you want
to modify only a single media file, you can add filters to a setting already applied in the Batch
window. If you want to modify a custom setting permanently, you can add filters to the custom
setting in the Settings tab. That way, all future jobs you apply the setting to will be modified by
your chosen filters.
Note:  In the Settings tab, filters can be applied only to custom settings. If you want to apply filters
to any of the Apple-supplied settings in the Settings tab, first you must duplicate and save that
setting to the Custom folder. For more information, see Create and modify settings on page 35.
Apply and adjust filters
1 Do one of the following:
••

To apply a filter to a single media file: Select the media file’s setting in the target area of the
Batch window.

••

To apply a filter to a custom setting in the Settings tab: Select the setting in the Custom folder.

2 Click the Filters button in the Inspector.
The Filters pane opens, displaying the Video, Audio, and Color tabs.
3 Depending on the type of filter you want to apply, click the Video tab or Audio tab.
A list of available filters appears.
4 Select a filter in the list, and make adjustments to the controls in the lower part of the Inspector.
When you make adjustments to a filter, a checkmark appears beside the filter name in the filter
list, indicating that the filter has been applied to the setting.

The filter is automatically
selected if you make any
adjustments to it.
Any changes you make
to a filter’s settings
apply to the currently
selected filter.
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If you applied a filter to a setting in the Batch window, you can view the results of filter
adjustments in the Preview window. The viewer in this window is split into original and
transcoded views of your media file so that you can see or hear the effects of your filter settings
before processing the batch (as long as the checkbox for that particular filter is selected). This
can be helpful when you’re applying multiple filters because it can be difficult to anticipate
how the filters will interact with each other. It’s a good idea to scan through the whole movie
to ensure that your changes are not too extreme for some scenes. For more information, see
Preview media as source or with settings applied on page 52.

Adjustments you make
can be viewed in the
Preview window.

Note:  Depending on your system, the source media file type, and the number of filters applied,
the Preview window showing the filter settings may update at a lower frame rate than the
source frame rate.
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5 If you want to apply additional filters, repeat step 4.
6 Drag the filters up or down within the list to set the order in which you want them applied to the
source media file during transcoding.

Drag filters up or down
to set the order in which
you want them to be
applied to the source
media file.

Because filters are processed one by one during transcoding—starting with the first item in the
list—it’s important that your filters be organized in the order you want them. For example, it’s
sensible to place a text overlay filter last, so that the text color you selected isn’t modified by
other applied filters. If you see unexpected results in the Preview window, try changing the order
of the filters in the list.
Note:  If you reorder filters applied to a custom setting in the Settings tab, and then try to select
a different setting in the Settings tab, a Save dialog appears, requiring you to save or revert the
changes you made to the custom setting.

Video filters
Compressor includes the following video filters, located in the Video tab of the Filters pane.
BlackWhite Restore
Restores nearly black colors to pure black and nearly white colors to pure white without affecting
colors in the rest of the image. Use this filter to better compress the solid black and white areas
(the luminance) in the image, such as backgrounds. The two sliders let you separately set values
between 0 and 100 for black and white.
The BlackWhite Restore filter contains the following controls:

••

Black: Sets values between 0 and 100 for black.

••

White: Sets values between 0 and 100 for white.
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Brightness and Contrast
Alters the overall color and luminance values of your output media file to a brighter or darker
level. Some QuickTime codecs darken your video file, so you can use this filter to compensate.
Choose any number between –100 and 100, but avoid extreme settings, because they confer a
very washed-out quality.
The Brightness and Contrast filter contains the following controls:

••

Brightness: Adjusts brightness to any number between –100 and 100.

••

Contrast: Adjusts contrast to any number between –100 and 100.

Color Correct Highlights, Color Correct Midtones, Color Correct Shadows
Depending on which of these three filters you choose, corrects white balance inaccuracies and
creates color effects on the bright, midtone, or dark areas of your clip. You can adjust red, green,
and blue values independently between –100 and 100.
The three Color Correct filters contain the following controls:

••

Red: Adjusts the red value between –100 and 100.

••

Green: Adjusts the green value between –100 and 100.

••

Blue: Adjusts the blue value between –100 and 100.
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Deinterlacing
Removes the effects of interlacing. However, if you need to deinterlace video, it’s recommended
that you use the controls in the Frame Controls pane, instead. The deinterlacing controls in the
Frame controls pane provide better quality than this legacy filter. For more information, see
About deinterlacing on page 172.
The (legacy) Deinterlacing filter contains the following controls:

••

Algorithm: Choose one of four deinterlacing methods from this pop-up menu:
••

Blur: Blends the odd and even fields together. This setting gives more importance to
temporal data and preserves motion better, but because individual frames consist of a
composite of both frames, they don’t look good when you pause playback.

••

Even: Keeps the even fields and ignores the odd fields, avoiding motion blur.

••

Odd: Keeps the odd fields and ignores the even fields, avoiding motion blur.

••

Sharp: Looks at both fields to make all edges sharper. This setting gives more importance
to spatial data.

Fade In/Out
Adds a dissolve from and to a matte color at the beginning and end of the clip.
The Fade In/Out filter contains the following controls:

••

Fade In Duration: Sets the duration of the fade-in.

••

Fade Out Duration: Sets the duration of the fade-out.

••

Fade In Opacity: Sets the opacity of the clip’s video at the first frame. A value of 0.0 sets the
clip video to be completely covered by the matte color. A value of 0.5 sets the clip to be 50
percent covered by the matte color.

••

Fade Out Opacity: Sets the opacity of the clip’s video at the last frame. A value of 0.0 sets the
clip video to be completely covered by the matte color. A value of 0.5 sets the clip to be 50
percent covered by the matte color.

••

Fade Color: Sets the matte color. When you click the color well, the Colors window appears,
and you can choose the color to fade to and from. (The Fade In and Fade Out colors must be
the same.)
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Gamma Correction
Controls the overall brightness of an image as displayed on a monitor by changing the gamma
amount of the media file. This filter can be used to remove detail from an underexposed clip or
reduce an overexposed clip’s saturation to an acceptable level without washing out the image
too much. Computers using different operating systems have different monitor settings. For
cross-platform viewing, correcting the gamma will improve the image for all platforms.
The Gamma Correction filter contains a single control:

••

Gamma: Sets a gamma setting between 0.1 and 4.0.

Letterbox
Scales and positions the image in the frame within horizontal letterbox bars.
The Letterbox filter contains the following controls:

••

Type: Choose a letterboxing method from this pop-up menu. Scale vertically compresses
the video to fit within the letterbox bars. Matte crops off the video where the letterbox bars
are placed.

••

Position: Choose the position of the video from this pop-up menu. Center places letterbox bars
above and below the video, keeping the video centered. Bottom positions the video at the
bottom of the screen with a single letterbox bar above it. Top positions the video at the top of
the screen with a single letterbox bar below it.

••

Output: Choose the specific aspect ratio to use for the letterbox from this pop-up menu. Each
menu item is followed by a value that shows the ratio of the width to the height for that
setting. For example, the Academy setting shows its aspect ratio as 1.85:1, indicating that the
image’s width is 1.85 times the size of its height. The Manual setting enables the Manual slider,
which you can use to manually set the letterbox aspect ratio.

••

Manual: Lets you manually set the letterbox aspect ratio when Manual is selected in the
Output pop-up menu. (The Manual slider has no effect when Manual is not selected in the
Output pop-up menu.)

••

Background: Sets the letterbox color. When you click the color well, the Colors window appears,
and you can choose a background color.
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Noise Removal
Reduces random flecks of noise from the image. Some codecs introduce noise into the video file,
which can be softened with the Noise Removal filter. You can improve image quality and spatially
compress your material more efficiently by reducing its fine detail.
The noise reduction filter allows you to blur areas of low contrast while leaving high-contrast
edges sharp. This is known as adaptive noise reduction. The results are imperceptible to the
human eye but improve the final compression of the source media. It’s especially important to
use this filter with live video.
The Noise Removal filter contains the following controls:

••

Apply To: Choose the channels from which you want to filter noise using this pop-up menu.
The default choice is All Channels, which filters out noise from all channels including the
alpha channel. The other choice is Chroma Channels, which filters out noise only from the two
chroma channels—U and V—in the AYUV color space (or R408 in Final Cut Pro terminology).

••

Iterations: Choose the number of noise-smoothing passes (between 1 and 4) from this pop-up
menu. For instance, if you choose 2, the noise-removal algorithm is applied to the media file
twice. The modified image is used each time as a starting point for the algorithm. The more
iterations used, the fuzzier the image becomes.

••

Algorithm: Choose a noise-smoothing algorithm from this pop-up menu. Average modifies
each pixel’s color by taking an average of pixels around it, including its own color value.
Replace modifies each pixel’s color by taking an average of pixels around it, while ignoring
its own color value. Merge modifies each pixel’s color by taking a weighted average of
surrounding pixels and itself (with the pixel’s own color value given greater weight).
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Sharpen Edge
Enhances the image contrast around object edges. Some codecs blur the video image, so this
filter can counteract the softening effect of noise removal or blurred source material and increase
the perception of sharpness in the image. When used to an extreme, the output media file can
look grainy.
The Sharpen Edge filter contains a single control:

••

Amount: Sets a sharpen setting between 0.0 and 100.0.

Text Overlay
Superimposes text onto the image. This is a useful tool for stamping other relevant text
information onto your output media file.
The Text Overlay filter contains the following controls:

••

Position: Positions text in the image. Choose from any of 13 positions such as Center, Lower
Left, Lower Left - Title Safe, and so on.

••

Alpha: Sets the text opacity. Choose a value between 0 and 1. A value of 0 makes the text
completely transparent, and a value of 1 makes it completely opaque.

••

Overlay Text: Type your text here.

••

Text Color: Click the color well to choose a text color from the Colors window.

••

Select Font: Click this button to open a window for selecting font, style, and size.
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Timecode Generator
Superimposes the clip’s timecode text onto the image. You can also add a label to the
timecode text.
The Timecode Generator filter contains the following controls:

••

Position: Positions timecode text in the image. Choose from any of 13 positions such as Center,
Lower Left, Lower Left - Title Safe, and so on.

••

Alpha: Sets the timecode text opacity. Choose a value between 0 and 1. A value of 0 makes the
text completely transparent, and a value of 1 makes it completely opaque.

••

Label: Type any text that you want to appear to the left of the timecode number here.

••

Start Timecode at 00:00:00:00: Select this checkbox to have the timecode start at 00:00:00:00.
When this is not selected, the clip’s timecode is used.

••

Text Color: Click this color well to choose a timecode text color from the Colors window.

••

Select Font: Click this button to open a window for selecting font, style, and size.

Watermark
Superimposes a watermark onto the image. This is a useful tool for stamping a suitable logo onto
your output media file. The watermark filter can apply either still images or movies as watermarks
on your output media file.
The Watermark filter contains the following controls:

••

Position pop-up menu: Positions the watermark image in the image. Choose from any of 13
positions such as Center, Lower Left, Lower Left - Title Safe, and so on.

••

Scale By: Sets the size of the watermark image.

••

Alpha: Sets the watermark image opacity. Choose a value between 0 and 1. A value of 0 makes
the watermark image completely transparent, and a value of 1 makes it completely opaque.

••

Repeat: When you choose a clip as the watermark, selecting this checkbox loops playback of
the watermark clip. If you don’t select this checkbox, the watermark clip plays until its end and
then disappears.

••

Choose: Click this button to open the file-selection dialog and select a stored watermark movie
or still image.
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Audio filters
Compressor includes the following audio filters, located in the Audio tab of the Filters pane.
Important:  The audio filters are not available when audio is set to “Pass-through” in QuickTime
settings. For more information, see Create QuickTime media files on page 124.
Dynamic Range
Lets you dynamically control a clip’s audio levels by enhancing the quieter parts and lowering
the louder parts. This is also referred to as audio level compression (not to be confused with
video compression).
The Dynamic Range filter contains the following controls:

••

Soften Above: Sets the level at which audio is reduced (softened) to the level set by the
Master Gain control.

••

Noise Threshold: Sets the level of what is considered noise. Audio at this level and above is
dynamically boosted to the level set by the Master Gain. Audio below this level is left as is.

••

Master Gain: Sets the average level of the dynamically compressed audio.

Peak Limiter
Sets the level of the loudest audio allowed in the clip.
The Peak Limiter filter contains a single control:

••

Gain (dB): Sets the level above which louder peaks are reduced.
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Apple: AUGraphicEQ
Allows you to shape a wide variety of frequencies throughout the audible frequency range. You
have the choice of a 31-band version or a 10-band version.
The Apple: AUGraphicEQ filter contains the following controls:

••

Options: Click this button to open the Apple: AUGraphicEQ window, a graphic equalizer control
described below.

••

Apple: AUGraphicEQ: Adjusts the level of each frequency band to any value between –20 dB
and 20 dB. To modify a level, drag a frequency slider or, alternatively, select a frequency slider,
and type a number in the dB field (in the lower-right corner of the graphic equalizer window).
Drag to select multiple bands for simultaneous adjustment. You can also hold down the
Control key while dragging across the bands to “draw” an equalization curve. To set all bands
to a 0.0 dB value, click the Flatten EQ button.

Fade In/Out
Adds a mix from and to silence (or a gain level you set) at the beginning and end of the clip.
Note:  When using the Fade In/Out and Dynamic Range filters at the same time, be sure to have
the Dynamic Range filter ahead of the Fade In/Out filter in the filter list.
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The FadeIn/Out filter contains the following controls:

••

Fade In Duration: Sets the duration of the mix from the gain value to the clip’s normal audio
level at the start of the clip.

••

Fade Out Duration: Sets the duration of the mix from the clip’s normal audio level to the gain
value at the end of the clip.

••

Fade In Gain: Sets the level that the mix starts with. A value of –100.0 is silence, whereas a level
of 0.0 leaves the audio as it is.

••

Fade Out Gain: Sets the level that the mix ends with. A value of –100.0 is silence, whereas a
level of 0.0 leaves the audio as it is.

Color output
In addition to the Video and Audio tabs, the Filters pane contains a Color tab. Click the Color
tab to access a pop-up menu to manually adjust the color space for the output media file.
Compressor supports several standard color spaces—YUV (R408), 2VUY, RGBA, ARGB, and YUV
(v210)—and automatically chooses the optimal color space based on your source media format,
output file format, and chosen filters. However, you can override the automatic choice by
manually choosing a color space from the Output Color Space pop-up menu in the Color tab.
The Color tab contains a single control:

••

Output Color Space: Choose a color space for the output media file from this pop-up menu.
••

Default for Encoder: Uses the standard color space for the target format.

••

Preserve source: Maintains the color space of the source media file.

••

SD (601): Uses the standard color space for standard-definition (SD) media files.

••

HD (709): Uses the standard color space for high-definition (HD) media files.
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Work with frame controls
Frame controls overview
Many transcoding jobs, as well as manual adjustments made in the Geometry pane of
the Inspector, change the frame size (resolution) of the output video file. Frame controls
in Compressor use advanced image analysis to apply the most appropriate reprocessing
methods in transcoding jobs that involve a change in frame size. Frame controls can also apply
deinterlacing, retiming, and other video-processing effects. Available in the Frame Controls pane
of the Inspector, these tools let you:
••

Convert video files between international television standards, such as PAL to NTSC,
or NTSC to PAL.

••

Downconvert high-definition (HD) video sources to standard definition (SD), or upconvert
SD to HD.

••

Convert a progressive stream to an interlaced one, or interlaced to progressive.

••

Make high-quality frame rate adjustments, including high-quality slow-motion effects.

••

Automatically remove telecine pulldown (reverse telecine).

You can apply frame controls to custom saved settings in the Settings tab or to a setting already
applied in the Batch window. When you activate frame controls, Compressor automatically
chooses the best parameter settings based on your selected settings. However, you can override
the automatic settings by manually adjusting the controls in the Frame Controls pane. For more
information, see Apply frame controls to a setting on page 167. For more information about the
controls in the Frame Controls pane, see Frame Controls pane on page 168.

Automatic button
Frame Controls
pop-up menu

Resizing controls

Retiming controls

Important:  Frame controls settings cannot be previewed in the Preview window. To preview
frame controls settings, do a test transcode of a small section of your source media file. For more
information, see Transcode a portion of a clip on page 57.
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Apply frame controls to a setting
Use the Frame Controls pane in the Inspector to add frame processing and retiming adjustments
to a custom saved setting in the Settings tab or to a setting already applied in the Batch window.
Note:  In the Settings tab, frame controls can be applied only to custom settings. If you want to
apply frame controls to an Apple-supplied setting in the Settings tab, you must first duplicate
that setting and save it to the Custom folder. For more information, see Create and modify
settings on page 35.
Add automatic frame controls adjustments to a setting
1 Do one of the following:
••

To apply frame controls to a custom setting in the Settings tab: Select a setting in the Custom folder.

••

To apply frame controls to a setting already applied to a source media file in the Batch window:
Select the setting in the target area.

2 Click the Frame Controls button in the Inspector window.
The Frame Controls pane opens.
3 Click the Automatic button (with a gear icon) next to the Frame Controls pop-up menu.
Compressor analyzes the transcoding job (the source media file and the applied setting), and
automatically determines the appropriate frame controls attributes.
In automatic mode, frame controls technology is engaged in the following two types of
transcodes only:
••

Transcoding from high-definition (HD) sources to standard-definition (SD) MPEG-2 output files

••

Transcoding from interlaced sources to H.264 for Apple Devices (progressive) output files

Add custom frame controls adjustments to a setting
You can override the automatic frame controls adjustments assigned by Compressor by making
manual adjustments in the Frame Controls pane.
1 Repeat steps 1 to 3 from “Add automatic frame controls adjustments to a setting,” above.
2 Choose On from the Frame Controls pop-up menu.
The manual controls in the Frame Controls pane become available.
Note:  If the Automatic button is active, you first need to click it to turn it off, and then on again.
3 Make changes to any of the controls in the Frame Controls pane.
For more information, see Frame Controls pane on page 168.
4 To save the changes, click Save.
A new custom setting containing your manually adjusted frame controls appears in the Custom
folder of the Settings tab. You can now apply this setting to other source media files in the Batch
window. For more information about assigning settings in the Batch window, see Assign settings
to source media on page 32.
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Frame Controls pane
Use the following parameter controls in the Frame Controls pane of the Inspector to manually
adjust processing methods and retiming settings.

Automatic button
Frame Controls
pop-up menu

Resizing controls

Retiming controls

Activation controls
Use the two controls at the top of the pane to turn on automatic frame controls or manual
frame controls.
••

Automatic button: Click this button to have Compressor analyze the transcoding job (the
source media file and the applied setting) and then automatically apply the appropriate frame
controls attributes.
Frame Controls
Automatic button

In automatic mode, frame controls technology is engaged only for the following two types of
transcoding jobs:

••

••

Transcoding from high-definition (HD) sources to standard-definition (SD) MPEG-2 output files

••

Transcoding from interlaced sources to H.264 for Apple Devices (progressive) output files

Frame Controls pop-up menu: When the Automatic button is active, this pop-up menu becomes
available. Choose one of the following options:
••

Off: The default setting for most Apple presets. Choose Off if your Compressor project does
not involve changes to the frame size, frame rate, or field dominance.

••

On: Allows you to manually adjust all the attributes in the Frame Controls pane.
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Resizing Control
Use the controls in this area of the Frame Controls pane to choose the processing algorithm used
to resize frames.
••

••

Resize Filter: Choose a resizing method from this pop-up menu. This decision is a trade-off
between faster processing time and higher output quality in projects that involve a change
in resolution.

••

Fast (Nearest pixel): Provides the fastest processing time.

••

Better (Linear filter): Provides a medium trade-off between processing time and
output quality.

••

Best (Statistical prediction): Provides the highest output quality, but takes longer.

Output Fields: Choose the output scanning method (either the field dominance or a conversion
to progressive scanning) from this pop-up menu.

••

Same as source: Maintains the same scanning method used by the source media file.

••

Progressive: Scans complete frames (not divided into interlaced fields). Use this setting
instead of the Compressor Deinterlacing filter (a legacy filter in the Filters pane), because it
always results in higher-quality video.

••

Top first: Scans interlaced fields, giving dominance (field order) to the top field, also known as
field two, the upper field, or the odd field.

••

Bottom first: Scans interlaced fields, giving dominance (field order) to the bottom field, also
known as field one, the lower field, or the even field.
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••

Deinterlace: Choose a deinterlacing method from this pop-up menu. This decision is a tradeoff between faster processing and higher-quality deinterlacing of motion areas within the
frame. In all cases, each higher-quality deinterlacing option yields the same or better results
than the next lower-quality option. However, if downward resizing is also applied to the frame,
improvements in quality may not be noticeable. Under these circumstances, Fast or Better will
likely provide sufficiently high quality, depending on the amount of downward resizing.
For general information about deinterlacing, see About deinterlacing on page 172.
Important:  Using all Best settings may result in unexpectedly long processing times. If you’re
reducing the frame size in addition to deinterlacing the frame, Fast or Better will likely provide
sufficiently high quality, depending on the amount of downward resizing.

Note:  Although the Deinterlace pop-up menu is always active, Compressor only deinterlaces
jobs that need it. (For example, if the source is interlaced and the Output Fields pop-up
menu is set to Progressive, Compressor will deinterlace. If the source media file is progressive,
Compressor will not deinterlace.)
The Deinterlace pop-up menu contains the following options:
••

Fast (Line averaging): Averages adjacent lines in a frame.

••

Better (Motion adaptive): Applies good-quality deinterlacing for areas of the image that are
in motion.

••

Best (Motion compensated): Applies higher-quality deinterlacing for areas of the image that
are in motion.

••

Reverse Telecine: Removes the extra fields added during the telecine process to convert the
film’s 24 fps to NTSC’s 29.97 fps. Selecting this item disables all other items in the Frame
Controls pane. For more information about 3:2 pulldown and using the Reverse Telecine
feature, see About reverse telecine on page 173.

••

Adaptive Details: Applies advanced image analysis to distinguish between noise and edge areas.

••

Anti-alias: Sets a softness level from 0 to 100. This parameter improves the quality of
conversions when you’re scaling media up. For example, when transcoding SD video to HD,
Anti-alias smooths out jagged edges that might appear in the image.

••

Details Level: Sets a level (from 0 to 100) to preserve sharp edges. This is a sharpening control
that lets you add detail back to an image being enlarged. Unlike other sharpening operations,
the Details Level setting is able to distinguish between noise and feature details, and generally
doesn’t increase unwanted grain. Increasing this parameter value may introduce jagged edges,
however, which can be eliminated by increasing the Anti-alias level.
Note:  Adaptive Details, Anti-alias, and Details Level pertain only to frame resizing (scaling),
not deinterlacing.
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Retiming Control
Use the controls in this area of the Frame Controls pane to choose the algorithm with which
frame rates are adjusted.
Note:  When you use the retiming controls to change video speed, Compressor also adjusts
the audio portion of the output media file so that it stays in sync with the video. The retiming
controls do not affect the audio pitch. For more information about using these options, see
About retiming on page 175.
••

Rate Conversion: Choose a frame-retiming method (to change the frame rate) from this pop-up
menu. This decision is a trade-off between faster processing time and higher output quality.
In many cases, the Better setting provides sufficiently high-quality conversion at a substantial
savings in processing time over the Best setting.
Important:  Using all Best settings may result in unexpectedly long processing times. The
Better setting for rate conversion provides sufficiently high-quality conversion at a substantial
savings in processing time over the Best setting.
The Rate Conversion pop-up menu contains the following options:

••

••

Fast (Nearest frame): Applies no frame blending; Compressor simply uses a copy of the
nearest available frame to fill the new in-between frames.

••

Good (Frame blending): Averages neighboring frames together to create new
in-between frames.

••

Better (Motion compensated): Uses optical flow to interpolate frames, with
good-quality results.

••

Best (High quality motion compensated): Uses optical flow to interpolate frames, with higherquality results; this option is particularly useful for transcodes that involve increases in frame
rates (for example, 23.98 fps to 59.94 fps).

Set Duration to: Choose one of three methods to convert the clip’s duration to a new duration:

Selection pop-up menu
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••

Percent of source: Modifies the output clip’s speed by a percentage of the source clip’s
speed. Type a custom percentage value in the field, or choose a preset value from the
adjacent pop-up menu (with a downward arrow). These preset values are intended for use
in specific situations:
••

24 @ 25: Use this setting when you have 24 fps video that you want to convert to 25 fps for
PAL distribution.

••

23.98 @ 24: Use this setting when you have 23.98 fps video and want to convert it to 24 fps.

••

23.98 @ 25: Use this setting when you have 23.98 fps video and want to convert it to 25 fps
for PAL distribution.

••

30 @ 29.97: Use this setting when you have 30 fps video and want to convert it to 29.97 fps.

••

29.97 @ 30: Use this setting when you have 29.97 fps video and want to convert it to 30 fps.

••

24 @ 23.98: Use this setting when you have 24 fps video and want to convert it to 23.98 fps
for NTSC DVD distribution.
With each of these settings, no intermediate video frames are required—the existing
frames are just set to play back faster or slower.

••

Total duration: Sets a duration for the clip. As you change the duration (by modifying the
value slider), the percentage changes accordingly in the field above. This option is most
useful when you have a source media file whose duration is a bit longer or shorter than it
needs to be, and you’d rather change its playback speed than add or remove video frames.
With this method, intermediate video frames are created as needed.

••

So source frames play at [frame rate] fps: Use this option when the source media file’s frame
rate does not match the Encoder pane frame rate (shown as the frame rate for this item).

About deinterlacing
You can use the frame controls in Compressor to deinterlace your video media.
NTSC and PAL video is interlaced. This means that each frame of video consists of two fields (1/60 of
a second apart), one with the odd broadcast lines of the image and one with the even broadcast
lines of the image. The differences between these two fields create the impression of motion:
The eye combines these two images into the optical illusion of a whole frame of smooth, realistic
motion at 30 fps in standard-definition (SD) television; and because of the high field-refresh speeds
(1/60 of a second) of broadcast television, the interlacing is virtually invisible to a casual viewer.
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Because interlacing creates two fields for each frame, areas with fast movement within the field
become separated into alternating jagged lines. You can view your source media one frame at a
time and check for horizontal stripes along the leading and trailing edges of moving objects.

Interlacing creates
a “comb” effect that
should be removed.

If your source media file needs to be converted to a frame-based format, you must deinterlace
the file to remove the effects of interlacing. The best way to do so in Compressor is to use the
Deinterlace pop-up menu in the Frame Controls pane. (For more information, see Frame Controls
pane on page 168.) Because interlacing on computer displays can cause high-motion parts of
your video to look fuzzy, deinterlacing is especially important if you’re outputting a QuickTime
movie for desktop or web playback. You can remove the upper (odd) or lower (even) field from
an interlaced video file, although smooth motion may be compromised within the clip. The
deinterlacing features in Compressor can also be used to eliminate flickering caused by interlacing
in still frames that have thin vertical lines, such as title pages with small text. The remaining fields
are interpolated to create a whole image, resulting in an overall softening of the image.

About reverse telecine
The Deinterlace pop-up menu in the Frame Controls pane includes a setting for reversing the
telecine of the source file.
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Telecine is the process of converting motion picture film to the NTSC video format used in
broadcast television. The most common telecine approach to converting film’s standard 24 fps
frame rate to NTSC video’s 29.97 fps frame rate is to perform a 3:2 pulldown (also known as a
2:3:2:3 pulldown). If you alternate recording two fields of one film frame and then three fields of
the next, the 24 frames in 1 second of film end up filling the 30 frames in 1 second of video.

A B C D
A A B B B C C D D D

Field Field Field Field Field Field Field Field Field Field
1
2
1
2
1
2
1
2
1
2

Before (23.98 fps)

3:2 Pull-Down

A B C D A B C D A B C D A B C D A B C D A B C D
After (29.97 fps)
A A BBBCCDDD AABB BCCDDD AABBBCCDDDA ABBBCC DDD AABBBCCDDD AAB BBCCDDD

One second

As shown above, the 3:2 pattern (actually a 2:3:2:3 pattern because frame A is recorded to two
fields followed by frame B recorded to three fields) repeats after four film frames.
For editing and effects purposes, it’s often desirable to remove the extra fields and restore the
video to its original 23.98 fps rate. This process is known as reverse telecine. An additional benefit
of restoring the original 23.98 fps rate is that it’s easier to convert this to PAL, the European
broadcast standard, which uses a 25 fps frame rate.
The lower frame rate also has the advantage of requiring fewer frames per second of video,
leading to smaller file sizes. The reverse telecine feature in Compressor makes it easy to do
this conversion.
3:2 Pull-Down Removal

One second
Before (29.97 fps)
A A BBBCCDDD AABB BCCDDD AABBBCCDDDA ABBBCC DDD AABBBCCDDD AAB BBCCDDD

After (23.98 fps)

A B C D A B C D A B C D A B C D A B C D A B C D

A A B B B C C D D D

Field Field Field Field Field Field Field Field Field Field
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2
1
2
1
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2
1
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Other reverse telecine issues
Because the goal of reverse telecine is to output progressive 23.98 fps video, all the other options
in the Frame Controls pane are disabled when you choose Reverse Telecine from the Deinterlace
pop-up menu.
When using the Reverse Telecine menu command, consider these issues:
••

Because of the unpredictable nature of the processing when reversing the telecine, segmented
encoding does not work as efficiently as it does when reverse telecine is not being used.

••

If you pause the transcoding process, the transcode must start from the beginning when
you restart it.

Creating PAL video during the reverse telecine process
It’s a common practice to convert 23.98 fps or 24 fps video to PAL’s 25 fps rate by speeding up
the playback by 4 percent. If you’re starting with NTSC 29.97 fps video from a telecine, you can
convert it to PAL video by chaining two Compressor jobs. (For more information about chaining
jobs, see Chain jobs on page 146.) Create the following two jobs:
••

First job: Apply a setting to the job that performs the reverse telecine process and results
in an NTSC frame size at 23.98 fps. (Although you can apply a setting that also converts the
video to PAL, that format conversion does not use Frame Controls and therefore may not be
of suitable quality.)

••

Second job: Create the second job selecting the first job and choosing Job > New Job With
Target Output. This creates a job that is chained to the output of the first job. You can now
apply a setting that sets the output format to PAL and use the Frame Controls feature to
ensure a high-quality output file.

About the cadence
When film is telecined to NTSC video, it has a constant cadence. This means that the 3:2 pattern
is consistent and uninterrupted. It’s relatively easy to remove the telecine from a constantcadence clip because you need only determine the pattern once.
If you take these telecined clips and edit them as NTSC video, the result is a final video file that
has a broken cadence with an inconsistent 3:2 pattern. It’s much more difficult to remove the
telecine from this clip because you have to constantly verify the cadence to make sure you don’t
inadvertently choose incorrect fields when creating the 23.98 fps video.
The Reverse Telecine feature included with Compressor automatically detects broken cadences
and adjusts processing as needed.

About retiming
The retiming controls in the Frame Controls pane have two common uses:
••

Convert video from one frame rate to another: This typically involves converting NTSC video to
PAL frame rates or PAL video to NTSC frame rates. This function uses only the setting of the
Rate Conversion pop-up menu and is automatically configured when necessary.

••

Convert video to a new speed: This can be a matter of playing the existing frames at a different
rate or, in the case of slow-motion effects, it can require generating intermediate frames.
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In all cases, if the source media file contains audio, the audio also has its speed changed, with
the audio pitch corrected so that it sounds the same as the original, just at a different speed. This
ensures that you’ll maintain sync between the video and audio.
If you preview a setting that uses retiming controls, the video will play at its new frame rate or
speed, but it won’t have been processed by Frame Controls and will be of a lower quality than
the actual transcoded output file. The audio is pitch corrected when the setting is previewed.
Important:  If you’re using retiming controls on a setting using the QuickTime Movie output
format and choose “Pass-through” for the audio setting, the audio does not have its speed
changed and will not maintain sync with the video. For more information, see Create QuickTime
media files on page 124.

Modify geometry settings
Geometry overview
Although all of the Apple-supplied settings in Compressor contain parameters that set the
dimensions of your output video file, you can customize the final cropping, sizing, and aspect
ratio (the ratio between image frame width and height) using the controls in the Geometry
pane of the Inspector. The Geometry pane provides three different methods you can use to
affect the output image:
••

Cropping removes video content from an image. Often that content is unnecessary image
area (such as the overscan area, which is necessary for television, but not for computers) to
make what’s left seem bigger in the same frame size. Not only do the Compressor cropping
controls let you remove unwanted areas of the image, they also let you reframe the image to
emphasize a specific region.
The cropping controls also include a “Letterbox area of source” setting that detects image edges
and automatically enters crop values to match them. This is especially useful if you want to crop
out the letterbox area (the black bars above and below a widescreen image) of a source media file.
The cropping controls are located in the Source Inset (Cropping) section of the Geometry pane.

••

Scaling alters the frame size of the output video file without removing any of the source
image. Most often, scaling involves shrinking your output media image size to save storage
space or reduce the bit rate. The scaling controls are located in the “Dimensions (encoded
pixels)” area of the Geometry pane.
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••

Padding scales the image to a smaller size while retaining the output image’s frame size, by
filling the padded areas with black. Unlike cropping, padding does not remove any of the
source image or change the overall frame size. Instead, the image is reduced and black is
added to the borders of the frame to maintain the same frame size. The padding controls are
located in the Output Image Inset (Padding) section of the Geometry pane.

Cropping

Scaling

Padding

Crop, scale, and change frame dimensions
Use the Geometry pane in the Inspector window to crop, scale, and change frame dimensions
in a setting. Alternatively, you can crop the frame dimensions by dragging red frame bars in the
Preview window.
Note:  In the Settings tab, geometry adjustments can be applied only to custom settings. If you
want to adjust the geometry of an Apple-supplied setting in the Settings tab, you must first
duplicate that setting and save it to the Custom folder. For more information, see Create and
modify settings on page 35.
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Adjust the dimensions of a setting using the Geometry pane
1 Do one of the following:
••

To adjust the dimensions of a custom setting in the Settings tab: Select a setting in the
Custom folder.

••

To adjust the dimensions of a setting already applied to a source media file in the Batch window:
Select the setting in the target area.

2 Click the Geometry button in the Inspector.
The Geometry pane opens.

3 Do any of the following:
••

In the Source Inset (Cropping) area, enter your preferred cropping dimensions.

••

In the Frame Size pop-up menu, choose your preferred frame size.

••

In the Output Image Inset (Padding) area, choose an option from the Padding pop-up menu
(or choose Custom and type values in the fields below).

If you adjusted the geometry of a setting in the Batch window, you can view the results in the
Preview window.
4 To save the changes, click Save.
Adjust the cropping dimensions of a setting using the Preview window
1 Do one of the following:
••

To adjust the dimensions of a custom setting in the Settings tab: Select a setting in the
Custom folder.

••

To adjust the dimensions of a setting already applied to a source media file in the Batch window:
Select the setting in the target area.

2 Drag the red frame bars in the Preview window.
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As you drag, a help tag displays a numeric representation of your frame cropping dimensions.
Hold down the Shift key to constrain the crop to either the source aspect ratio, the source height,
or the source width.

If you select a batch’s target, any
resizing in the Preview window is
reflected in the Geometry pane.
You can also directly enter numbers
into these cropping fields.

Drag the red frame
bars (by the handles)
to adjust the output
file frame size.

3 To save the changes, click Save.
For more information, see Geometry pane on page 179 or Preview media as source or with
settings applied on page 52.

Geometry pane
Use the following parameter controls in the Geometry pane to choose cropping settings, output
media file frame sizes, and the aspect ratio (the ratio between image frame width and height) of
your output video file.

Cropping

Scaling

Padding
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Source Inset (Cropping) controls
Use these controls to reframe the image with a standard aspect ratio preset or custom dimensions.
••

••

Crop to: Choose a standard aspect ratio from this pop-up menu to crop the frame from the
center. There are eight choices:

••

Custom: Lets you manually enter values in the Left, Right, Top, and Bottom cropping fields
(described below), or adjust these values by dragging the red frame bars in the Preview
window. For more information, see Crop, scale, and change frame dimensions on page 177.

••

4:3 (1.33:1): Applies an automatic center crop with an aspect ratio of 4:3.

••

16:9 (1.78:1): Applies an automatic center crop with an aspect ratio of 16:9.

••

Panavision (2.35:1): Applies an automatic center crop with an aspect ratio of 2.35:1.

••

Europe Standard (1.66:1): Applies an automatic center crop with an aspect ratio of 1.66:1.

••

UK Standard (1.75:1): Applies an automatic center crop with an aspect ratio of 1.75:1.

••

Academy (1.85:1): Applies an automatic center crop with an aspect ratio of 1.85:1.

••

Letterbox area of source: Allows Compressor to detect whether the source media file has
been letterboxed, and if it has, to enter crop values to remove the letterbox.

Left, Right, Top, and Bottom: Four value fields that let you apply custom cropping dimensions
in pixel increments. Most broadcast video files have overscan areas. If the output file will be
shown exclusively on a computer screen rather than on a television screen, you can safely
remove some edging from your file without affecting the picture area. The values entered
in these fields give the distance (in pixels) between the edge of the original frame and the
resulting cropped frame. All fields default to 0.

Note:  The regular (action safe) overscan area is the outer 5 percent of the image on all four
sides. Cut in an additional 5 percent and you have the more conservative title safe area. So you
can safely crop anywhere between 5 and 10 percent of your outer frame area and still preserve
the essential material.
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When you adjust the cropping settings, one of two things happens to the output video file’s
frame size:
••

The frame size remains the same if you’ve chosen anything other than the “100% of source,”
“50% of source,” and “25% of source” settings in the Frame Size pop-up menu of the
“Dimensions (encoded pixels)” section of the Geometry pane. This means that the source video
image is scaled larger to fill the output video file’s frame size, which results in larger pixels and
overall image degradation.

••

The frame size is reduced by the crop amounts if you have chosen the “100% of source,” “50%
of source,” or “25% of source” setting in the Frame Size pop-up menu of the “Dimensions
(encoded pixels)” section of the Geometry pane. This can result in nonstandard frame sizes.

Note:  If you want to transcode a normal size standard-definition (SD) source media file (720 x
486) using an MPEG-2 NTSC setting, your output media file will be automatically cropped (two
pixels from the top and four from the bottom) to achieve the MPEG-2 required dimensions
of 720 x 480, unless you already specified cropping attributes. This cropping attribute is only
temporary and is not saved in the setting. You can see the automatic crop in the usual way, by
double-clicking the setting in the job to open the Preview window. For more information about
the Video Format pop-up menu, see MPEG-2 Encoder pane on page 89.
Dimensions (encoded pixels) controls
These scaling controls alter the size of the output video file without removing any of the
source image. They are available only when you use the MPEG- 4, QuickTime Movie, and Image
Sequence output encoding formats. For other formats, the settings are dimmed but show the
values that will be used when the batch is submitted.
••

Frame Size Width and Height fields: These fields let you customize the frame size and
aspect ratio of your output media file. Enter a value in either the Width or the Height field.
Alternatively, you can choose a standard aspect ratio from the adjacent pop-up menu,
described below.

••

Frame Size pop-up menu: Choose an option to set the dimensions of your output media file.
Values are automatically entered in the Width and Height fields based on the choices you
make in the pop-up menus.
••

100% of source: Defines an output dimension identical to the dimension of the source media.
(This option leaves the dimension unchanged.)

••

50% of source: Scales the output dimension to exactly 50% of the source media dimension.

••

25% of source: Scales the output dimension to exactly 25% of the source media dimension.

••

Up to 1920x1080: Scales the output dimensions to not exceed a 1920 x 1080 frame size while
maintaining the original aspect ratio.

••

Up to 1280x720: Scales the output dimensions to not exceed a 1280 x 720 frame size while
maintaining the original aspect ratio.

••

Up to 960x540: Scales the output dimensions to not exceed a 960 x 540 frame size while
maintaining the original aspect ratio.

••

Up to 854x480: Scales the output dimensions to not exceed a 854 x 480 frame size while
maintaining the original aspect ratio.
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••

Up to 428x240: Scales the output dimensions to not exceed a 428 x 240 frame size while
maintaining the original aspect ratio.

••

Up to 214x120: Scales the output dimensions to not exceed a 214 x 120 frame size while
maintaining the original aspect ratio.

••

320x240: Defines an output dimension of exactly 320 x 240.

••

640x480: Defines an output dimension of exactly 640 x 480.

••

720x480: Defines an output dimension of exactly 720 x 480.

••

720x486: Defines an output dimension of exactly 720 x 486.

••

720x576: Defines an output dimension of exactly 720 x 576.

••

1280x720: Defines an output dimension of exactly 1280 x 720.

••

1920x1080: Defines an output dimension of exactly 1920 x 1080.

••

Custom: Lets you enter custom dimensions in the Width and Height fields. This setting has
no constraint on the aspect ratio.

••

Custom (4:3): Lets you enter custom dimensions in the Width and Height fields, but
constrains them to the 4:3 aspect ratio. Enter a value in either the Width or the Height field,
and the other value is entered automatically.

••

Custom (16:9): Lets you enter custom dimensions in the Width and Height fields, but
constrains them to the 16:9 aspect ratio. Enter a value in either the Width or the Height field,
and the other value is entered automatically.

••

Custom (1.85:1): Lets you enter custom dimensions in the Width and Height fields, but
constrains them to the 1.85:1 aspect ratio. Enter a value in either the Width or the Height
field, and the other value is entered automatically.

••

Custom (2.35:1): Lets you enter custom dimensions in the Width and Height fields, but
constrains them to the 2.35:1 aspect ratio. Enter a value in either the Width or the Height
field, and the other value is entered automatically.

••

Pixel Aspect field: Lets you enter a custom pixel aspect ratio (when the adjacent Pixel Aspect
pop-up menu is set to Custom). Pixel aspect ratio refers to the shape of the pixels in a digital
image, a setting that is especially important when using certain filters. For example, if the
graphic you use for the Watermark filter has a circle and you want to be sure it still looks like
a circle when finished (as opposed to an oval), you must choose a Pixel Aspect setting that
matches your output format.

••

Pixel Aspect pop-up menu: Choose a standard pixel aspect ratio for the output media file from
this pop-up menu. This control forces the pixel aspect ratios to conform to specific formats.
Menu options include the following:
••

Custom: Lets you manually enter custom values in the adjacent Pixel Aspect field.

••

Default for size: Sets the pixel aspect ratio to the commonly assumed value for the setting’s
width and height. For example, the default for 720 x 480 or 720 x 486 is NTSC CCIR 601/DV NTSC.

••

Square: Sets the pixel aspect ratio for proper display on computers.

••

NTSC CCIR 601/DV: Forces the pixel aspect ratio to 4:3 using 720 x 480 pixels.

••

NTSC CCIR 601/DV (16:9): Forces the pixel aspect ratio to 16:9 using 720 x 480 pixels.

••

PAL CCIR 601: Forces the pixel aspect ratio to 4:3 using 720 x 576 pixels.

••

PAL CCIR 601 (16:9): Forces the pixel aspect ratio to 16:9 using 720 x 576 pixels.

••

HD (960x720): Forces the pixel aspect ratio to 16:9 using 1280 x 720 pixels.

••

HD (1280x1080): Forces the pixel aspect ratio to 16:9 using 1920 x 1080 pixels.

••

HD (1440x1080): Forces the pixel aspect ratio to 16:9 using 1440 x 1080 pixels.
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Output Image Inset (Padding) controls
Use these controls to apply and adjust padding. Padding scales the image to a smaller size while
retaining the output image’s frame size by filling the “padded” areas with black. Unlike cropping,
padding does not remove any of the source image.
Padding is useful when the source image frame size is smaller than the output image frame
size and you want to prevent the source image from being scaled to the output image size. By
adding the correct amount of padding, the source image will remain the same size in the output
image, with black filling the rest of the image frame.
Padding is automatically applied when the source video image is uncompressed NTSC 720 x
486 and the output image is 720 x 480. There are also several common padding settings you
can choose from, such as 16 x 9 and Panavision. These presets make it easy to have Compressor
automatically enter padding values to ensure the source image retains its original aspect ratio.

••

••

Padding pop-up menu: Choose a padding method from this pop-up menu.
••

Custom: Lets you manually enter custom values in the Left, Right, Top, and Bottom fields.

••

Preserve source aspect ratio: Pads the image so that the original aspect ratio is maintained.

••

4x3 1.33:1: Uses a 4:3 aspect ratio.

••

16x9 1.78:1: Uses a 16:9 aspect ratio.

••

4x3 1.33:1: Uses a 4:3 aspect ratio.

••

Panavision 2.35:1: Uses a 2.35:1 aspect ratio.

••

Europe Standard 1.66:1: Uses a 1.66:1 aspect ratio.

••

UK Standard 1.75:1: Uses a 1.75:1 aspect ratio.

••

Academy 1.85:1: Uses a 1.85:1 aspect ratio.

Left, Right, Top, and Bottom: These fields let you customize the dimensions of the black padding
around the sides of a frame (when the Padding pop-up menu is set to Custom).
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Add post-transcoding actions
Post-transcoding actions overview
In Compressor, you can create automatic post-transcoding actions and apply them to jobs in the
Batch window or to settings in the Settings tab. Post-transcoding actions simplify and accelerate
your day-to-day workflow and make it easy to share your work with others. Using actions, you
can quickly create and deliver output media files for the iPhone, iPad, iPod, Apple TV, DVD, Bluray Disc, the web, and YouTube without having to open any additional applications. You can
also automatically send email notifications when transcoding jobs are completed. And you can
trigger Automator workflows for individual transcoding jobs and trigger AppleScript documents
for individual targets.
Compressor supports two kinds of post-transcoding actions:
••

Setting actions are applied to settings in the Batch window or to custom settings in the
Settings tab. (Applying setting actions to a custom setting lets you save those actions
for future use.) There are two setting actions: email notification and default destination
assignment (the place on a local or remote disk where a transcoded file is saved). You apply
setting actions in the Actions pane of the Inspector. For more information, see Add setting
actions on page 184.

••

Job actions are applied to jobs in the Batch window. You can use job actions to automate
your transcoding workflow. For example, you can apply job actions to automatically upload
output media files to web streaming sites such as YouTube, to burn DVDs and Blu-ray discs, to
trigger Automator workflows, to transfer output media files to iTunes, to open output media
files in other applications, or to create web reference movies. Job actions are integral to the
functioning of batch templates. (For more information about batch templates, see Create
a batch on page 18.) You apply job actions in the Job Action tab in the Inspector (which
becomes available when you select the source media file in the Batch window). For more
information, see Add job actions on page 186.

Add setting actions
Apply setting actions in the Actions pane of the Inspector to do either or both of the following:
••

Send an email notification when a transcoding job is finished.

••

Choose a default save destination for a job or custom setting.

Add an email notification to a setting
You can apply one email notification per setting in the Batch window or the Custom folder of the
Settings tab. Email notifications are useful if you’re transcoding an especially large source media
file that may take many hours to complete. Rather than continuously checking to see if the
transcoding is finished, you can designate yourself as the email recipient (in the Actions pane of
the Inspector), and then wait until you receive an email.
Note:  In the Settings tab, setting actions can be applied only to custom settings. If you want to
apply a setting action to any of the Apple-supplied settings in the Settings tab, you must first
duplicate that setting and save it to the Custom folder. For more information, see Create and
modify settings on page 35.
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1 Do one of the following:
••

To apply an email notification to a setting in the Batch window: Select the setting in the Batch
window (by clicking the target area).

••

To apply an email notification to a custom setting in the Settings tab: Select the setting in the
Custom folder.

2 Click the Actions button in the Inspector.

Click the Actions button
to view the Actions pane.

3 Select the “Email Notification to” checkbox and enter an email address in the accompanying field.
Note:  If this checkbox appears dimmed, you must first enter an email address and outgoing mail
server in Compressor preferences. (Choose Compressor > Preferences. You may need to close and
reopen Compressor before your email preference changes take effect. For more information, see
Set Compressor preferences on page 211.)
4 If you want to save this email configuration to the selected setting, click Save or Save As.
Add a default destination for a setting
You can also use the Actions pane to assign an output destination to a setting in the Batch
window or the Custom folder of the Settings tab. (If you want to set a default destination for all
settings in Compressor, use Compressor preferences. For more information, see Set Compressor
preferences on page 211.)
Note:  In the Settings tab, setting actions can be applied only to custom settings. If you want to
apply a setting action to any of the Apple-supplied settings in the Settings tab, you must first
duplicate that setting and save it to the Custom folder. For more information, see Create and
modify settings on page 35.
1 Do one of the following:
••

To assign an output destination to a setting in the Batch window: Select the desired setting in the
Batch window (by clicking the target area).

••

To assign an output destination to a custom setting in the Settings tab: Select the desired setting
in the Custom folder.

2 Click the Actions button in the Inspector.
The Actions pane opens.
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3 Choose a destination from the Default Destination pop-up menu.
The pop-up menu lists the standard Apple destinations (Desktop, User’s Movies Folder, and so
on) and any custom destinations you’ve created.
4 If you want to save this default destination to the selected setting, click Save.

Add job actions
Apply job actions in the Job Action tab of the Inspector to automate your post-transcoding
workflow with the following tasks:
••

Upload output media files to web streaming sites such as YouTube, Facebook, and Vimeo.

••

Burn DVDs and Blu-ray discs.

••

Prepare files for live web streaming.

••

Trigger Automator workflows.

••

Transfer output media files to iTunes.

••

Open output media files in other applications.

••

Create web reference movies.

••

Send a notification email.

The Job Action tab of the Inspector becomes available when you select a source job in the
Batch window.
Note:  Job actions are also used in batch templates. For more information, see Quick and easy
batch template workflow on page 14.
Add a job action to a source media file
1 Add a source media file to the Batch window (if there isn’t already one there).
2 Click anywhere in the job area (the rectangle surrounding the source media file and its target or
targets) to select the job.
The A/V Attributes tab, Additional Information tab, and Job Action tab appear in the Inspector
window. (If the Inspector window is not open, click the Inspector button or choose Window >
Show Inspector.)
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3 If the Job Action tab is not active, click it.

4 Choose an item from the “When job completes” pop-up menu.
For a detailed description of each job action, see Job Action tab on page 187.
After you choose an action, a group of controls appears below the pop-up menu.
5 Adjust the controls to your liking, and click Submit in the Batch window.
Compressor begins transcoding the job, and applies the post-transcoding job actions you
selected in the Job Action tab.

Job Action tab
Depending on the action you choose in the “When job completes” pop-up menu, different
controls appear in the Job Action tab of the Inspector. Use these controls to apply and adjust
post-transcoding actions to entire jobs (a source media file in the Batch window with one or
more settings applied).
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Each control set in the Job Action tab is detailed below.
Add to iTunes Library
Use this form to automatically add output media files to iTunes.

••

Playlist pop-up menu: Choose a playlist in your iTunes library to add the output media file to.
Note:  The first time you use this feature, this pop-up menu is empty. To populate this menu
with playlists from your iTunes library, choose Refresh from the Playlist pop-up menu.

••

Title field: Enter the title of the file as you want it to appear in your iTunes library.

Create DVD
Use this form to enter information and settings for the DVD you want to burn.

••

Output Device pop-up menu: Choose the device you want to format to. The pop-up menu
displays a list of your system’s suitable output devices, including optical drives and the
computer’s hard disk. Choose Hard Drive to create a disk image (.img) file that you can burn
to DVD media at a later time using the Disk Utility application (available in the Utilities folder).
Other settings may change depending on the device you choose.
Important:  If a progress indicator appears next to the output device you selected, wait a
moment for the list of available devices to update. This can happen when you eject or insert a
disc or when you turn an optical drive on or off.

••

Eject button: Depending on your optical media drive type, click this button to eject optical
media from the drive or to open the drive’s media tray.

Chapter 7    Advanced functions

188

••

Layers pop-up menu: Choose the type of disc you’re making:
••

Automatic: Tells Compressor to automatically detect the type of disc you insert. For this
setting to work, you must insert the disc before clicking Burn. Additionally, Automatic always
creates a single-layer disk image when Hard Drive is selected as the output device.

••

Single-layer: Tells Compressor to identify the disc as a single-layer disc. You can use this
setting to force a dual-layer disc to be treated as a single-layer disc.

••

Dual-layer: Tells Compressor to identify the disc as a dual-layer disc. You can use this setting
to force the disk image to be formatted for a dual-layer disc when you choose Hard Drive as
your output device. Choosing Dual-layer when using a single-layer disc may result in an error
while burning the disc, depending on the project’s length.

••

Disc Template pop-up menu: Choose a menu template for the DVD.

••

Title field: Enter a name for the program on the DVD.

••

When Disc Loads pop-up menu: Choose what happens when the disc loads in the player:
••

Show Menu: Shows the menu.

••

Play Movie: Plays the movie.

••

Use Chapter Marker Text as Subtitles checkbox: Select this checkbox to have marker text appear
as subtitles. This setting is particularly useful for creating DVD dailies, because it lets you line
up a series of clips or scenes and identify each item with a marker text subtitle.

••

Background button: Opens a dialog to locate and select a still image for the menu’s background.

••

Main Menu and Chapter Menu buttons: Click the Main Menu and Chapter Menu buttons to
display previews of the menus included with the selected template.

Create Blu-ray Disc
Use this form to enter information and settings for the Blu-ray disc you want to burn.
Additionally, you can burn an AVCHD disc based on settings in this form.
An AVCHD disc can be thought of as a simpler high-definition (HD) disc that is burned to red
laser media. The resulting disc plays in Blu-ray Disc players that are compatible with the AVCHD
format. This means you can burn a disc that contains HD video content and some basic menu
features using a standard DVD burner, and play that disc in compatible Blu-ray Disc players. For
information about creating H.264 streams suitable for Blu-ray discs and AVCHD discs, see Create
Blu-ray discs on page 70.
Important:  You cannot play any disc containing Blu-ray content on a Mac computer.

Chapter 7    Advanced functions

189

You choose whether to burn a Blu-ray disc or an AVCHD disc using the Output Device pop-up
menu. The setting descriptions below identify which items do not apply to AVCHD discs.

••

Output Device pop-up menu: Choose the device to format to. The pop-up menu displays a list
of your system’s suitable output devices, including optical drives and the computer’s hard disk.
Each device also includes the words “Blu-ray” or “AVCHD” to indicate which type of disc it creates.
Choose Hard Drive to create a disk image (.img) file that you can burn to Blu-ray disc media at
a later time using the Disk Utility application (available in the Utilities folder). If you choose a
standard DVD burner, the disc is formatted as an AVCHD disc. All other devices format the disc as
a Blu-ray disc. Other settings may change depending on the device you choose.
Important:  If a progress indicator appears next to the output device you selected, wait a
moment for the list of available devices to update. This can happen when you eject or insert a
disc or when you turn an optical drive on or off.

••

Eject button: Depending on your optical media drive type, click this button to eject optical
media from the drive or open the drive’s media tray.

••

Layers pop-up menu: Choose the type of disc you’re making:
••

Automatic: Tells Compressor to automatically detect the type of disc you insert. For
Automatic to work, you must insert the disc before clicking Burn. Additionally, Automatic
always creates a single-layer disk image when Hard Drive is selected as the output device.

••

Single-layer: Tells Compressor to identify the disc as a single-layer disc. You can use this to
force a dual-layer disc to be treated as a single-layer disc.

••

Dual-layer: Tells Compressor to identify the disc as a dual-layer disc. You can use this to force
the disk image to be formatted for a dual-layer disc when you choose Hard Drive as your
output device. Choosing Dual-layer when using a single-layer disc may result in an error
while burning the disc, depending on the project’s length.

••

Disc Template pop-up menu: Choose a menu template for the Blu-ray disc.

••

Title field: Enter a name for the program on the Blu-ray disc.

••

When Disc Loads pop-up menu: Choose what happens when the disc loads in the player:
••

Show Menu: Shows the menu.

••

Play Movie: Plays the movie.
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••

Use Chapter Marker Text as Subtitles checkbox: Select this checkbox to have marker text appear
as subtitles. This setting is particularly useful for creating Blu-ray disc dailies, because it lets you
line up a series of clips or scenes and identify each item with a marker text subtitle.
Note:  Subtitles are not supported on AVCHD discs.

••

Include Loop Movie Button checkbox: Select this checkbox to add a Loop Movie button to the
menu. This option is not available on all disc templates.

••

Background button: Click to open a dialog to locate and select a background graphic.

••

Logo Graphic button: Click to open a dialog to locate and select a logo graphic.

••

Title Graphic button: Click to open a dialog to locate and select a title graphic.

••

Main Menu and Chapter Menu buttons: Click the Main Menu and Chapter Menu buttons to
display previews of the menus included with the selected template.
Note:   Blu-ray and AVCHD menus are best suited for display at 1080i or 1080p resolutions.
Users should ensure that their player and display are set accordingly.

Create Web Reference Movie
Use this form to create a reference movie that enables a web browser and a server to
automatically select the right movie for any device or connection speed, without requiring the
viewer to make a choice.

••

Choose button: Click to open a dialog for locating and selecting a destinations folder.

••

“Create Read Me file with sample HTML” checkbox: Use this checkbox to control whether
Compressor creates a text document containing complete instructions and sample HTML for
embedding the web reference movie in a website.

••

Create Poster Image checkbox: Use this checkbox to control whether Compressor creates a
thumbnail image for embedding the web reference movie in a website.
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Open with Application
Use this form to specify an application to open the output media file.

••

Open With pop-up menu: Choose the application that will open the output media file.

Prepare for HTTP Live streaming
Use this form to create a set of files to stream audio and video to iPad, iPhone, iPod touch, and
Mac, using an ordinary web server. Designed for mobility, HTTP live streaming can dynamically
adjust movie playback quality to match the available speed of wired or wireless networks. HTTP
live streaming is great for delivering streaming media to your iOS-based application or HTML5based website. For detailed information about implementing HTTP live streaming, see the
Apple Developer HTTP live streaming website.
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••

Choose button: Click to open a dialog for locating a destination for the HTTP live streaming assets.

••

Segment Duration field: Enter a value (in seconds) to define the segment lengths for the media.
This value defines how the video streams are split into segments. Segmentation governs when
the web server can switch between the various video formats while streaming to a device
with varying network connection speeds. A smaller value allows the server to respond more
quickly to changing connection speeds.

••

“Create Read Me file with sample HTML” checkbox: Select this checkbox to include a file with
basic HTTP live streaming usage information.

Run Automator Workflow
Use this form to choose an Automator script to run.

••

Choose button: Click to open a dialog for locating and selecting an Automator script that
Compressor will execute automatically on completion of the transcoding job.
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Publish to YouTube
Use this form to enter information about movies you want to publish to a YouTube account on
the web.
Note:  To upload multiple YouTube output media files in one batch, create a separate job for each
output media file.

Important:  You must complete all fields for successful uploading.
••

Username field: Enter your YouTube username.

••

Password field: Enter your YouTube password.

••

Title field: Enter the name of the movie you’re publishing.

••

Description field: Enter text describing the movie you’re publishing.

••

Tags field: Enter keywords that describe your movie. These are search terms that your intended
audience might use to find your movie on YouTube. For more information, see YouTube help.

••

Category pop-up menu: Choose a YouTube category for your movie. On YouTube, a movie can
belong to one of several categories (topic areas).

••

“Make this movie private” checkbox: Select this checkbox to control viewing access to the movie
you’re publishing. When you make a video private on YouTube, you have the option of sharing
it with a select number of people from any of the contact lists you create for your account. For
more information, see YouTube help.
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Publish to Facebook
Use this form to enter information about movies you want to publish to a Facebook account
on the web.
Note:  To upload multiple Facebook output media files in one batch, create a separate job for
each output media file.

Important:  You must complete all fields for successful uploading.
••

Email field: Enter the email address for a Facebook account.

••

Password field: Enter a Facebook password.

••

Title field: Enter the name of the movie you’re publishing.

••

Description field: Enter a description of the movie you’re publishing.

••

Privacy pop-up menu: Choose who can view the movie: Only Me, Friends, Friends of Friends,
or Public.
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Publish to Vimeo
Use this form to enter information about movies you want to publish to a Vimeo account on
the web.
Note:  To upload multiple Vimeo output media files in one batch, create a separate job for each
output media file.

Important:  You must complete all fields for successful uploading.
••

Email field: Enter the email address for a Vimeo account.

••

Password field: Enter a Vimeo password.

••

Title field: Enter the name of the movie you’re publishing.

••

Description field: Enter a description of the movie you’re publishing.

••

Tags field: Enter keywords that describe your movie. These are search terms that your intended
audience might use to find your movie on Vimeo. For more information, see Vimeo help.

••

“Viewable by” pop-up menu: Choose who can view the movie: Anyone, My Contacts, or Nobody Else.
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Publish to CNN iReport
Use this form to enter information about movies you want to publish to a CNN iReport account
on the web.
Note:  To upload multiple CNN iReport output media files in one batch, create a separate job for
each output media file.

••

Email field: Enter the email address for a CNN iReport account.

••

Password field: Enter a CNN iReport password.

••

Subject field: Enter the name of the movie you’re publishing.

••

Body field: Enter a description of the movie you’re publishing.

••

Tags field: Enter tags associated with the the movie you’re publishing.
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Send Email
Use this form to enter information for an email to be composed when the job is completed. This email
contains the actual output file as an attachment and opens in the Mail application so that you can
further edit the email’s contents and other settings. When you’re done editing the email, click Send.

••

Send To field: Enter the email address you want the email to be sent to. You can enter multiple
email addresses, separated by a comma.

••

Send From field: Enter the email address you want the email to be sent from.

••

Subject field: Enter the email’s subject.

••

Message field: Enter the email’s text.

Use Droplets
Create Droplets
You can save one or more settings or groups of settings in Compressor as a Droplet. A Droplet is a
standalone preset packaged into a drag-and-drop application and saved as an icon. Simply drag a
source media file onto a Droplet to launch a transcoding session, without opening Compressor.
Drag selected source
media files to a Droplet
to transcode them.

Compressor offers two simple methods for creating Droplets: using the Save Selection as Droplet
button in the Settings tab, or using the Create Droplet command in the File menu.
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Create a Droplet using the Save Selection as Droplet button in the Settings tab
You can create a Droplet in the Settings tab by selecting one or more Apple-supplied or custom
settings, and clicking the Save Selection as Droplet button.
1 In the Settings tab, select one or more settings or setting groups that you want to save as a Droplet.
2 Do either of the following:
••

Click the Save Selection as Droplet button in the top-left corner of the Settings tab.
Save Selection
as Droplet button

••

Control-click the settings you selected and choose Save as Droplet from the shortcut menu.

The Save dialog appears.

Note:  You can Shift-click or Command-click to add multiple settings or setting groups to a
Droplet. In this situation, every source media file is transcoded by every setting in the Droplet.
For example, if you submitted two source media files to a Droplet containing three settings,
Compressor creates six different output media files.
3 In the Save dialog, enter a name for the Droplet in the Save As field and use the Where pop-up
menu to navigate to the location where you want to save the Droplet.
You can save your Droplet anywhere on your computer, but it’s most convenient to save it on
your desktop, so that you can conveniently drag source media files to it.
4 Use the “Choose Destination for Droplet results” pop-up menu to choose a destination folder for
the output media files that the Droplet creates.
You can only select destinations that have already been created using the Destinations tab. If
no custom destinations have been created, only four default Apple destinations appear in the
Choose Destination pop-up menu. For more information about destinations, see Create and
modify destinations on page 140.
5 Click Save.
Your newly created Droplet appears as an icon at whatever location you selected. You are now
ready to use it for transcoding.
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Create a Droplet using the Create Droplet command in the File menu
1 Choose File > Create Droplet.
The Save dialog appears.

2 Select one or more settings or setting groups that you want to save as a Droplet.
You can Shift-click or Command-click to add multiple settings or setting groups to a Droplet. In
this situation, every source media file is transcoded by every setting in the Droplet. For example,
if you submitted two source media files to a Droplet containing three settings, Compressor
creates six different output media files.
3 Enter a name for the Droplet in the Save As field and use the Where pop-up menu to navigate to
the location where you want to save the Droplet.
You can save your Droplet anywhere on your computer, but it’s most convenient to save it on
your desktop, so that you can conveniently drag source media files to it.
4 Use the “Destination for files created by the droplet” pop-up menu to choose a destination folder
for the output media files that the Droplet creates.
You can only select destinations that have already been created using the Destinations tab. If
no custom destinations have been created, only four default Apple destinations appear in the
Choose Destination pop-up menu. For more information about destinations, see Create and
modify destinations on page 140.
5 Click Save.
Your newly created Droplet appears as an icon at whatever location you selected. You are now
ready to use it for transcoding.
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Use Droplets for transcoding media
After you create a Droplet, you can transcode source media files by dragging them to the
Droplet icon.
Transcode source media files using a Droplet
1 In the Finder, select one or more source media files.
2 Drag the selected files to the Droplet icon.

The Droplet window appears with the media files displayed in the Source Files sidebar on the left.
Note:  If you deselect the “Show window on startup” checkbox at the bottom of the Droplet
window, in future Droplet sessions transcoding will begin immediately after you drag a source
media file or files onto the Droplet, and the Droplet window will not appear.

3 In the Droplet window, add, delete, or modify settings and source media files.
For more information about customizing jobs in the Droplet window, see Droplet window on
page 204.
4 When you’re satisfied with the settings, click Submit.
The submit dialog appears. For detailed information about the submit dialog, see Submit a
batch on page 147.
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5 In the submit dialog, do the following:
a Enter a name for the batch in the Name field.
Although you aren’t required to name the batch, doing so helps you identify it in Share Monitor.
b In the Cluster pop-up menu, choose the computer or cluster to process the batch.
The default Cluster setting is This Computer, which means Compressor does not involve
any other computers in completing the batch. However, you can choose any other available
clusters that appear in this list. For information about setting up an Apple Qmaster distributed
processing network, see Distributed processing basics on page 217.
c Choose a priority level for the batch from the Priority pop-up menu.
d To submit the batch for processin, click Submit or press Return.
Each source media file is processed according to the existing setting or group of settings
contained within the Droplet, plus any modifications you made in the Droplet window.
6 If you want to view the processing status of your source media files, open Share Monitor.
For more information, see Share Monitor Help.
Adjust Droplet settings
There are several ways to check and adjust settings in the Droplet window.
mm To see detailed information about your output media file: Click the Show Info button on the right
side of any output row.
“Show info for”
pop-up menu

Note:  If you’re transcoding multiple source files, use the “Show info for” pop-up menu in the Info
dialog to choose which source media file’s details are displayed.
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mm To adjust or apply job actions: Click the Show/Hide Details button to reveal an action drawer for
the selected job, modify job actions using the controls in this drawer, and click the Show/Hide
Details button to collapse the drawer.
For more information about post-transcoding actions, see Add setting actions on page 184.

Show/Hide Details button

DVD Action drawer

For detailed information about the controls in the Droplet window, see Droplet window on
page 204.
Transcode source media files using an open Droplet
If a Droplet window is open, you can drag your source media files from the Finder directly to the
Source Files sidebar and submit them for transcoding.
1 Double-click a Droplet icon.
The Droplet window appears.
2 In the Finder, locate the source media files and drag them into the Source Files sidebar of the
Droplet window.

3 In the Droplet window, modify your settings as necessary.
For more information about the settings in the Droplet window, see Droplet window on page 204.
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4 Click Submit, and in the submit dialog that appears, click Submit again.
Each source media file is processed according to the existing setting or group of settings
contained within the Droplet. For example, if you submit two source media files to a Droplet
containing three settings, Compressor creates six different output media files.
5 If you want to view the processing status of your source media files, open Share Monitor.
If you drag files to a Droplet icon without first opening the application or opening a Droplet,
Compressor may display an alert message (“This computer is unavailable”), indicating that
Compressor processing services have not yet started up in the background. Click Submit at the
bottom of the Droplet window. Compressor processing services will start up and transcode the files.
If you submit a large number of source media files (such as 200 or more) using a Droplet, there
may be a delay of about a minute between the “Getting ready for processing” alert message
and the dialog reporting that the job is being submitted. You can avoid this reporting delay by
reducing the number of source files you submit at one time with a Droplet.

Droplet window
You can open any Droplet to view its full details as well as add, remove, and modify settings
and source media files. You can also modify the filenames for the output media files using the
Filename Template field and change the destination where the output media files are saved. (For
more information about using file identifiers, see Destinations tab and Inspector on page 143.)
The Droplet window contains the following features and controls:
Source Files
sidebar

Setting
pop-up menu

Destination
pop-up menu

Outputs

Submit button
“Show window on
startup” checkbox
••

Source Files sidebar: Displays a list of all source media files in the batch to be submitted.
You can drag additional source media files into this sidebar to add them to the batch to
be transcoded.

••

Destination pop-up menu and Choose button: Choose a save destination for the output media
file from this pop-up menu. You can choose one of the Compressor preset destinations
(Cluster Storage, Desktop, Source, or User’s Movie Folder) or click the adjacent Choose button
to open the Destination Location dialog and set your own custom save location.
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••

Setting pop-up menu (not labeled): Use this pop-up menu to select the type of output
media file. The preset choices are Apple TV, Blu-ray, DVD, iPhone, iPod, MP3 file, YouTube,
and Other. The Other option opens a dialog in which you can choose from a list of existing
Compressor settings.

••

Outputs area: The main area of the Droplet window displays all the outputs that have been
added to the Droplet. Each output row shown in this area will result in a separate media file
generated from each item in the Source Files sidebar.
Show Info button

Action checkbox (only present
for some job types)

Add Output and
Remove Output buttons

••

Filename Template field: Displays a template consisting of two tags that combine to create
the filename of the output file. The first tag (Source) is the source file name and the second
tag (Setting) is the output format chosen in the Setting pop-up menu (such as “iPod” or
“YouTube”). You can manually edit the filename by deleting or rearranging the tags in this
field, or by typing additional text.

••

Show Info button: Click to display extensive details about the current setting and the output
media file. If you’re transcoding multiple source files, you can view information about each
source media file by choosing the source filename from the “Show info for” pop-up menu.

••

Add Output and Remove Output buttons: Click Add Output (+) to create additional outputs. Click
Remove Output (–) to delete an output row.

••

Action checkbox: Select this checkbox to activate any post-transcoding actions (beyond
simply creating the output media file). For more information, see Post-transcoding actions
overview on page 184.

••

“Show window on startup” checkbox: Select this checkbox to have the Droplet window open
when you drag source media files to the Droplet icon, before the batch is submitted. Opening
the Droplet window allows you to verify the settings contained within the Droplet. If the
checkbox is not selected, the batch is submitted as soon as the batch is dragged to the
Droplet icon (as long as there are no errors), and the Droplet window doesn’t open.

••

Submit: Click this button to open the submit dialog and submit the batch. For more
information about submitting, see Submit a batch on page 147.

Use Final Cut Pro X and Motion 5 with Compressor

You can use Compressor to convert sequences or clips to one or more file formats from within
other applications, such as Final Cut Pro X and Motion 5. This integration makes transcoding
(the process of converting files from their original format to output files ready for distribution
in another format) faster and more convenient. Integration also saves hard disk space by
eliminating the need to export intermediate media files before processing them. It also leverages
the video-processing technology of the other applications to do much of the work (therefore
maximizing the quality of images that are encoded), and avoids degradation that can occur from
multiple compression and decompression steps.
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Final Cut Pro and Motion contain a Share menu with many commonly used transcoding options
already configured. However, if you need a transcoding option not covered by the preconfigured
Share items, or you need to customize one of the options, you can use the Send to Compressor
options to open the project in Compressor, where you can configure the output options
as needed.
Important:  Compressor 4 must be installed on the same computer as Final Cut Pro X and Motion
5 for these options to work.
Transcode a Final Cut Pro or Motion project
You can send a Final Cut Pro X or Motion 5 project to Compressor either with a setting already
in place or with no setting applied. In either case, the project appears in a batch that you can
configure as you would any other Compressor batch.
1 Open Final Cut Pro or Motion and select the project that you want to transcode.
2 Do one of the following:
••

Choose File > Send to Compressor.
With this option, Compressor opens and the project appears as a job in a new batch with no
settings applied.
The Final Cut Pro project name
is used as the new job’s name.

••

Choose Share, choose one of the preset output options, make adjustments in the Share dialog,
click Advanced, and then click Send to Compressor.
With this option, Compressor opens, and the project appears as a job in a new batch
configured with the Share dialog options you chose.

3 Assign settings and destinations to the job as necessary.
For more information, see Assign settings to source media on page 32 and Assign
destinations on page 138.
4 Click the Submit button in the Batch window.
Compressor transcodes the project according to your specified settings and destination.
Note:  After the Final Cut Pro or Motion project opens in Compressor, you can continue working
in Final Cut Pro or Motion on that project or a different project.
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Use the command line to submit Compressor jobs
Shell commands overview
If you are accustomed to doing your work from Terminal shells, you can run the Compressor
application from the command line using the Compressor command, with a number of
command-line options for submitting jobs.
In the command-line descriptions below, angle brackets < > indicate a mandatory argument in a
command, and brackets [ ] indicate an optional argument.

Synopsis
Below is a synopsis of the command for submitting a job to a cluster. The Compressor command
is located in /Applications/Compressor.app/Contents/MacOS/.
Compressor [‑clustername <name>][‑clusterid <username:password@
ipaddress:portNumber>] [‑batchfilepath <path>] [‑batchname <batchname>]
[‑priority <value>] [‑jobpath <path>] [‑settingpath <path>] [‑destinationpath
<path>] [‑info <xml>] [‑timeout <seconds>] [‑help] [‑show]

In this example, ‑jobpath, ‑settingpath, and ‑destinationpath, in that order, can be repeated
as many times as the number of jobs you want to submit.
Note:  Not all the options are necessary. For example, you can specify the cluster either by its
‑clustername or by its ‑clusterid. You do not need to specify both. If both are specified, only
‑clusterid is used.
Additionally, if you specify ‑batchfilepath, then ‑jobpath, ‑settingpath, and
‑destinationpath are not necessary because the previously saved batch file already contains
information about the job, settings, and destination.
Example of ‑batchfilepath:
Compressor ‑clustername "This Computer" ‑batchfilepath "/Volumes/Hermione/
SavedCompressorBatches/FreeChampagne.compressor"

After the job is submitted successfully, this command displays the batch ID (identifier) and job ID
(identifier) in the shell, and you can monitor the progress of a batch in Share Monitor.

Command options
This table provides information about each of the command options for submitting jobs.
Submission command option

Description

‑clustername <name>

Use to specify the name of the cluster to which
you want to send the job. Using the cluster name,
Compressor looks for the cluster on the network in
order to use it.

‑password <value>

User password for the cluster specified by
-clusterid or -clustername.

‑batchname <name>

Use to specify a name for the batch so that you can
easily recognize it in Share Monitor.
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Submission command option

Description

‑clusterid <user name:password@IP
address:port number>

Optionally, you can use ‑clusterid to enter the
cluster ID (IP address) and port number instead of
using ‑clustername. (When you enter the cluster
ID and port number, less time is required to find the
cluster on the network.) Enclose the IP address and
port as follows:
"tcp://<ip address>:<port>"

Also, if your cluster requires a password,
you must supply a password that is set for
QuickClusters in the Apple Qmaster Sharing
window in Compressor, or for manually created
clusters, in Apple Qadministrator. The format is
-clusterid [username:password]@<ip
address>:<port>. The user name is not checked,

so it can be any user name, but the password
must be valid. You can also use -password with
-clusterid as follows:

-clusterid @<ip address>:<port>
-password <password> Use Compressor
-show to see a cluster’s IP address and port number

(clusterid).
‑priority <value>

Specifies the priority level for a job.

‑jobpath <url>

Specifies the location of the source file.

‑settingpath <url>

Specifies the location of the settings for the job.

‑destinationpath <url>

Specifies the destination file URL for the job.

‑info <xml>

Gives detailed information for a batch or a job.

‑timeout <seconds>

Use to specify the number of seconds before
Compressor can quit when looking for a cluster.
The default value is 30. A value of 0 puts no limit on
the timeout and allows Compressor to browse the
network for as long as it needs to find the cluster.

‑show

Shows the ID information for the cluster specified
with ‑clustername or ‑clusterid, or for all
clusters if no cluster is specified.

‑help

Displays information regarding the required
parameters for the Compressor command.

Example: Compressor commands
Following are examples of code for submitting common Compressor commands.
Cluster names and IDs on a local network
The following command lists all of the cluster names and IDs on the local network.
/Applications/Compressor.app/Contents/MacOS/Compressor -show -timeout 10

This command has the following elements:
••

Identifies where Compressor is located (the quotation marks are used because of the space in
“Final Cut Pro”).

••

Shows all cluster names and IDs found.

••

Sets the command to time out after 10 seconds.
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Submit a job with no password
The following command submits a job to a cluster identified by a name that does not have
a password.
/Applications/Compressor.app/Contents/MacOS/Compressor -clustername MyCluster
-batchname "My First Batch" -jobpath ~/Movies/MySource.mov -settingpath
~/Library/Application\ Support/Compressor/Settings/MPEG-4.setting
-destinationpath ~/Movies/MyOutput.mp4 -timeout 5

This command has the following elements:
••

Identifies where Compressor is located.

••

Sends this job to the cluster named MyCluster.

••

Assigns the batch name My First Batch (the quotation marks are used because of the spaces).

••

Finds the MySource.mov file for the job at ~/Movies/MySource.mov.

••

Uses the MPEG-4 setting at ~/Library/Application\ Support/Compressor/Settings/MPEG-4.
setting (the “\” character is used in this case to retain the space in “Application Support”).

••

Writes the output file, named MyOutput.mp4, to the ~/Movies folder.

••

Sets the command to time out after 5 seconds of looking for the cluster.

Submit a job with a password
The following submits a job to a cluster identified by a name that does have a password.
/Applications/Compressor.app/Contents/MacOS/Compressor -clustername MyCluster
-password testpassword -batchname "My First Batch" -jobpath ~/Movies/
MySource.mov -settingpath ~/Library/Application\ Support/Compressor/Settings/
MPEG-4.setting -destinationpath ~/Movies/MyOutput.mp4 -timeout 5

This command has the following elements:
••

Identifies where Compressor is located.

••

Sends this job to the cluster named MyCluster.

••

Submits the password “testpassword.”

••

Assigns the batch name My First Batch.

••

Finds the MySource.mov file for the job at ~/Movies/MySource.mov.

••

Uses the MPEG-4 setting at ~/Library/Application\ Support/Compressor/Settings/MPEG-4.setting.

••

Writes the output file, named MyOutput.mp4, to the ~/Movies folder.

••

Sets the command to time out after five seconds of looking for the cluster.

Submit a job using a cluster ID and no password
The following submits a job to a cluster identified by an IP address that does not have a password.
/Applications/Compressor.app/Contents/MacOS/Compressor -clusterid
"tcp://192.168.1.148:62995" -batchname "My First Batch" -jobpath ~/Movies/
MySource.mov -settingpath ~/Library/Application\ Support/Compressor/Settings/
MPEG-4.setting -destinationpath ~/Movies/MyOutput.mp4 -timeout 5

Chapter 7    Advanced functions

209

This command has the following elements:
••

Identifies where Compressor is located.

••

Sends this job to the cluster with the IP address of tcp://192.168.1.148 at port 62995.

••

Assigns the batch name My First Batch.

••

Finds the MySource.mov file for the job at ~/Movies/MySource.mov.

••

Uses the MPEG-4 setting at ~/Library/Application\ Support/Compressor/Settings/MPEG-4.setting.

••

Writes the output file, named MyOutput.mp4, to the ~/Movies folder.

••

Sets the command to time out after 5 seconds of looking for the cluster.

Submit a job using a cluster ID and an inline password
The following submits a job to a cluster identified by an IP address, with a user name and an
inline password.
/Applications/Compressor.app/Contents/MacOS/Compressor -clusterid "tcp://usernam
e:testpassword@192.168.1.148:62995" -batchname "My First Batch" -jobpath ~/
Movies/MySource.mov -settingpath ~/Library/Application\ Support/Compressor/
Settings/MPEG-4.setting -destinationpath ~/Movies/MyOutput.mp4 -timeout 5

This command has the following elements:
••

Identifies where Compressor is located.

••

Sends this job as “username” with the password “testpassword” to the cluster with the IP
address of tcp://192.168.1.148 at port 62995.

••

Assigns the batch name My First Batch.

••

Finds the MySource.mov file for the job at ~/Movies/MySource.mov.

••

Uses the MPEG-4 setting at ~/Library/Application\ Support/Compressor/Settings/MPEG-4.setting.

••

Writes the output file, named MyOutput.mp4, to the ~/Movies folder.

••

Sets the command to time out after 5 seconds of looking for the cluster.

Submit a job using a cluster ID and a password
The following submits a job to a cluster identified by an IP address using a password, but does
not specify a user name.
/Applications/Compressor.app/Contents/MacOS/Compressor -clusterid
"tcp://192.168.1.148:62995" -password testpassword -batchname "My First
Batch" -jobpath ~/Movies/MySource.mov -settingpath ~/Library/Application\
Support/Compressor/Settings/MPEG-4.setting -destinationpath ~/Movies/
MyOutput.mp4 -timeout 5

This command has the following elements:
••

Identifies where Compressor is located.

••

Sends this job to the cluster with the IP address of tcp://192.168.1.148 at port 62995 with the
password “testpassword.”

••

Assigns the batch name My First Batch.

••

Finds the MySource.mov file for the job at ~/Movies/MySource.mov.

••

Uses the MPEG-4 setting at ~/Library/Application\ Support/Compressor/Settings/MPEG-4.setting.

••

Writes the output file, named MyOutput.mp4, to the ~/Movies folder.

••

Sets the command to time out after 5 seconds of looking for the cluster.
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Compressor preferences
Set Compressor preferences
Use the Compressor Preferences window to configure a variety of Compressor settings.
Open and set Compressor preferences
1 Choose Compressor > Preferences, or press Command-Comma (,).
The Preferences window appears.

2 Enter your preferred settings using the fields and controls in this window.
For detailed information about settings in the Preferences window, see Preferences window on
page 212.
3 When you’ve finished entering your preferences, click OK.
Enter IP addresses or ranges for remote host computers
If you want to allow remote host computers to connect to your computer, you can add them to
the list at the bottom of the Preferences window.
1 Choose Compressor > Preferences, or press Command-Comma (,).
2 Click the Add (+) button at the bottom of the Compressor Preferences window.
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The host address dialog appears.

3 In the host address dialog, do one of the following:
••

Select Host, complete the Host Name and IP Address fields, and click Add Host.
Note:  You can also enter only the host name or the IP address and press the Tab
key. If a corresponding host name or IP address is found, the match is entered in the
field automatically.

••

Select “Host IP address range,” complete the Range fields, and click Add Range.

The hosts or host ranges appear in the Host table in the main Preferences window.
Important:  Any changes you make to the Compressor preference settings take effect only when
you click OK. If you make changes but decide not to use them, click Cancel.

Preferences window
The Compressor Preferences window contains the following settings:
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••

Email Address field: Enter a default email address for email notification.

••

Outgoing Mail Server field: Enter the mail server used by your computer for outgoing email. For
more information about email notification, see Add setting actions on page 184.

••

“Automatically launch Share Monitor” checkbox: Select to have Share Monitor automatically
open when you submit a batch.

••

“Display job thumbnails” checkbox: Select to display thumbnail images for jobs in the
Batch window.

••

Cluster Options pop-up menu: Choose a cluster copying method (for distributed processing
scratch storage settings):
••

Copy source to cluster as needed: Copies source files to a cluster’s scratch storage location
as needed.

••

Always copy source to cluster: Always copies source files to a cluster’s scratch storage location.

••

Never copy source to cluster: Prevents Compressor from copying source files. For example,
if you have a very large source file, you can use this option to manually mount a shared
storage on the nodes rather than copying the file to the cluster.

••

Never copy files to/from cluster: Prevents Compressor from copying any files. Either all the files
are in the correct locations, or the batch fails.

••

“Copy at submission (high priority)” checkbox: Select to have Compressor transfer source files to
the processing cluster immediately.

••

Default Setting pop-up menu: Choose a default preset from the settings in the Settings tab.

••

Default Destination pop-up menu: Choose a default save location from the list of existing
destinations in the Destination tab.

••

For New Batches buttons: Select one of the following options for setting the Compressor
startup screen:
••

Show Template Chooser: Compressor opens with the Batch Template Chooser open.

••

Use Blank Template: Compressor opens with an empty untitled batch with a placeholder job.

••

“Allow connections from other computers” checkbox: Select to allow remote computers running
Share Monitor to view this computer’s job status. Share Monitor on the remote computer only
needs to know the IP address or host name. (There is no password to enter.)

••

“Enter IP addresses or ranges for manually selected computers” table: Displays information about
remote host computers.

••

Add (+) and Remove (–) buttons: Click these buttons to add or delete information about remote
host computers. For more information, see Set Compressor preferences on page 211.
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Use Apple Qmaster to set up
a distributed processing system

8

What is Apple Qmaster?

Apple Qmaster is used for two separate purposes: to configure service nodes and cluster controllers
in a distributed processing network, and to submit jobs and batches for distributed processing.
The Apple Qmaster application is one part of the larger Apple Qmaster distributed processing
system, which also includes Compressor, Apple Qadministrator, and Share Monitor. The complete
system includes controls for configuring clusters of processing computers and for monitoring,
pausing, resuming, or canceling work that has been submitted.
To set up your computer to be part of a distributed processing network, you use the Apple
Qmaster Sharing window. You can also use the Apple Qmaster Sharing window to activate,
create, or make changes to Apple Qmaster cluster-controlling and processing services (including
passwords and scratch storage locations).
Service
node

Cluster
controller

Use the Apple Qmaster Sharing window
to configure service nodes and cluster controllers

To learn more about distributed processing, see Distributed processing overview on page 215.
To learn more about the Apple Qmaster Sharing window, see Setup pane of the Apple
Qmaster Sharing window on page 253 and Advanced pane of the Apple Qmaster Sharing
window on page 254.
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After setting up your distributed processing system, you use the Apple Qmaster window to submit
distributed processing jobs and batches from applications like Compressor, Maya, and Shake.
For example, you can:
••

Process a batch of Shake files: Drag Shake files into the Apple Qmaster window. A default script
for submitting the jobs is automatically created, and you can then adjust settings and specify
details such as which cluster to use.

••

Process a batch of Maya files: Apple Qmaster uses a dedicated window for submitting and
customizing Maya jobs.

••

Process projects from other frame-based rendering applications (such as After Effects and
LightWave): Use the Generic Render command in Apple Qmaster.

To learn more about submitting jobs and batches for distributed rendering and processing, see
Batch processing overview on page 236. To learn more about the Apple Qmaster window, see
Apple Qmaster window on page 250.

Distributed processing systems
Distributed processing overview
Transcoding or processing a series of large files on one desktop computer is processor-intensive
and time-consuming. Distributed processing accelerates processing by distributing the work to
multiple computers that have been chosen to provide more processing power. You can submit
batches of processing jobs to the Apple Qmaster distributed processing system, which allocates
those jobs to other computers in the most efficient way.
The Apple Qmaster system is a suite of applications that work together to provide maximum
power and flexibility for distributed processing. The elements of the system can be combined in
a variety of ways to suit your needs.
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In general, you use the Apple Qmaster Sharing window in Compressor to configure service
nodes and cluster controllers and to create service nodes for This Computer Plus clusters
and QuickClusters, which provide what most users need. System administrators use Apple
Qadministrator for advanced cluster creation and control. Client users use Compressor or Apple
Qmaster to submit batches of jobs for processing. Finally, both administrators and client users
can use Share Monitor to monitor and manage batches.
Compressor

Users: Administrators
Use to: Create service nodes and
cluster controllers

Apple Qadministrator

Users: Administrators
Use to: Assemble clusters of service nodes
and cluster controllers

QuickCluster

Share Monitor

Compressor or Apple Qmaster

Users: Administrators and client users
Use to: Monitor batches that have
been sent to clusters

Users: Client users
Use to: Submit jobs to clusters
for processing

Note:  It’s possible to create a simple (personal) distributed processing system and skip Apple
Qadministrator altogether. For more information, see Quickly set up a service node using This
Computer Plus on page 223 and Set up a cluster controller using QuickClusters on page 224.
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Distributed processing basics
Computers that submit batches to the Apple Qmaster distributed processing system are called
clients. A client computer can be any computer that has Compressor installed and is on the same
network (subnet) as the cluster controller. Multiple client computers can be on the same subnet,
using the same cluster to do the processing for various applications.
An Apple Qmaster job is a processing task in the form of a project shared by Final Cut Pro or
Motion, a Compressor or Apple Qmaster batch, a Shake file, and other application files, that
includes settings such as rendering instructions, file locations, and destinations.

Network

Batch of
processing jobs
Client computer
Jobs are submitted.

Processed
files
Apple Qmaster cluster
Processing is
performed by cluster.

Destination folder
Files are placed at
specified destination.

A batch is one or more jobs submitted for processing at one time. The procedure is analogous
to printing multipage documents from a word-processing application; the files are spooled and
processed in the background. Although a batch can include just one job, you’ll typically want
to submit several jobs at once for processing. Similarly, several people can use the same Apple
Qmaster system at the same time, with several client computers sending batches in the same
time frame.
Batches are managed and distributed by the computer that’s designated as the Apple Qmaster
cluster controller. When a client sends batches to the Apple Qmaster distributed processing
system, all the processing and subsequent moving of any output files is performed by a group
of Apple Qmaster–configured computers called a cluster. You can create one or more clusters of
service nodes, with one cluster controller included in each cluster. Each computer in the cluster is
connected to the other computers in the cluster through a network connection.
Cluster
controller

Service
node

Service
node

Service
node

Example of a cluster

The client computer, the service nodes, and the cluster controller are often on separate (but
network-connected) computers, for the most rapid processing potential. However, the cluster
controller could be on a client computer or a service node. For more information about this
scenario, see Examples of distributed processing systems on page 219.
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An Apple Qmaster cluster contains:
••

Service nodes: The computers that perform the processing of batches submitted via
Compressor or Apple Qmaster. A batch can include one or more jobs. The service nodes are
where the processing work is done. When you assign a group of service nodes to a cluster,
they function as one very powerful computer because all their resources are shared. If one
service node is overloaded or otherwise inaccessible, another service node is used.

••

A cluster controller: The software that divides up batches, determines which service nodes to
send work to, and tracks and directs the processes.
Client computer from
which users send jobs to the cluster

Cluster
(can contain multiple service nodes, but only one cluster controller)
Cluster controller manages the
distribution of client’s jobs across the cluster

Service node
processes jobs

Service node
processes jobs

Service node
processes jobs

Service node
processes jobs

Note:  See the Distributed Rendering Guide on the Shake Support website
(http://www.apple.com/support/shake) for an online guide to setting up a full-time “render farm”
incorporating an Xserve computer and cluster nodes.

Distributed processing setup guidelines
The following are the basic rules for setting up a distributed processing network:
••

A cluster must contain one (and only one) computer acting as the cluster controller and at
least one computer acting as the service node. (These two can be the same computer; see
Examples of distributed processing systems on page 219.)

••

The client computers and the computers in any cluster that supports them must be on the
same network.

••

The network must support the Bonjour networking technology built in to OS X.

••

All the computers in a cluster need read-and-write access to any computers (or storage
devices) that will be specified as output destinations for files.

••

All of the computers in a cluster must use the same versions of Compressor, QuickTime, and OS X.
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Examples of distributed processing systems
The following sections provide three examples of distributed processing networks.
Example: A small distributed processing network
A very small distributed processing network could include as few as two computers:
••

One computer connected to the client and configured to act as both the service node and the
cluster controller

••

One client computer
Service node with cluster
controller enabled

Client

Minimum setup for distributed processing

Though simple, this setup is useful in a small-scale environment because it allows the client
computer to offload a lot of processing work.
Example: A distributed processing network using desktop computers
This network uses desktop computers to create a “part-time” processing network. Five computers
act as both the clients (workstations from which users submit jobs for distributed processing)
and cluster computers (which do the processing). The bulk of the processing jobs can be
submitted with Compressor or Apple Qmaster at the end of the day, so that the computers
process a large queue of distributed processing batches after the work day is done. For
information about scheduling service node availability, see Advanced pane of the Apple Qmaster
Sharing window on page 254 and Schedule service availability on page 229.

Network

Each computer acts as both
a client that submits jobs for processing and
a service node that performs the processing.
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Example: A target distributed processing network using a local area network (LAN)
For more powerful rendering, this network includes multiple client computers on a LAN that
are connected to a cluster using a high-speed switch. A rack of servers plus a shared storage
device, acting as the cluster, create an extremely strong rendering engine. In this example, each
service node has a local copy of the relevant client application software so that it can process the
rendering jobs.
Client

Client

Client

Client

LAN

High-speed switch

Rack of servers containing
cluster controller and
service nodes, plus
rack-mounted shared
storage device

Example of a network setup for distributed rendering

Additional components of a distributed processing network
A distributed processing network can consist of as few as one or two computers, whereas a highvolume network may include many computers, an Xserve system and Xserve cluster nodes in a
rack, and high-speed networking infrastructures. You can scale up a distributed processing system
as your workload demands by adding features and devices to the network that supports it.
There are many ways to expand the capacity of a distributed processing network, including by
using any of the following components:
••

High-speed switch and cables: A 100Base-T or Gigabit Ethernet switch and compatible cables
can be used to allow your data to move over the LAN at maximum speed.

••

Multiple clients: Multiple client computers can use the services of the same cluster. Additionally,
you can have multiple client applications on the same client computer, with each client
application using the same cluster.

••

Multiple clusters: Depending on how extensive your network is and how many clients it
needs to serve, you may want to divide up available computers and create more than one
cluster to serve various clients. (Users select the cluster they want to send a batch to when
they submit the batch.)
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••

Multiple service nodes: In general, more service nodes mean more processing power. If your
workflow is mainly I/O bound, configure the number of services so that reads and writes do
not exceed your network and storage capabilities. For CPU-bound workflows, set the number
of services so that all available resources on the machine will be used. If the computing load,
per job, is closer to the network load, having a smaller number of service nodes per cluster
may be more efficient. If you’re using the Apple Qmaster distributed processing system with
an application other than Shake or Compressor, consult the application’s user manual for
information about how to optimize the number of service nodes.

••

Storage device: A storage device, such as a remote disk or group of disk arrays, can be used as
cluster scratch storage, which is a place for short-term storage of temporary data generated by
the cluster controller, clients, and service nodes. (You set the scratch storage location in the
Apple Qmaster Sharing window of Compressor. For more information, see Advanced pane
of the Apple Qmaster Sharing window on page 254 and Use cluster storage on page 232.)
Alternatively, a storage area network (for example, Xsan) can be used as a final destination for
the files after they’re processed.

To maximize your resources, consider using some computers for more than one distributed
processing function:
••

Service node and cluster controller: In a small setup, one of the service nodes in a cluster can
also act as the cluster controller so that it performs both functions. However, in a cluster of
many service nodes, the processing load required for the cluster controller may be so high
that it becomes inefficient to use one computer as both a service node and a cluster controller.

••

Client computer and cluster controller or service node: You can also set up a client computer to
act as a cluster controller or service node in a cluster. However, keep in mind that the more
available processing power a computer has, the faster it can manage or process jobs.

How the Apple Qmaster system distributes batches
The cluster controller determines the most efficient use of the cluster resources based on the
availability of each service node and by the types of jobs in the batch. Certain jobs can be
segmented; others cannot.
••

If the job can be subdivided into data segments: Each segment is processed in parallel on the
service nodes in the cluster. For example, for a render batch, the cluster controller can divide
the jobs into groups (segments).

••

If the batch can be subdivided into tasks: Different tasks are run on different service nodes. For
example, for a render batch, the cluster controller can subdivide the rendering work into
different processing tasks.
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Rather than actually moving segments, Apple Qmaster tells the service nodes which segments
to read via the network, where to find them, and what to do with them. Below is an example of
how one batch might be processed in an Apple Qmaster system.
Batch submitted by
Compressor or
Apple Qmaster (job request
for frames 1–30)

Cluster controller
divides and distributes
job to available
service nodes

Instructions specifying
locations of source files
and frames 01–10

Instructions specifying
locations of source files
and frames 11–20

Instructions specifying
locations of source files
and frames 21–30

Service node 1

Service node 2

Service node 3

Processed file (frames 1–30)
placed in specified
destination

In distributing batches, Apple Qmaster uses the technology built in to OS X to locate services in
a cluster on the same IP subnet and to dynamically share and receive information. Because the
computers can continually transmit their current processing availability status, Apple Qmaster
can distribute the workload evenly across the cluster.

Create service nodes and cluster controllers
Creating service nodes and cluster controllers overview
Once your network is set up and you have installed the necessary components, you are ready
to create your distributed processing system. There are three ways you can set up a distributed
processing system:
••

Use This Computer Plus: The This Computer Plus option in Apple Qmaster is the easiest
approach you can take to creating a distributed processing system. You simply install
Compressor on any computers you want to perform processing duties, and then configure
the computers as service nodes. For more information, see Quickly set up a service node using
This Computer Plus on page 223.

••

Create a QuickCluster: You can create a QuickCluster in Apple Qmaster, configuring a single
computer to be a cluster by choosing the number of instances it supports, based on the
number of cores available. For more information, see Set up a cluster controller using
QuickClusters on page 224.

••

Manually create a cluster using Apple Qadministrator: Large installations can manually create
managed clusters to be used by their clients. For more information, see Create and modify a
cluster on page 258.
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Quickly set up a service node using This Computer Plus
Using This Computer Plus gives you an easy way to take advantage of the distributed processing
capabilities offered by Apple Qmaster without requiring a lot of knowledge about how clusters
are configured, how to set up file sharing, and so on.
Note:  Before following the steps below, confirm that each computer you configure is using the
same versions of Compressor, QuickTime, and OS X.
Set up a computer as a service node using This Computer Plus
1 In Compressor, choose Apple Qmaster > Share This Computer.
The Apple Qmaster Sharing window appears.

2 In the Setup pane, select “Share this computer” and “as Services only.”
3 Select Compressor in the Services area, and make sure that “Require these services to only be
used in managed clusters” is not selected.
4 Click OK.
If you’re making changes to existing settings and this computer is already providing processing
services, clicking OK immediately resets this computer’s services. If this computer is also the
cluster controller, any current jobs are terminated.
This computer is now available for Compressor to use as an unmanaged service node.
For information about processing a batch using This Computer Plus, see Submit a batch of files
from Compressor on page 237.
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Set up a cluster controller using QuickClusters
QuickClusters offer a simple and automated way to create and configure clusters, as well
as an alternative to creating and configuring clusters manually with Apple Qadministrator.
QuickClusters with enabled unmanaged services automatically configure themselves and use
any available unmanaged services on the same local network (subnet). QuickClusters listen for
unmanaged service advertisements and may mark or remember any of them for later use.
The Apple Qmaster distributed processing system has default settings that allow you to use
distributed processing immediately.
Note:  Before following the steps below, confirm that the cluster controller computer and all the
service node computers are using the same versions of Compressor, QuickTime, and OS X.
Stage 1: Set up the cluster controller
Follow these steps on the cluster controller computer and for each of the service node computers.
1 In Compressor, choose Apple Qmaster > Share This Computer.
The Apple Qmaster Sharing window appears.

2 In the Setup pane, select “Share this computer.”
All other settings in this window should be correct by default:
••

The “as QuickCluster with services” option should be selected.

••

Compressor should be selected.

••

“Require these services to only be used in managed clusters” should not be selected.

••

A default name for this QuickCluster appears in the “Identify this QuickCluster as” text area.

••

“Include unmanaged services from other computers” should be selected.

••

“Require password” should not be selected.

For more information about these settings, see Setup pane of the Apple Qmaster Sharing
window on page 253.
3 Click OK.
Important:  If you’re making changes to existing settings and this computer is already providing
processing services, clicking OK immediately resets this computer’s services. If this computer is
also the cluster controller, any current jobs are terminated.
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A QuickCluster is created with this computer as its controller and one instance of processing
services. For information about multiple service instances, see Use virtual clusters to make the
most of multicore computers on page 230.
Stage 2: Add a service node computer to a cluster
1 In Compressor, choose Apple Qmaster > Share This Computer.
The Apple Qmaster Sharing window appears.
2 In the Setup pane, select “Share this computer” and “as Services only.”

All other settings in this window should be correct by default:
••

Rendering and Compressor should both be selected.

••

“Require these services to only be used in managed clusters” should not be selected.

••

All other settings are not available.

For more information about these settings, see Setup pane of the Apple Qmaster Sharing
window on page 253.
3 Click OK.
This creates a service node that will automatically process jobs submitted to the QuickCluster
you set up in the previous task.
For information about processing a batch using the cluster you created, see Batch processing
overview on page 236.

Advanced service node and cluster controller information
Use nodes without Compressor installed
You can create a cluster containing one or more computers that don’t have Compressor installed.
To do this, you configure an intermediary service node that executes Apple Qmaster commands
using SSH on other computers. These are called extended nodes.
If all the nodes in the cluster will be extended nodes, the cluster needs one intermediary
node that also acts as the cluster controller. If you’re creating a cluster that contains only an
intermediary node and extended nodes, you can do all the setup in the Apple Qmaster Sharing
window in Compressor, without using Apple Qadministrator.
However, if you want a cluster that contains both regular service nodes and extended nodes,
configure an intermediary node and then add it to a regular cluster that already has a cluster
controller. (There can be only one cluster controller per cluster.)
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Configure an intermediary service node to run Apple Qmaster commands on extended nodes
Before you begin, be sure that the computer that will be the intermediary service node has
Compressor installed and that the computers that will be the extended nodes have a UNIXbased operating system and have SSH enabled.
1 In Compressor, choose Apple Qmaster > Share This Computer.
If this intermediary node will be part of a mixed cluster, with a different computer acting as the
cluster controller, skip to step 5. If you want this intermediary node to be the cluster controller for
this cluster, do steps 2, 3, and 4.
2 In the Apple Qmaster Sharing window, select “Share this computer” and select either the "as
QuickCluster with services” or the “as Services and cluster controller” option.
3 Enter a name in the “Identify this QuickCluster as” field. This is the name that will be shown in
the Cluster list in Apple Qadministrator and in the cluster pop-up menus in Share Monitor and
Apple Qmaster.

4 Select the Rendering and “Require these services to only be used in managed clusters” checkboxes.

5 Click the Options button next to the Rendering item.
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6 In the dialog that appears, add an instance for each extended node you want this intermediary
node to send commands to by doing the following:
a Choose SSH from the Add (+) pop-up menu.
b Edit the Host name, Username, and (if applicable) Password columns so that they describe
each computer you want to use as an extended node, and click OK.

Edit the Host name,
Username, and
Password columns
to specify the extended
nodes you’re adding.

7 In the Apple Qmaster Sharing window, click OK.
Note:  If you’re making changes to existing settings and this computer is already providing
processing services, a window appears warning you that its services must be restarted for the
changes to take effect. You can delay the restart by entering the number of minutes to wait,
which gives you time to warn others or for current batches to finish processing.
If you configured this intermediary node as the cluster controller, your work is done and
the extended node cluster is ready to start receiving and processing batches submitted by
Apple Qmaster.
If, instead, you want the extended nodes to be part of a cluster that includes regular service
nodes, use Apple Qadministrator to add this intermediary node to that cluster. You add an
intermediary node in the same way you add other service nodes. For more information, see
Creating service nodes and cluster controllers overview on page 222.
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Enable managed and unmanaged services
When you configure processing services, you can choose to make them either managed services
or unmanaged services (the default).
Managed services can be assigned to serve one particular cluster controller. Once assigned,
managed services remain exclusively dedicated to that cluster until they’re removed with Apple
Qadministrator. QuickClusters can’t use managed services from other nodes, except in the case of
extended node clusters.
Unmanaged services automatically assign themselves to the first available This Computer Plus
cluster or QuickCluster with enabled unmanaged service support. QuickClusters listen for
unmanaged service advertisements and may mark or remember any of them for later use. An
unmanaged service remains dedicated to its This Computer Plus cluster or QuickCluster only
long enough to finish the current job. Once the current job is complete, an unmanaged service
is once again a “free agent” and advertises its availability to all This Computer Plus clusters
and QuickClusters.
Note:  Managed clusters (those created with Apple Qadministrator) can also use unmanaged
services. When unmanaged service support is enabled on a managed cluster, the cluster
automatically adds any available unmanaged services in addition to its managed services
(that were explicitly added using Apple Qadministrator). Once the current job is complete, an
unmanaged service is once again a “free agent” and advertises its availability to all This Computer
Plus clusters and QuickClusters.
Enable unmanaged services for use with This Computer Plus
You enable unmanaged services after submitting a batch from Compressor.
1 Select a batch in the batch window, and click the Submit button.
2 In the dialog that appears, select the This Computer Plus checkbox.
For more information about submitting a batch, see Submit a batch on page 147.
Enable unmanaged services on QuickClusters
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 To create a QuickCluster, select “Share this computer” and “as QuickCluster with services.”
3 Select “Include unmanaged services from other computers.”

4 Click OK.
For more information about creating QuickClusters, see Set up a cluster controller using
QuickClusters on page 224.
Enable unmanaged services on managed clusters
1 In Apple Qadministrator, select a cluster in the Cluster list, or click the Add (+) button to add a
new cluster.
2 Select “Allow use of unmanaged services.”
For more information about creating managed clusters, see Create and modify a cluster on
page 258.
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Set managed processing services
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 Do one of the following:
••

To use this computer only in managed clusters: Select “Require these services to only be used in
managed clusters.”

••

To use this computer in unmanaged as well as managed clusters: Deselect “Require these services
to only be used in managed clusters.”

3 Click OK.
Important:  If you’re making changes to existing settings and this computer is already providing
processing services, clicking OK immediately resets this computer’s services. If this computer is
also the cluster controller, any current jobs are terminated.
Turn off processing services
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 In the Services section, do one of the following:
••

To turn off Compressor services: Deselect the Compressor checkbox.

••

To turn off Apple Qmaster services: Deselect the Rendering checkbox.

3 Click OK.

Schedule service availability
If you enabled unmanaged services, you can open a calendar dialog and schedule the availability
of these services to the distributed processing system.
Customize service availability
1 Choose Apple Qmaster > Share This Computer, select the Advanced Service Settings area of the
Advanced pane, and click Set.
The Service Schedule dialog appears.

2 To constrain the availability of unmanaged services for each day of the week, choose an option
from the pop-up menu for each day:
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••

On: This setting indicates that the services are available for all 24 hours of that particular day.
(This is the default setting for all seven days of the week.)

••

Off: Makes the service unavailable on that day of the week.

••

On Between: Allows you to enter the period of time the service will be available.

••

Off Between: Allows you to enter the period of time the service will not be available.

3 Enter any constraining time periods in the appropriate start time and end time fields.
Note:  You must enter valid days and times. The time cannot overlap into the next day in one entry.
There must be two entries when the range ends after 12 a.m. For example, if you want service
availability from Sunday night to Monday morning, you could set up the Sunday schedule to be on
between 6:00 a.m. and 12:00 a.m. and to be on for Monday between 12:00 a.m. and 8:00 a.m.
4 To save the settings, click OK.
5 To apply the changes to this computer, click OK.
Important:  If you’re making changes to existing settings and this computer is already providing
processing services, clicking OK immediately resets this computer’s services. If this computer is
also the cluster controller, any current jobs are terminated.

Use virtual clusters to make the most of multicore computers
You can adjust the number of instances of a processing service, essentially creating virtual
clusters on individual computers. For processor-intensive work, having multiple instances may
increase speed and efficiency, depending on the processing application. Too many instances,
however, may actually decrease speed and efficiency.
A general rule for choosing the number of instances is to allow 2 GB of memory for each
instance. If you have a computer with 8 GB of memory that offers eight instances in the pop-up
menu, choosing four instances should provide good results. This number can vary widely though,
depending on whether that computer is also being used for other duties.
Note:  By default, the Apple Qmaster system creates one rendering service instance for each
processor. Rendering services are for Shake (with Apple Qmaster), Autodesk Maya, and other
UNIX command-line programs, as opposed to Compressor services, which are solely for
Compressor distributed processing. Consult the documentation that came with the application
to see if using each processor individually is ideal.
Change the number of instances of processing services on a computer
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 Select Compressor or Rendering in the Services section, and then click its Options button.
3 In the dialog that appears, choose the number of instances from the pop-up menu, and click OK.
Choose the number
of instances from
the pop-up menu.

4 Click OK in the Apple Qmaster Sharing window.
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Turn cluster controller services on or off
You can easily turn a specific computer’s cluster controller services on or off.
Turn on cluster controller services
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 Select the “Share this computer” checkbox and do one of the following:
••

To create an “instant” cluster with unmanaged services: Select “as QuickCluster with services.”

••

To build a cluster in Apple Qadministrator: Select “as Services and cluster controller.”
For more information, see Create and modify a cluster on page 258 and Enable managed and
unmanaged services on page 228.

3 In the Services area, select Rendering or Compressor, or both.
4 Click OK.
The cluster is enabled, making this computer a cluster controller.
Turn off cluster controller services
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 Deselect the “Share this computer” checkbox and click OK.
Important:  If you’re making changes to existing settings and this computer is already providing
processing services, clicking OK immediately resets this computer’s services. If this computer is
also the cluster controller, any current jobs are terminated.
Note:  You can instead turn off the controller and just make the node a service node. To do this,
select “as Services only” in the “Share this computer” section.

Set a service password for including a computer in a cluster
If you want to control who is able to include a specific service node or cluster controller in a
cluster, you can create a password called a service password for the computer.
••

If you set up a QuickCluster: Other users will be required to enter this password before
submitting requests to this computer.

••

If you set up a cluster to use with Apple Qadministrator: An administrator will be required to
enter this password before adding this computer to a cluster.

••

If you configure the computer as both a cluster controller and a service node: One password is
used for both users and administrators.

Note:  A service password can be stored in a user’s keychain.
Set or change a service password
1 On the computer designated as the service node or cluster controller, open Compressor and
choose Apple Qmaster > Share This Computer.
2 Do one of the following:
••

To require a password: Select Require password.

••

To change an existing password: Click Change Password.
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3 In the dialog that appears, enter and verify a password, and click OK.

4 To apply this change, click OK in the Apple Qmaster Sharing window.
Important:  If you’re making changes to existing settings and this computer is already providing
processing services, clicking OK immediately resets this computer’s services. If this computer is
also the cluster controller, any current jobs are terminated.

Use cluster storage
By default, the Apple Qmaster distributed processing system saves temporary process files in the
following location on the cluster controller: /Users/username/Library/Application Support/Apple
Qmaster/Storage/. You can also choose any other location on a local disk for this scratch storage.
Computers in the cluster will access this location as needed.
Note:  If you submit a reference movie for distributed processing, the Apple Qmaster distributed
processing system automatically copies the appropriate media files to the processing cluster
by either manually mounting the network storage on all of the cluster’s nodes, or by using
shared storage on all the nodes (for example, Xsan). For best performance, you can avoid this file
transfer step by making sure that the media files specified in the reference movie are available
to each node of the Apple Qmaster cluster. Compressor users can change this behavior by
adjusting cluster options in Compressor preferences. For more information, see Set Compressor
preferences on page 211.
If you’re processing large source media files that exceed the available storage space on the
startup disk, you may run out of storage space on that disk. There are a number of things you can
do to address this:
••

Change the cluster storage location to a disk with more free space.

••

Configure cluster storage settings to delete files more frequently.

••

Set Cluster Options preferences in Compressor to “Never copy source to cluster.”

You can also define which ports Apple Qmaster uses for service advertisements.
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Change cluster storage settings
1 On the cluster controller, open Compressor and choose Apple Qmaster > Share This Computer.
2 To open the Advanced pane, click Advanced.
3 Do any of the following:
••

To change the cluster storage location: Click the “Storage location” Set button, navigate to the
folder in the dialog, and click Choose.
Note:  If you’re using the default This Computer setting in the Cluster pop-up menu in the
Compressor Batch window and you choose Cluster Storage as the destination, the output file
is copied to the Source location. Otherwise, This Computer doesn’t use cluster storage.

••

To change how often cluster storage files are deleted: Enter a new number in the “Delete files
older than N Days” field.

Enter a new number to
change how often cluster
storage files are deleted.
Click Set to open
a dialog for choosing
a new storage folder.

4 To apply the changes, click OK.
Important:  If you are making changes to existing settings and this computer is already providing
processing services, clicking OK immediately resets this computer’s services. If this computer is
also the cluster controller, any current jobs are terminated.
If you are using cluster storage and an error occurs, partial files may be left on the designated
cluster storage location. Check the designated cluster storage location to make sure no partial
media files are left there. If you find partial media files, delete them and submit the job again.
Define ports for Apple Qmaster service advertisements
1 In Compressor, choose Apple Qmaster > Share This Computer.
2 To open the Advanced pane, click Advanced.
3 Select Enable Port Range From, and set the start of the range by entering any integer value
between 50,000 and 65,535.
4 In the “Number of ports” field, enter the size of the range, such as 1000.
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Rendering services and shared storage setup
Here are some tips for setting up an Apple Qmaster “render farm.”
Change the number of rendering service instances
By default, Apple Qmaster enables one rendering service per core. On a dual-core system, you’ll
have two rendering services enabled by default. That means, for example, that two copies
of Shake will be running at the same time on a dual-core system. You may need to disable a
rendering service. For more information about changing the number of rendering services, see
Creating service nodes and cluster controllers overview on page 222.
Note:  If you’re using Shake, you can always change the number of processors Shake uses at
submission time by using -cpus x, where x is the number of threads to use.
Set up shared volumes
For all the nodes in the cluster to know where to find assets needed for any given batch,
the nodes must have a common volume to work from. There are many ways to set up file
sharing. For more information, see the OS X documentation about file sharing and the OS X
Server documentation.

Use distributed processing with Shake
Follow the instructions below to set up distributed processing to use with Shake.
Stage 1: Turn off the UNC setting
To make sharing and volume mounting work smoothly in this setup, you need to turn off the
Shake UNC setting on each computer. The UNC setting uses the entire file pathname, with the
network address, in a convention that starts with //ComputerName/DriveName/path. You don’t
want Shake to use this filenaming convention because it conflicts with the file sharing and
volume mounting used in this setup.
Note:  All the media volumes should have the same name.
In the three steps below, you make this change in a Shake startup .h file. As described in the
Shake documentation, the startup .h files, located in the startup directory, are used to customize
Shake settings (similar to setting preferences).
1 Log in as the user who will use Shake on the computer.
2 Double-click the Terminal icon in /Applications/Utilities/ to open a Terminal window.
3 Enter these two command lines in the Terminal window, pressing Return after each command line:
mkdir -p ~/nreal/include/startup/
echo 'script.uncFileNames = 0;' > ~/nreal/include/startup/UNC_off.h

To complete the process, repeat steps 1 to 3 on the other computer.
Stage 2: Turn on file sharing
mm Turn on file sharing for each computer in the cluster.
For more information, see the OS X documentation.
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Stage 3: Mount the media storage volumes
Follow the instructions below so that all the computers in the cluster are mounting all the media
volumes in the cluster.
1 On each computer, log in as the administrator.
(The first user account you create when you set up OS X is an administrator account.)
2 On each computer in the group, use the Connect to Server command from the Finder’s Go menu
to mount each media volume.
3 Enter another computer’s name in the Connect to Server dialog and click Connect.
4 Choose the associated media volume as the volume you want to mount.
5 Repeat steps 1 through 4 until all the computers are mounting all the media volumes in the cluster.
After you finish the three tasks above, each one of these computers can be used to submit jobs
for distributed processing. Because of the way access has been configured, all file pathnames are
conveniently consistent and simple for the purposes of specifying them in Compressor, in Shake
scripts, and in Apple Qmaster, assuming that:
••

Users place the source media on a mounted media volume.

••

Users place the Shake scripts on a mounted media volume.

••

All folders and files on the shared media volumes have read-and-write access enabled for
everyone (for Owner, Group, and Others). You can configure this access setting by selecting the
folder or file and choosing File > Get Info.

These three assumptions are important because they ensure that all the computers have readand-write access to all the source files and output destinations.

Recovery and failure notifications
The Apple Qmaster distributed processing system has a number of built-in features designed to
attempt recovery if there’s a problem and to notify you when the system attempts a recovery.
Recovery features
The recovery actions described next occur automatically if failures occur in the Apple Qmaster
distributed processing system. There’s no need for you, as the administrator, to enable or
configure these features.
••

If a service stops unexpectedly: If either the cluster controller service or the processing enabled
on a service node stops unexpectedly, the Apple Qmaster distributed processing system
restarts the service. To avoid the risk of endless stopping and restarting, the system restarts the
failed service a maximum of four times. The first two times, it restarts the service right away. If
the service stops abruptly a third or fourth time, the system restarts the service only if it had
been running for at least 10 seconds before it stopped.

••

If a batch is interrupted: When a service stops suddenly while in the middle of processing an
Apple Qmaster batch, the cluster controller resubmits the interrupted batch in a way that
prevents the reprocessing of any batch segments that were complete before the service
stopped. The cluster controller delays resuming the batch for about a minute from the time it
loses contact with the service.

••

If a batch fails: When the service is running, but one batch fails to process, a service exception
occurs. When this happens, the cluster controller resubmits the batch immediately. The
cluster controller resubmits the batch a maximum of two times. If the job fails on the third
submission, the distributed processing system stops resubmitting the job. In Share Monitor,
the job’s status is set to Failed.
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Failure notifications
There are two ways that the Apple Qmaster distributed processing system can provide
information about a problem.
••

Email notification: When a processing service stops unexpectedly, Apple Qmaster sends
a notification email to the address that was entered in the Apple Qadministrator Cluster
Preferences dialog for that cluster. If no address was entered there, the email is sent to the
address in the Internet settings of the computer on which the cluster controller is enabled.
Note:  Apple Qmaster does not support SMTP servers that require authentication.

••

Log files for individual jobs or batches: If a particular job or batch fails, a log file is generated that
describes this failure. You can find the name and location of this log file in Share Monitor by
selecting the batch or job, clicking the Show Info button, and clicking the Show Log button.
For more information, see Share Monitor Help.

Notification and log labels
The following table lists the service labels used in the email notifications and logs.
Processing service type

Notification label

Local Compressor service

servicecontroller:com.apple.stomp.transcoder

Distributed Compressor service

servicecontroller:com.apple.stomp.transcoderx

Distributed Apple Qmaster service

servicecontroller:com.apple.qmaster.executor

Process a batch
Batch processing overview
Client computer users can submit batches for processing using either Compressor or Apple Qmaster.

Batch

Batch

Cluster A

Use Compressor to submit
a batch to a cluster

Use Apple Qmaster to submit
a batch to a cluster

Batch

Batch
Network

Cluster B
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When using Compressor to submit a batch of files, you can use the Cluster pop-up menu in
the Batch window to choose a cluster to process the batch. For more information, see Submit a
batch of files from Compressor on page 237.
You can use Apple Qmaster to submit a batch of Shake or Maya files, or use the Generic Render
command to render a batch of projects from other frame-based rendering applications (such as
After Effects and LightWave).
••

For Shake: Install a copy of Shake on every node in the cluster. For command-line rendering
on OS X, a license is not needed. You also must install any third-party plug-ins, fonts, and so
on, that your projects require on each node in the cluster. For more information, see Submit a
batch of Shake files using Apple Qmaster on page 238.

••

For Maya: Install and license a copy of Maya for every node in the cluster. You also must install
any third-party plug-ins, fonts, and so on, that your projects require on each node in the cluster.
For more information, see Submit a batch of Maya files using Apple Qmaster on page 240.

••

For After Effects: Install a copy of After Effects 6.5 or later on every node in the cluster. You also
must install aerender, the command-line renderer for After Effects. After Effects requires a
product key and serial number before installation. For more information, see Submit a batch of
files using the Generic Render command in Apple Qmaster on page 242.

••

For other frame-based rendering applications: Install a copy of the rendering application on
every node in the cluster. Also install any third-party plug-ins, fonts, and so on, that your
projects require on each node in the cluster. For more information, see Submit a batch of files
using the Generic Render command in Apple Qmaster on page 242.

For all command-line frame-rendering applications, including Shake, make sure that the paths
in your project files can be accessed by all nodes in the cluster. For example, in Shake, these two
items are required:
••

Specify the media file locations in Shake scripts: As you follow the steps in Submit a batch of
Shake files using Apple Qmaster on page 238, all the Shake render scripts should specify
their source media (File In) locations and output (File Out) destinations as /Volumes/
MediaDiskName/ (for example, /Volumes/Media3/).

••

Specify Shake script locations in Apple Qmaster: As you follow the steps in Submit a batch of
Shake files using Apple Qmaster on page 238, all the Shake script locations should be specified
in Apple Qmaster as /Volumes/MediaDiskName/ScriptFilename (for example, /Volumes/
Media3/Script.shk).

Submit a batch of files from Compressor
Submit a batch of files for distributed processing from Compressor
1 In Compressor, click Submit.
2 In the dialog that appears, do one of the following:
••

To submit to This Computer Plus: Choose This Computer from the Cluster pop-up menu, and
select This Computer Plus.

••

To submit to a cluster: Choose the appropriate cluster from the Cluster pop-up menu.

Note:  For information about the other options in the submit dialog, see Submit a batch on page 147.
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3 Click Submit.
Compressor and Apple Qmaster coordinate the distribution of the processing tasks between
the available computers and deposit the resulting output files at the location or locations you
designated in Compressor.
You can view the status of the batch in the Share Monitor window. For more information about
Share Monitor, see Share Monitor Help.

Submit a batch of Shake files using Apple Qmaster
Apple Qmaster includes a plug-in for Shake that automates and customizes the process by which
Shake batches are submitted with Apple Qmaster. Because of this, the process for submitting
Shake batches is more automated than the process for submitting batches for applications that
don’t have such plug-ins.
The plug-ins automatically set some default parameters for the job. They also provide a dialog for
you to adjust these parameters to your needs and to add more command-line options to each job.
For more information, see Shake plug-in dialog on page 245.
Note:  You can also submit Shake batches as described in Use Apple Qmaster to submit UNIX
commands on page 247, but the following method is the easiest way to submit Shake batches
with Apple Qmaster.
Submit a batch of Shake files
1 In Compressor, choose Apple Qmaster > Create Rendering Jobs.
Apple Qmaster opens.
2 To name your batch, enter a name in the “Batch name” field.
Naming your batch helps you easily locate it in Share Monitor.
3 Choose Shake from the Command pop-up menu, and click the Add (+) button.
The Shake window appears.
Note:  You can also drag the Shake file to the Batch table (the middle area of the Apple
Qmaster window).
4 In the Script field, enter the location of the Shake file if it isn’t already shown.
If you dragged the file to the window, the file location is already there.
Note:  The Shake field shows the default location of Shake on your computer. If it’s not correct, be
sure to update it.
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5 If you want, edit the available values and settings to customize the command.
Each setting corresponds to a commonly used Shake command, with the exception of the
Minimum setting. For more information, see Shake plug-in dialog on page 245 and the
Shake documentation.

Except for Minimum,
each setting corresponds
to a commonly used Shake
command or option.

6 If you want, add other command-line options to the Options field.
You can further customize the
batch instructions by adding
command-line options here.

The full command
is displayed here.

7 Click OK.
The Shake job appears in the window.

The job appears
in the window.
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8 To add more jobs to this batch, repeat steps 3 through 7.
9 To make changes to the batch before submitting, do either of the following:
••

To edit a command in the list: Double-click the job and make changes in the dialog that appears.

••

To remove a job from this batch (before you submit the batch): Select the job, and click the
Remove (–) button.

10 To set options for this batch, specify the following settings:
••

Submit To: Choose a cluster to process this batch.

••

Working Directory: If relevant, enter the working directory (from which you want the command
to be executed).

••

Priority: Choose the priority level from the pop-up menu. The higher the priority, the sooner
and faster this batch will be processed relative to other batches.

••

Delay: Specify how long you would like the system to wait before processing this batch.

11 To submit the batch for processing, click Submit.
Any output files for the batch are placed in the destination specified in the script file or command.
Note:  If you’re using Apple Qmaster to render Shake jobs as QuickTime movie output, every
service node in the Apple Qmaster cluster must have OS X v10.6 or later.
The Apple Qmaster window includes additional features that you can use while creating jobs.
For example, you can duplicate jobs, saving a copy of a batch, and view a history of batch
submissions. For more information, including the location of the buttons mentioned below, see
Apple Qmaster window on page 250.
If you want to save a copy of a batch you created with Apple Qmaster, in case you need to
resubmit it, choose File > Save As.
For more information about using Shake in a distributed processing system, see Use distributed
processing with Shake on page 234 and Rendering services and shared storage setup on page 234.

Submit a batch of Maya files using Apple Qmaster
Using Apple Qmaster, you can quickly create and submit a batch of Maya jobs.
Most Maya assets are contained in the project directory. If your project uses external files, you’ll
need to relink them when the project is moved to the shared volume.
It may be necessary to retarget your assets once you move your project to the shared volume.
This varies depending on the types of files and plug-ins used. If you’ll hand off this project to
a cluster administrator, you should save the file in Maya ASCII (.ma) as well. This way, it can be
edited to fix path problems without advanced knowledge of using Maya.
There’s a dialog in Apple Qmaster that is used for specifying commands for the distributed
processing of Maya files. The settings in the Maya plug-in dialog correspond to a commonly used
Maya command or option.
Important:  If an option in the Maya plug-in window is not supported in the version of Maya
that you are using, that option will not work in Qmaster. To get more information, see the
Maya documentation.
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Submit a batch of Maya files
1 In Compressor, choose Apple Qmaster > Create Rendering Jobs.
Apple Qmaster opens.
2 In the Apple Qmaster window, enter a name for the batch in the “Batch name” field. (This is the
name that appears in Share Monitor after you submit the batch.)
3 Choose Maya from the Command pop-up menu, and click the Add (+) button.
Note:  You can also drag the Maya file to the Batch table (the middle area of the Apple
Qmaster window).
4 In the dialog that appears, do one of the following:
••

Verify that the Maya field displays the default location for the Maya application.

••

Use the Choose buttons to navigate to and choose the location of the Maya project and scene
files for this job.

••

In the Frames section, enter a start and end frame for the job.

••

Type additional command options in the Options field.

The full command
is displayed here.

The available settings correspond to commonly used Maya command options. You can also
type additional command options in the Options field. For more information about the Maya
command seetings, see the Maya documentation.
5 When you’ve finished creating the full command, click OK.
6 To add more jobs to this batch, repeat steps 3 through 5.
7 To set options for this batch, specify the following settings:
••

Submit To: Choose a cluster to process this batch.

••

Working Directory: If relevant, enter the working directory (from which you want the command
to be executed) in the Working Directory column.

••

Priority: Choose the priority level from the pop-up menu. The higher the priority, the sooner
and faster this batch will be processed relative to other batches.
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8 To submit the batch for processing, click Submit.
Important:  By default, Apple Qmaster ignores Maya error messages. You can view errors in
Share Monitor. If you use Maya plug-ins, you can change this by removing or renaming Users/
username/Library/Application\ Support/Apple\ Qmaster/MayaCommandPlugin.commandPlugin/
Contents/Resources/mayascript. Advanced users can customize MayaScript to suit their
environment and workflow.
Any output files for the batch are placed in the destination specified in the script file or command.

Submit a batch of files using the Generic Render command in Apple Qmaster
You can use the Generic Render command in Apple Qmaster for the distributed processing of
projects from other frame-based rendering applications (such as After Effects and LightWave).
The plug-in dialog allows you to adjust parameters and add more command-line options to each
job. For more information, see Generic Render dialog on page 246.
Submit a batch of files for processing using the Generic Render command
1 In Compressor, choose Apple Qmaster > Create Rendering Jobs.
2 In the Apple Qmaster window, enter a name for the batch in the “Batch name” field.
(This is the name that appears in Share Monitor after you submit the batch.)
3 Choose Generic Render from the Command pop-up menu, and click the Add (+) button.
Note:  You can also drag the file to the Batch table (the middle area of the Apple Qmaster window).
The Generic Render dialog appears.

The full command
is displayed here.

4 Verify that the location of the frame-based rendering application in the Executable field
is correct.
5 If needed for your rendering application, define the Input and Item settings.
6 In the Frames section, enter a start and end frame for the job.
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7 In the Command Template section, do one of the following:
••

Use the Default Template as is, or adjust it by adding command elements from the
pop-up menu.

••

To create an additional template, click the Add (+) button and adjust by adding command
elements from the pop-up menu.

••

To change the order of the command elements, drag them left or right.

Note:  The “Treat non-zero exit status as failure” checkbox in the Generic Render dialog allows
you to use Apple Qmaster with rendering applications that return nonzero results that are not
intended to indicate failure. By default, this checkbox is selected. If your rendering application
issues nonzero results that are not intended to indicate failure, deselect the checkbox.
8 If necessary, add command-line instructions in the Options field.
Any text entered here is appended at the end of the command.
9 Verify the full command in the Command field.
You can further customize the
batch instructions by adding
command-line options here.

The full command
is displayed here.

10 Click OK.
11 To add more jobs to this batch, repeat steps 3 through 10.
12 To set options for this batch, specify the following settings:
••

Submit To: Choose a cluster to process this batch.

••

Working Directory: If relevant, enter the working directory (from which you want the command
to be executed) in the Working Directory column.

••

Priority: Choose the priority level from the pop-up menu. The higher the priority, the sooner
and faster this batch will be processed relative to other batches.

13 To submit the batch for processing, click Submit.
Important:  If you output from the Generic Render plug-in to single files containing all the
frames, such as a QuickTime movie, all the nodes of a cluster may try to write to the same file
at the same time. To avoid this problem, choose a different output file format or use a different
render command.
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Advanced rendering information
Set environment variables in Apple Qmaster
Environment variables are settings within a shell, from which commands are issued that affect the
way a program operates. People who regularly execute commands from a Terminal shell, or write
shell scripts, are usually familiar with environment variables.
For example, the environment variable called PATH tells the shell where to look for commands
that are entered. The PATH that is specified becomes the search path that’s used when locating
a program. It’s set for you automatically, but you’ll want to add to it. For instance, if your user
name is “jane” and there is a directory named “groupbin” (in your home directory) that contains
programs you want to run from a shell, the environment variable name would be PATH and the
value of that name would be ~jane/groupbin.
You may want to set or change an environment variable for submitting certain jobs. When you
set an environment variable within Apple Qmaster, the new setting takes effect immediately. This
gives you an easy way to do things such as setting common directory paths or plug-in-specific
environment variables for Apple Qmaster jobs. Additionally, you can streamline your workflow
with environment variables and preflight scripts that you can run on each node of a cluster prior to
actually processing the batch. Preflight scripts are sent with every distributed segment of a job.
Add or remove an environment variable in Apple Qmaster
1 Select the command for which you want to set an environment variable.
2 Click the Set Environment button.
3 Add a preflight script and environment variable by doing one of the following:

Click the Add (+) button,
then enter a variable
name and value.
••

To add a variable: Click the Add (+) button, and select and edit Untitled Variable in both the
Name and Value columns.

••

To remove a variable: Select it, and click the Remove (–) button.

4 Click OK.
Your environment variables take effect immediately, and are retained only for the selected command.
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Manage Shake media files on a shared volume
It may be necessary to relink your Shake assets once you move your project to the shared
volume. This varies depending on the types of files, plug-ins, fonts, and environmental
requirements. Things that commonly need to be changed are the FileIn and FileOut paths, and
env variables such as NR_INCLUDE_PATH and NR_FONT_PATH. UNC should be disabled, as these
paths are typically not resolvable to nodes in the cluster when arbitrary host names are used.
Disable UNC and enable Apple Qmaster from within the Shake application
1 Go to: ~/nreal/include/startup
2 Create a file called: qmaster.h
3 Add the following:
script.uncFileNames = 0;
sys.useRenderQueue = "Qmaster";

4 Press Return several times after the last line.
5 Save your work.

Shake plug-in dialog
The Shake Plug-in dialog contains the following settings.

Except for Minimum,
each setting corresponds
to a commonly used Shake
command or option.

••

Shake field: This field shows the location of the Shake application on your computer.

••

Script field: This field shows the location of the Shake project file. (You can also select the field
and then drag the file to the Script field to have the file location entered automatically.)

••

Ignore script failures: This checkbox allows you to determine whether Apple Qmaster should
continue rendering all the frames of the script in the event that Shake returns a nonzero exit
status. By default, this checkbox is not selected.

••

Frames (Start, End, Steps): These fields set the start and end frame for the job.

••

Frames (Minimum): You can change the value in the Minimum field to change the minimum
number of frames in each Apple Qmaster segment. For example, with a minimum value of 10
(the default), Apple Qmaster divides a 100-frame job into at least 10 segments of 10 frames
each. If you change the minimum value to 5, Apple Qmaster divides a 100-frame job into at
least 20 segments of 5 frames each. (When you set a minimum, keep in mind that although
smaller segments allow a job to be distributed to more nodes at once, smaller segments can
also mean that more processing effort is spent on opening and closing Shake on each node.)
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••

Proxies: Select the checkbox to make the proxy settings available. Although the four default
proxy settings are identical in both Shake and Apple Qmaster, they have slightly different
names in each application. The list below indicates the corresponding names. The Apple
Qmaster button name is in italics, followed by the corresponding Shake name:
••

P1: Base

••

P2: P1

••

P3: P2

••

P4: P3

••

Scale pop-up menu: Refer to the Shake documentation for more information.

••

Proxy Ratio pop-up menu: Refer to the Shake documentation for more information.

••

Motion Blur: This pop-up menu contains several options for configuring motion-blur settings.
••

Default for script: Retains custom motion-blur settings from the original Shake script.

••

Off: Turns off motion blur.

••

On: Turns on motion blur.

••

Shutter checkbox: Refer to the Shake documentation for more information.

••

Shutter slider and field: Refer to the Shake documentation for more information.

••

Monitor: Though the Monitor pop-up menu corresponds to a Shake command option, it
requires some explanation in the context of this dialog. The pop-up menu lets you choose
whether or not to display each frame as it renders. If you don’t want to see the frames as they
render, choose None. To see the frames as they render, choose a display resolution option from
the Monitor pop-up menu, and specify the FileOut node in the Options field. For example:
-node nodename. (If the script has only one FileOut node, you don’t need to specify it.)

••

Options field: You can customize the batch instructions by adding command-line options here.

••

Command: The full command is displayed here.

For more information about the options in this dialog, see the Shake documentation.

Generic Render dialog
The Generic Render dialog contains the following settings.

The full command
is displayed here.
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••

Executable: This field shows the path to your command-line render.

••

Input: This field is a generic field that you can use as necessary.

••

Item: This field is a generic field that you can use as necessary.

••

Frames (Start, End, Steps): These fields set the start and end frame for the job. Refer to the Maya
documentation for more information about the Steps field.

••

Frames (Minimum): You can change the value in the Minimum field to change the minimum
number of frames in each Apple Qmaster segment. For example, with a minimum value of 10
(the default), Apple Qmaster divides a 100-frame job into at least 10 segments of 10 frames
each. If you change the minimum value to 5, Apple Qmaster divides a 100-frame job into at
least 20 segments of 5 frames each. (When you set a minimum, keep in mind that although
smaller segments allow a job to be distributed to more nodes at once, smaller segments can
also mean that more processing effort is spent on opening and closing Shake on each node.)

••

Template Name: Contains command templates that you’ve created. To create a command
template, click the Add (+) button, name the new command, and enter the command
information in the dialog.

••

Format: Use the pop-up menu to add commands or enter your own. The resulting command
appears in the Command field.

••

Options field: You can customize the command instructions by adding command-line options here.

••

Command: The full command is displayed here.

Use Mental Ray for Maya
To use the Mental Ray for Maya renderer, add -r mr to the Options field. You must have a licensed
copy of Maya on each node in the cluster to use the Mental Ray renderer. If the node in question
has only one processor, the number of satellite processors does not apply to Apple Qmaster.
Another option is -rt. This specifies the number of rendering threads. By default, the number
of rendering threads is 2. You might want to change this value depending on the type of
computers in your cluster. In a homogeneous cluster environment, you would change this value
to 4, as there are four processors per node, and some Maya operations might be faster with more
threads. This option is passed to all the nodes in the cluster. So, if you have nodes that vary in
the number of processors, you need to be careful with the number of threads you use. Too many
threads can result in lower performance for those nodes.
If you want to selectively enable the number of threads a node uses, you must use a wrapper.
Force Apple Qmaster to heed Maya plug-in warnings
mm Remove or rename the following file:/Library/Application\ Support/Apple\ Qmaster
/MayaCommandPlugin.commandPlugin/Contents/Resources/mayascript

Use Apple Qmaster to submit UNIX commands
You can use Apple Qmaster for distributed processing of any UNIX commands, including any
application that can be operated from the command line. Apple Qmaster provides a convenient
way to issue commands, shortening the amount of typing you need to do by providing an
interface for the global parts of the command.
Distribute UNIX command batches with Apple Qmaster
1 In Compressor, choose Apple Qmaster > Create Rendering Jobs.
2 In the Apple Qmaster window, enter a name for the batch in the “Batch name” field.
(This is the name that appears in Share Monitor.)
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3 Choose Shell from the Command pop-up menu.

Choose Shell from
this pop-up menu.

4 For each job you want to add to the batch, click the Add (+) button, and type the UNIX
command in the Command column.
The UNIX command might specify, for example, the application, an output destination, and a
couple of command-line options.

Type the command in
the Command column.

Note:  If you need to delete a job from this batch (before you submit the batch), select the job
you want to delete and click the Remove (–) button.
5 To set options for this batch, specify the following settings:
••

Submit To: Choose a cluster to process this batch.

••

Working Directory: If relevant, enter the working directory (from which you want the
command to be executed).

••

Priority: Choose the priority level from the pop-up menu. The higher the priority, the sooner
and faster this batch will be processed relative to other batches.

••

Delay: Specify how long you would like the system to wait before processing this batch.

6 Click Submit.
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Job segmenting and two-pass or multi-pass encoding
If you choose the two-pass or the multi-pass mode, and you have distributed processing enabled,
you may have to choose between speedier processing and ensuring the highest possible quality.
The Apple Qmaster distributed processing system speeds up processing by distributing work to
multiple processing nodes (computers). One way it does this is by dividing up the total number of
frames in a job into smaller segments. Each of the processing computers then works on a different
segment. Because the nodes are working in parallel, the job is finished sooner than it would be
on a single computer. But with two-pass VBR and multi-pass encoding, each segment is treated
individually, so the bit rate allocation generated in the first pass for any one segment does not
include information from the segments processed on other computers. If your source media file
contains an uneven distribution of complex scenes (e.g. segments of mostly static material mixed
with segments of large amounts of action), job segmenting can result in uneven quality. Multi-pass
encoding can only be fully optimized if all the passes are performed on the same computer.
Note:  The Allow Job Segmenting checkbox affects only the segmenting of individual jobs (source
files). If you submit batches with multiple jobs, the distributed processing system will continue to
speed up processing by distributing (unsegmented) jobs, even with job segmenting turned off.
For more information about variable bit rate (VBR) encoding, see MPEG-2 Encoder pane on
page 89. For more information about the Apple Qmaster distributed processing system, see
Distributed processing overview on page 215.

Example: Submit After Effects batches with the Generic Render command
The following template is a good starting point for using the Generic Render plug-in to render
After Effects projects:
[EXECUTABLE] -project [INPUT] -comp "Comp 1" -RStemplate "Multi-Machine Settings"
-OMtemplate "Multi-Machine Sequence" -s [START FRAME] -e [END FRAME]-output
[ITEM]/test[####].psd

Where:
[EXECUTABLE] = /Applications/Adobe\ After\ Effects\ 6.5/aerender
[INPUT] = /Volumes/Media/Projects/AEProjs/Wine_Country/QMproject.aep
[START FRAME] = 0
[END FRAME] = 544
[STEPS] = Not Used
[ITEM] = /Volumes/Media/Projects/AEProjs/Wine_Country/output

In the example above, “Comp 1” is the name of the composition in your After Effects project and
“test[####].psd” is the output filename. Because you can’t select an output filename in the
template’s Item field before the output has been rendered, first select the output directory, and
then add the filename to the Item field.
Note:  In the example, /Volumes/Media/Projects/ is the shared volume. If you create the project
on a computer that isn’t using the shared volume, copy the project to the shared volume, open
After Effects, and relink any missing media.
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Here are additional tips for using the Generic Render plug-in to render After Effects projects:
••

After Effects makes good use of multiprocessor systems, but on projects that are not
processor-bound, two rendering services per node give you better results.

••

After Effects custom template information is stored in Users/username/Library/Preferences/
Adobe After Effects 6.5/Prefs/. If you would like to use custom Render Setting and Output Module
templates in an Apple Qmaster cluster, copy this file to the same location on each node in the
cluster. Then you can specify your templates when using the -RStemplate or -OMtemplate option.
Note:  If you’re using a newer version of After Effects, verify the preferences path in the
Adobe documentation.

The above example includes many additions to the shipping After Effects template. To render
an After Effects project in a distributed environment, you must render an image sequence. Userspecific sections must be edited every time. These include the comp name (Comp 1), output
filename (test[####].psd), and possibly output module and render settings.
After Effects provides Render Setting and Output Module templates specifically for this
environment. You can use custom After Effects render and output templates if you wish, but the
output must be an image sequence.
Also, you can use Notification and Set Environment before you submit. Notification is email
notification: Enter an email address and SMTP server, and you will be notified about the
completion of your batch and its status. Use Set Environment to define variables on a per-batch
basis. For more information, see Set environment variables in Apple Qmaster on page 244.
Note:  Apple Qmaster doesn’t currently support SMTP servers that require authentication.

Apple Qmaster window
Apple Qmaster window
You use the Apple Qmaster window to submit distributed processing jobs and batches from
applications like Compressor, Maya, and Shake.
Batch name

Toolbar buttons

Submit To
pop-up menu

Batch table

Command and Priority
pop-up menus
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Toolbar
The Apple Qmaster toolbar contains the following buttons.

••

History: Opens the History drawer, where you can view a full log of all the dates and names of
batches submitted from your computer and check the current status of all processing batches.
The Progress column is updated every 5 seconds.
Additionally, you can drag previously submitted batches to the batch list in the Apple Qmaster
window to add a copy of them to a batch you’re creating. To drag a job or batch from the
History drawer in Apple Qmaster, select the first column of the job or batch, and drag.

••

Set Environment: Opens a dialog where you can add environment variables and preflight scripts.

••

Notification: Opens a dialog where you can set (or reset) an email address to which the status
of a batch (completion or failure) can be sent. Apple Qmaster does not currently support SMTP
servers that require authentication.

••

Share Monitor: Opens Share Monitor, which allows you to view the status of all batches
being processed.

Batch table columns
The Batch table lists the individual jobs in a batch.

••

Type: One of four job types: Shake, Maya, Generic Render, or Shell (UNIX).

••

Command: The actual command for the job.

••

Working Directory: If relevant, the directory from which you want the command to be executed.

Additional settings
The Apple Qmaster window includes other important elements for creating and submitting
jobs and batches.
••

Batch name: Enter the name of the batch in this field. (This is the name that appears in
Share Monitor.)

••

Submit To: Use this pop-up menu to choose an available cluster to process the current batch.

••

Command: Use this pop-up menu to create commands.
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You can choose one of the following types of jobs.

••

••

Generic Render: For more information, see Submit a batch of files using the Generic Render
command in Apple Qmaster on page 242.

••

Maya: For more information, see Submit a batch of Maya files using Apple Qmaster on page 240.

••

Shake: For more information, see Submit a batch of Shake files using Apple Qmaster on page 238.

••

Shell: For more information, see Use Apple Qmaster to submit UNIX commands on page 247.

Add (+) button: Click this button to add a job (with the selected job type) to the Batch table.
This is especially useful if you want to submit similar jobs. You can add copies of the same job
and then edit values in Apple Qmaster as needed.
Add button

••

Remove (–) button: Click this button to delete the selected job from the Batch table.
Remove button

••

Duplicate button: Click this button to duplicate the selected job in the Batch table.
Duplicate button

••

Serialize Jobs: Select this checkbox to execute jobs in exactly the order in which they appear in
the batch list.

••

Priority: Use this pop-up menu to set the priority (urgency) for a batch, relative to other
batches. The default is Medium. High-priority batches get processed before medium-priority
and low-priority batches.
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••

Delay: Enter values in these fields to set a delay in hours (left field) or minutes (right field) for
any job in the batch. Click the arrows to change the values in increments of 1 hour (if the
hours field is active) or 5 minutes (if the minutes field is active).

••

Submit: Click this button to process the batch using the parameters set in the Apple
Qmaster window.

Apple Qmaster Sharing window
Setup pane of the Apple Qmaster Sharing window
You can use the Setup pane within the Apple Qmaster Sharing window to configure your
distributed processing system.

Sharing settings
•• Share this computer: Select this checkbox to share this computer using one of the three
options below. Deselect this option to not share this computer.
••

as QuickCluster with services: Select this option to create an “instant” cluster with unmanaged
services. For more information, see Set up a cluster controller using QuickClusters on page 224.

••

as Services and cluster controller: Select this option to define this computer as a cluster
controller when building a cluster in Apple Qadministrator. For more information, see Create
and modify a cluster on page 258.

••

as Services only: Select this option to make this computer a service node only. Service
nodes perform the processing of batches. They can be included in This Computer Plus
clusters, QuickClusters, or managed clusters. For more information, see Enable managed and
unmanaged services on page 228.
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Services settings
•• Rendering: Use this checkbox to enable or disable the Rendering service. Click its Options button
to open a dialog in which you can adjust the number of instances of a processing service. For
more information, see Use virtual clusters to make the most of multicore computers on page 230.
••

Compressor: Use this checkbox to enable or disable the Compressor service. Click its Options button
to open a dialog in which you can adjust the number of instances of a processing service. For more
information, see Use virtual clusters to make the most of multicore computers on page 230.

••

Require these services to only be used in managed clusters: Use this checkbox to make the shared
service unmanaged (the default) or managed. For more information, see Enable managed and
unmanaged services on page 228.

QuickCluster settings
•• Identify this QuickCluster as: Use this field to change the name of a QuickCluster. You can change
this name to something more meaningful if you like, because it’s the name used to identify this
computer in the Apple Qmaster distributed processing system, and the name that appears in the
Compressor Cluster pop-up menu or the Apple Qmaster Submit To pop-up menu.
For more information about QuickClusters, see Set up a cluster controller using
QuickClusters on page 224.
••

Include unmanaged services from other computers: Select this checkbox to have this QuickCluster
automatically use the available unmanaged computers on your network for distributed
processing. For more information, see Enable managed and unmanaged services on page 228.

Security settings
Require password: If you want to control who is able to include a specific service node or cluster
controller in a cluster, select this checkbox and enter a password in the dialog that appears. For
more information, see Set a service password for including a computer in a cluster on page 231.

••

Advanced pane of the Apple Qmaster Sharing window
You can use the Advanced pane within the Apple Qmaster Sharing window to further configure
your distributed processing system.
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Advanced Service Settings
Use these options to schedule service restarts and service availability.
••

Restart all services every 24 hours: Selecting this checkbox ensures a robust distributed
processing system. Refreshing the services periodically prevents increased virtual memory
sizes and memory leaks in third-party software.

••

Set schedule for unmanaged services: If you enabled unmanaged services, you can open a calendar
dialog and schedule the availability of these services to the distributed processing system. For
information about using the calendar interface, see Schedule service availability on page 229.

Shared Cluster Storage
Use these options to configure scratch storage for this computer’s cluster controller. For more
information about cluster storage, see Use cluster storage on page 232.
••

Delete files older than N days: Enter the number of days temporary process files may remain
on the cluster’s scratch location before they’re automatically deleted. If you anticipate a
transcoding session that will last up to seven days or longer, you must adjust this value.

••

Storage location: Shows the temporary cluster storage location. To change the location where
the cluster’s temporary process files are stored, click Set and choose a new local folder.

Network
Use these features to configure network settings.
••

Allow discovery via Bonjour: By default, this checkbox is selected to have the Apple Qmaster
distributed processing system use the Bonjour networking technology. You can deselect this
checkbox for enhanced security. This will prevent detection of your computer over a Bonjour
network. This feature requires OS X v10.7.5 or later.

••

Use network interfaces: Restrict distributed processing activity to a particular network interface
card by choosing it from this pop-up menu. If you do this on a service node computer, use a
different computer to submit Compressor jobs and batches.

••

Enable Port Range From: You can define which ports Apple Qmaster uses for service
advertisements with the Enable Port Range checkbox and text fields. For more information,
see Use cluster storage on page 232.

Extras
Use these features to configure additional settings.
••

Log service activity to file: If this checkbox is selected, an activity log is created and updated
regularly with information about the Apple Qmaster actions on this computer. Logs are stored in
/Library/Application Support/Apple Qmaster/Logs. To turn off this feature, deselect the checkbox.
Note:  You can also access this log information by clicking the Log button in Apple
Qadministrator or by clicking Show Log in the Share Monitor Show Info window.

••

Maximum Active Targets: By default, a cluster can process up to 40 targets at one time. To
change the maximum number of targets processed at the same time between two or more
jobs, enter a number from 1 to 999.

••

Identify this computer to Apple Qadministrator as: By default, a computer is identified on the
network by its computer name (as it’s entered in the Sharing pane of System Preferences).
You can change this name to something more meaningful if you like, because it’s the name
used to identify this computer in Apple Qadministrator. If you’re setting up a managed cluster
controller, this is the name that appears in the Apple Qadministrator Controller pop-up menu.
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Set Apple Qmaster preferences

You use the Apple Qmaster Preferences window to adjust how Apple Qmaster works with
remote computers.
Enter IP addresses or ranges for remote service host computers
1 Choose Apple Qmaster > Preferences.

2 Click the Add (+) button.
3 In the dialog that appears, do one of the following:
••

Select Host, complete the Host Name and IP Address fields, and click Add Host.

••

Select “Host IP address range,” complete the Range fields, and click Add Range.

4 In the Preferences window, click Apply.
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Use Apple Qadministrator
to create and modify clusters

9

What is Apple Qadministrator?

The Apple Qadministrator application is used to administer a distributed processing system built
with Apple Qmaster. You can use the Apple Qadministrator application to manually create and
modify Apple Qmaster clusters. Apple Qadministrator can be used on any computer that is on
the same network as the cluster you want to administer.
Note:  Most users will not need to use Apple Qadministrator to create or manage their clusters,
instead using This Computer Plus and QuickClusters.
Drag available service nodes
to assign them to a cluster.

Open Apple Qadministrator

You open Apple Qadministrator from Compressor.
Open the Apple Qadministrator window
mm In Compressor, choose Apple Qmaster > Administer Clusters.
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The Apple Qadministrator window appears. If a password was created for the currently selected
cluster, you will not be able to see or modify the cluster until you click the Lock button and then
enter the password in the dialog that appears.

Create and modify a cluster

After you configure managed service nodes or cluster controllers in Apple Qmaster, you can view
them in Apple Qadministrator. Next, you’ll use Apple Qadministrator to create and modify Apple
Qmaster clusters.
There are two basic steps to creating a managed cluster with Apple Qadministrator. First
you create a new cluster and select the cluster controller, and then you add service nodes to
the cluster. After a cluster is configured, you can use Apple Qadministrator to deactivate and
reactivate the processing services on a computer in the cluster, add a service node to the cluster,
or remove a service node from the cluster.
If you want to change the cluster controller in a cluster, you need to delete the cluster and then
re-create it with a new cluster controller.
Note:  QuickClusters are not visible in Apple Qadministrator unless Apple Qadministrator and
the QuickCluster are on the same computer. Only managed clusters (clusters that were created
in Apple Qmaster) can be modified and deleted in Apple Qadministrator. QuickClusters must
be modified in the Apple Qmaster Sharing window of Compressor. For more information, see
Creating service nodes and cluster controllers overview on page 222.
Create a new cluster
1 In Compressor, choose Apple Qmaster > Administer Clusters.
2 In the Apple Qadministrator window, click the Add (+) button, select Untitled Cluster, and rename it.
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The cluster name you create will also appear in the cluster pop-up menus in Compressor, Share
Monitor, Apple Qmaster, Final Cut Pro, and Motion.

... then rename the
Untitled Cluster.

Click the Add button...

3 In the Controller pop-up menu, choose a cluster controller from those available on the network.
Use this pop-up
menu to choose
a cluster controller.

Note:  If a password was created for the cluster controller in the Apple Qmaster Sharing window,
a password authentication window appears.
4 If you want to create cluster passwords, click the Security tab and select and enter the passwords.
••

Administrator password: If you create this password, administrators will need to know it to
modify this cluster and to view this cluster’s batches in Share Monitor.

••

User password: If you create this password, users will need to know it to submit batches to this
cluster and to view those batches in Share Monitor.

Add a service node to a cluster
1 If the Qmaster Service Browser isn’t already displayed in the Apple Qadministrator window, click
the disclosure triangle to display it.
Click this disclosure triangle
to see available nodes.

2 Add service nodes to the new cluster by dragging them from the Qmaster Service Browser list at
the bottom of the window to the cluster’s service nodes list.
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If a closed lock icon appears next to a computer name, click the lock and enter the password that
was assigned to it in the Apple Qmaster Sharing window in Compressor. Otherwise, you won’t be
able to drag that service node to the cluster.
Service nodes that are already assigned to another cluster are not shown.
Drag nodes to this list from
the Service Browser list.

Clicking this disclosure triangle
displays each instance of the
services set in the Apple Qmaster
Sharing window for this node.

Note:  The computer names that are listed at the top of the Name columns may appear in one
of three formats, depending on your setup: the computer name (for example, TL’s Machine),
the Apple networking name (for example, TL’s-Machine.local), or the network address for the
computer (for example, 02030b-dhcp45.company.com).
3 When you have finished adding service nodes, click Apply.
Your cluster is now ready to process batches.
Note:  Although Apple Qadministrator allows you to create a cluster with unmanaged services,
valid clusters require at least one managed service for the cluster to be viewable in Apple
Qmaster, Compressor, and Share Monitor.
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Modify a cluster
1 In the Cluster list on the left side of the Apple Qadministrator window, select the cluster you
want to change.
If the cluster’s service nodes (in the Services tab) doesn’t already display individual services, click
the disclosure triangle in the Name column.
Do any of the following:
••

To temporarily turn off the processing services on a computer in the cluster: Deselect the Active
checkbox for that service node.

••

To remove a service node from the cluster: Select the computer and drag it back to the Qmaster
Service Browser list at the bottom of the Apple Qadministrator window.
To remove nodes from
a cluster, drag them to the
Qmaster Service Browser.

••

To add a service node to the cluster: Drag it from the Qmaster Service rowser list at the bottom
of the window to the service nodes list.

2 Click Apply.
Note:  For instructions on how to turn off the service node or cluster controlling services on any
computer within a cluster, see Turn cluster controller services on or off on page 231.
Change a cluster’s name
1 In the Cluster list on the left side of the Apple Qadministrator window, double-click the cluster name.
2 Type a new name, and press Return.
Delete a cluster
1 In the Cluster list on the left side of the Apple Qadministrator window, select the cluster you
want to delete.
2 Click the Remove (–) button.
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Monitor cluster activity

You can use Apple Qadministrator to find out what’s happening within a cluster by examining
details (such as processor usage, which batch is being processed, disk space usage, and data
activity) about each node in the cluster.
You can also view log information for a selected service or cluster. This information is useful for
troubleshooting distributed processing issues, and it can be saved to a file and processed with
XML tools and UNIX scripts.
View cluster activity
1 In the Cluster list on the left side of the Apple Qadministrator window, select the cluster you
want to examine.
2 Select a node in the cluster’s service nodes list (in the Services tab).
3 Click the Info (i) button near the bottom of the Cluster list.
4 In the window that appears, click the CPU, Memory, Volume Info, and I/O Activity tabs to see a
variety of details about the selected node.
View or copy log information
1 In the Cluster list, select the service or cluster whose log you want to view.
2 Click the Log button near the bottom of the Cluster list.
A new window appears, displaying the log information for the selected service or cluster. The log
file is deleted when you close the window.

Set Apple Qadministrator preferences

Apple Qadministrator preferences apply to specific clusters and also to using Apple
Qadministrator over a wide area network.
Set preferences for a cluster or for using Apple Qadministrator over a wide area network
1 Open Apple Qadministrator.
2 In the Cluster list on the left side of the window, select the cluster for which you want to
set preferences.
3 Click the Preferences tab.
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4 To configure queue preferences in Apple Qadministrator, specify any of the following settings:
••

Maximum number of jobs in queue: Enter the maximum number of batches that can be queued
up at one time for this cluster. If the maximum number is reached, the cluster doesn’t accept
new batches until there’s an opening in the queue.

••

Keep job history for: Set how long batches are listed in the History table of Share Monitor.

••

Email notification for service down after: Set how much time should pass, after a service becomes
inaccessible, before the cluster controller sends an alert message to the administrator.

••

Status Interval: Set how often status information about this cluster should be generated and
sent to Share Monitor.

5 To have the cluster controller send service failure alerts to an administrator, specify the
following settings:
••

Admin Email: Enter the administrator’s email address.

••

Send with mail server: Enter the administrator’s mail server.

••

Domain: Enter the cluster controller’s domain.

Note:  The Apple Qmaster distributed processing system doesn’t currently support SMTP servers
that require authentication.
Enter IP addresses or ranges for remote computers
Apple Qadministrator wide area network preferences include the IP addresses for
remote computers.
1 Choose Apple Qadministrator > Preferences, or press Command-Comma (,).
The Preferences window appears, displaying information about remote host computers.

2 Click the Add (+) button.
The host address dialog, which is used to enter IP addresses or ranges for remote computers, appears.
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3 In the host address dialog, do one of the following:
••

To enter the IP address of a specific computer: Select Host, complete the Host Name and IP
Address fields, and click Add Host.

••

To enter a range of IP addresses: Select “Host IP address range,” complete the Range fields, and
click Add Range.

The hosts or host ranges appear in the Host table in the main Preferences window.
4 When you’re done adding or removing IP addresses, click OK in the Preferences window.
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10

Keyboard shortcuts

Compressor keyboard shortcuts

You can use keyboard shortcuts to quickly accomplish many tasks in Compressor. To use a
keyboard shortcut, press all the keys in the shortcut at the same time. Shortcuts for common
commands are listed in the table below.
General Compressor keyboard shortcuts
Action

Shortcut

Bring the History window to the front

Command-1

Bring the Preview window to the front

Command-2

Bring the Settings tab to the front

Command-3

Bring the Destinations tab to the front

Command-4

Close the current window

Command-Shift-W

Show/hide the Batch window toolbar

Command-Option-T

Revert to the original window layout

Shift-Control-U

Open the Compressor Preferences window

Command-Comma (,)

Create a new batch (the Batch Template Chooser
appears unless it has been disabled)

Command-N

Create a new batch (the Batch Template Chooser
appears even if it has been disabled)

Command-Shift-N

Save the current batch

Command-S

Save the current batch as a new batch

Command-Shift-S

Open a saved batch

Command-O

Close the current batch tab

Command-W

Save the current batch as a new template

Command-Option-S

Import a source asset to create a new job in the batch

Command-I

Open the dialog to replace the source of the current
job

Command-Shift-I

Create a new surround sound group job in the batch

Command-Control-I

Create a new image sequence job in the batch

Command-Option-I

Submit a batch from an open Droplet

Press the Return key

Remove a selected item from the Batch window,
Preview window, or Destinations tab

Press the Delete key

Navigate up list items in the Batch window,
Destinations tab, Settings tab, and Filters pane

Press the Up Arrow key

Navigate down list items in the Batch window,
Destinations tab, Settings tab, and Filters pane

Press the Down Arrow key
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Action

Shortcut

Navigate through text fields in all panes

Press the Tab key

Open the Mount Cluster Storage dialog

Command-Shift-M

Open Compressor Help

Command-Shift-Slash (/)

Preview window keyboard shortcuts
Action

Shortcut

Start fast reverse motion

J

Start fast forward motion

L

Go to the previous frame

Press the Left Arrow key

Go to the next frame

Press the Right Arrow key

Start or stop clip playback

Press the Space bar

Add or remove a marker at the current frame

M

When the playhead is positioned on a marker, open a
dialog for editing the marker

Command-E

Mark an In point

I

Mark an Out point

O
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